
SAINIK SCHOOL IMPHAL 

WINTER VACATION 2025-26 

HOMEWORK/ASSIGNMENT 

Class-X 

 

 

 

 

 

 

Write only the answers, clearly 

indicating the set number and question 

numbers, in the homework notebook. 

INFORMATION 

TECHNOLOGY 



Information Technology Class X Sample Papers - Page 1 of 42 
 

Information Technology for Class X-Set 1 

Time: 2 Hours         Maximum Marks: 50 

Instructions: 

• Please read the instructions carefully. 

• This Question Paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions whereas Section B contains Subjective Type 

Questions. 

• Out of the given (5 + 16 = 21) questions, a candidate has to answer (5 + 10 = 15) 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A: Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• Marks allotted are mentioned against each question/part. 

• There is no negative marking. 

• Do as per the instructions given. 

• Section B: Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A: Objective Type Questions [24 Marks] 

Question 1. 

Answer any 4 out of the given 6 questions on Employability Skills.    (4×1=4) 

(i) Samar wrote a notice full of difficult words and unclear instructions. Many students 

ignored it. Which principle of communication was violated? 

(a) Concreteness 

(b) Conciseness 

(c) Clarity 

(d) Completeness 

 

(ii) Which of the following is the most suitable term for managing stress through regular 

walking in a natural environment? 

(a) Physical fitness 

(b) Nature walk 

(c) Morning exercise 

(d) Forest workout 

 

(iii) Arjun studies regularly, stays focused on his goals, and encourages himself even when 

results aren’t immediate. This shows: 

(a) carelessness 

(b) laziness 

(c) self-motivation 

(d) distraction 

 

(iv) A good way to protect your system from viruses is to 

(a) ignore software updates. 

(b) open all email attachments. 
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(c) use antivirus software and scan regularly. 

(d) keep the computer always turned off. 

 

(v) One of the key roles of an entrepreneur in society is to 

(a) avoid competition 

(b) reduce employment opportunities 

(c) promote social and economic development 

(d) work in a bank 

 

(vi) Which one of these models best supports sustainable living? 

(a) Diesel generator 

(b) Solar cooker 

(c) Plastic incinerator 

(d) Coal heater 

 

Question 2. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Preeti wants to apply the same formatting from one paragraph to another quickly. Which 

feature should she use? 

(a) Format Paint 

(b) Fill Format 

(c) Clone Formatting 

(d) Copy-Paste 

 

(ii) Rahul inserted an image in his document but wants to wrap text tightly around it. Which 

option should he use? 

(a) In Background 

(b) Page Wrap 

(c) Optimal Page Wrap 

(d) Through 

 

(iii) Which of the following is a category of style in Writer? 

(a) Shape Style 

(b) Image Style 

(c) Frame Style 

(d) Caption Style 

 

(iv) Which menu is used to insert a Table of Contents in Writer? 

(a) Insert → Indexes and Tables 

(b) View → Navigator 

(c) Tools → AutoText 

(d) Format → Table of Contents 

 

(v) What is the use of a template in LibreOffice Writer? 

(a) To save passwords 

(b) To create identical charts 

(c) To reuse predefined document formats 

(d) To organise menus 
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(vi) Jyoti is preparing a school magazine using a template. She wants to apply a different 

template to a blank document. Which option should she use? 

(a) Import Template 

(b) Export Template 

(c) Apply Template 

(d) Insert Template 

 

Question 3. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) In Calc, which tool lets you test formulas under different scenarios? 

(a) Goal Seek 

(b) Solver 

(c) Scenario Manager 

(d) Filter 

 

(ii) In a shared spreadsheet, which action shows all previous edits? 

(a) Accept Change 

(b) Show Changes 

(c) Update Sheet 

(d) Sort Data 

 

(iii) A macro can be created using 

(a) Tools → Macros → Record Macro 

(b) Edit → Macros 

(c) Data → Macro Tool 

(d) Insert → Record 

 

(iv) Which hyperlink allows connection to a data source? 

(a) Web link 

(b) Document link 

(c) Registered data source link 

(d) Text link 

 

(v) Which Calc feature consolidates data from multiple ranges? 

(a) Group 

(b) Chart 

(c) Consolidate 

(d) Solver 

 

(vi) Which menu lets you create a scenario in Calc? 

(a) Data → Scenario 

(b) Insert → Scenario 

(c) Tools → Scenario 

(d) Format → Scenario 

 

Question 4. 

Answer any 5 out of the given 6 questions.       (5×1=5) 
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(i) Priya is designing a database of student details. She wants to ensure each record is 

uniquely identified. Which action should she take while creating the table in design view? 

(a) Sort the records 

(b) Set a primary key 

(c) Hide duplicate fields 

(d) Apply referential integrity 

 

(ii) Which tool in LibreOffice Base is used to display selected data from one or more tables 

based on specific conditions? 

(a) Report 

(b) Query 

(c) Form 

(d) Filter Wizard 

 

(iii) What does referential integrity ensure in relational databases? 

(a) Data is sorted alphabetically. 

(b) All linked tables are deleted. 

(c) Consistent and valid relationships between tables. 

(d) All data is converted to text. 

 

(iv) In LibreOffice Base, which object is used to display the final formatted output for 

printing? 

(a) Query 

(b) Table 

(c) Form 

(d) Report 

 

(v) Which of the following is not an object of LibreOffice Base? 

(a) Table 

(b) Form 

(c) Slide 

(d) Query 

 

(vi) While editing a form in LibreOffice Base, Meena wants to display a fixed text title at the 

top of the form. Which form control should she insert? 

(a) Date Field 

(b) Label 

(c) Text Box 

(d) Numeric Field 

 

Question 5. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Priya works long hours on a computer without adjusting screen brightness or taking 

breaks. She starts experiencing blurry vision and eye strain. Which safety measure could 

reduce this? 

(a) Use a dark background wallpaper 

(b) Lower the monitor below eye level 

(c) Take frequent eye breaks and adjust monitor brightness 
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(d) Increase screen resolution to maximum 

 

(ii) ………. is the science that focuses on designing tools and workspaces to fit human needs 

and prevent strain. 

(a) Physiology 

(b) Ergonomics 

(c) Kinesiology 

(d) Automation 

 

(iii) Which of the following is not a physical hazard in the workplace? 

(a) Poor ventilation 

(b) Loud noise 

(c) Bright lighting 

(d) Delayed email response 

 

(iv) The purpose of workplace safety policies is to 

(a) increase workload 

(b) reduce worker rights 

(c) prevent accidents and injuries 

(d) promote overtime 

 

(v) A slippery floor, uncovered wires, and poor lighting are examples of 

(a) Chemical hazards 

(b) Biological hazards 

(c) Physical hazards 

(d) Visual hazards 

 

(vi) Which of the following should not be done while working on electrical equipment? 

(a) Wear dry gloves 

(b) Work with wet hands 

(c) Use insulated tools 

(d) Switch off power before repairing 

 

Section B: Subjective Type Questions [26 Marks] 

Answer any 3 out of the given 5 questions on Employability Skills. Answer each question in 

20-30 words.           (3×2=6) 

Question 6. 

What are two ways to overcome communication barriers? 

 

Question 7. 

What is stress management and why is it important? 

 

Question 8. 

What is the purpose of installing antivirus software on a computer? 
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Question 9. 

What is the role of entrepreneurship in society? 

 

Question 10. 

Explain any two problems related to sustainable development. 

 

Answer any 4 out of the given 6 questions in 20-30 words each    (4×2=8) 

Question 11. 

What is meant by the ‘Track Changes’ feature in Writer and when is it useful? 

 

Question 12. 

Explain the function of the What-if Analysis tool in Calc. 

 

Question 13. 

How can you edit a hyperlink in Calc? 

 

Question 14. 

Define Relational Database Management System (RDBMS). Give two examples of its 

objects. 

 

Question 15. 

What are two common physical hazards found in office environments? 

 

Question 16. 

What are the basic guidelines for maintaining good air and water quality in the workplace? 

 

Answer any 3 out of the given 5 questions in 50-80 words each.    (3×4=12) 

Question 17. 

(a) What is the benefit of using the Fill Format mode in Styles and Formatting? 

(b) How does anchoring help in positioning images within text in Writer? 

 

Question 18. 

Mrs. Reema, the Head of the Academic Department at Sunrise School, is preparing the 

annual academic performance report. Each subject teacher has maintained their own 

spreadsheet for student marks in different worksheets. Mrs. Reema now wants to combine 

all subject-wise data, automate repetitive entries, analyse results using scenarios, and 

collaborate with teachers by tracking their feedback and suggestions. 

(a) Which feature should Mrs. Reema use to combine student marks from different subject 

worksheets into one final result sheet? 

(b) To automate the task of entering common remarks like ‘Passed’ or ‘Needs Improvement’ 

for multiple students, which tool should she use? 

(c) Mrs. Reema wants to evaluate how the overall class result changes if passing criteria are 

modified from 35 to 40 marks. Which tool will help her simulate and compare this? 

(d) Since the final report is shared among subject teachers for review, how can Mrs. Reema 

ensure all edits and suggestions made by them are tracked? 

 



Information Technology Class X Sample Papers - Page 7 of 42 
 

Question 19. 

A worker accidentally drops a heavy object on his foot. As a safety officer, you need to 

educate others on how to handle such emergencies and the importance of reporting. 

(a) What two actions should you take when an accident occurs at work? 

(b) Why is it important to follow accident-reporting procedures? 

 

Question 20. 

(a) What are queries in LibreOffice Base? Why are they used? 

(b) How can you create a query using the design view in Base? 

 

Question 21. 

Consider the following table: 

Reg_No Name Room_No Contact 

HS101 

HS102 

HS103 

Rohit 

Meena 

Rohit 

12 

14 

12 

9123456780 

9234567890 

9345678901 

(a) Suggest a suitable data type for the Reg_No and Room_No. 

(b) Which field should be set as the primary key and why? 

(c) Identify a possible alternate key and justify. 

(d) How many attributes and records are present? 
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Information Technology for Class X-Set 2 

Time: 2 Hours         Maximum Marks: 50 

Class 10 Guides 

Instructions: 

• Please read the instructions carefully. 

• This Question Paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions whereas Section B contains Subjective Type 

Questions. 

• Out of the given (5 + 16 = 21) questions, a candidate has to answer (5 + 10 = 15) 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A: Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• Marks allotted are mentioned against each question/part. 

• There is no negative marking. 

• Do as per the instructions given. 

• Section B: Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A: Objective Type Questions [24 Marks] 

Question 1. 

Answer any 4 out of the given 6 questions on Employability Skills    (4×1=4) 

(i) After submitting a report, Neha received comments like “Your analysis in Section 2 is very 

clear and well-supported by data.” 

What kind of feedback did Neha receive? 

(a) Specific and descriptive 

(b) Non-verbal and general 

(c) Vague and indirect 

(d) Verbal and emotional 

 

(ii) What is the first step in managing time effectively? 

(a) Avoiding planning 

(b) Identifying and prioritising tasks 

(c) Ignoring deadlines 

(d) Doing everything at once 

 

(iii) Ananya takes deep breaths and practices meditation for 10 minutes before every exam 

to calm her mind. This is an example of 

(a) self-motivation 

(b) emotional intelligence 

(c) stress management technique 

(d) time management 

 

(iv) The Recycle Bin allows users to 

(a) permanently delete files 
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(b) restore deleted files 

(c) increase memory 

(d) access internet settings 

 

(v) Which of the following is a myth about entrepreneurship? 

(a) Entrepreneurs never fail in business 

(b) Entrepreneurs take risks 

(c) Entrepreneurs create jobs 

(d) Entrepreneurs bring innovation 

 

(vi) Which of the following is a responsible way to protect cultural heritage and indigenous 

knowledge? 

(a) Ignoring traditional farming practices 

(b) Promoting local crafts and customs 

(c) Destroying old monuments 

(d) Avoiding folk tales and oral history 

 

Question 2. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Ansh inserted several images but now wants to resize them to maintain uniformity. Which 

method is best? 

(a) Resize using comer handles 

(b) Use save as 

(c) Use replace image 

(d) Use hyperlink 

 

(ii) Rohit added a comment while reviewing a document. How can he remove it later? 

(a) Go to Insert → Delete 

(b) Right-click the comment and select Delete 

(c) Remove from Format tab 

(d) Clear all contents 

 

(iii) Which category of styles applies to table formatting? 

(a) Frame 

(b) Paragraph 

(c) Table 

(d) List 

 

(iv) What does anchoring an object mean in Writer? 

(a) Locking the object 

(b) Changing the file format 

(c) Setting its fixed position relative to text or page 

(d) Exporting it to another app 

 

(v) What is the default wrapping mode when inserting an image? 

(a) In Background 

(b) Page Wrap 

(c) No Wrap 
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(d) Optimal Page Wrap 

 

(vi) Shivani created a new style using formatting from selected text. Which method did she 

use? 

(a) From Template 

(b) From Selection 

(c) Fill Style 

(d) Style Updater 

 

Question 3. 

Answer any 5 out of the given 6 questions.       (5×1=5 ) 

(i) Which of the following lets you test different values in formulas without changing the 

original data? 

(a) Filters 

(b) Scenarios 

(c) Cell formatting 

(d) Autofill 

 

(ii) A macro created in Libre Office is saved in 

(a) txt format 

(b) As part of the document 

(c) ods settings 

(d) Clipboard 

 

(iii) What is the purpose of absolute hyperlinks? 

(a) Link to undefined cells 

(b) Link to external documents with full path 

(c) Move sheets 

(d) Format cells 

 

(iv) After enabling ‘Track Changes’, what does Calc display to indicate changes made? 

(a) Highlighted cells with details of the change 

(b) Hidden comments 

(c) Password prompts 

(d) Automatically saves the document 

 

(v) Which feature allows adding input from other spreadsheets into one? 

(a) Chart 

(b) Consolidate 

(c) Sort 

(d) Scenario 

 

(vi) Where can you find the Scenario Manager in Calc? 

(a) Data → Scenarios 

(b) Tools → Macro 

(c) Edit → Scenario 

(d) Insert → Object 
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Question 4. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) In a One-to-Many relationship 

(a) one record in the first table matches only one record in the second table. 

(b) one record in the first table matches many records in the second table. 

(c) many records in the first table match many records in the second table. 

(d) both tables have the same number of records. 

 

(ii) Which data model organises data in a tree-like structure? 

(a) Relational 

(b) Network 

(c) Hierarchical 

(d) Structural 

 

(iii) Which type of field is used to store whole numbers? 

(a) Boolean 

(b) Integer 

(c) Float 

(d) Text 

 

(iv) What is the default extension of a LibreOffice Base file? 

(a) .odb 

(b) .ods 

(c) .odt 

(d) .odg 

 

(v) Which view allows manual design of queries? 

(a) Wizard 

(b) Design View 

(c) Report View 

(d) Table View 

 

(vi) A query that uses mathematical calculations is a 

(a) Text Query 

(b) SQL Query 

(c) Numerical Query 

(d) Mathematical Query 

 

Question 5. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) If someone collapses due to cardiac arrest, the first action should be 

(a) try to revive them yourself. 

(b) move them to comfort. 

(c) call emergency services. 

(d) look for ID card. 
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(ii) In ergonomics, the chair used at the computer workstation should have 

(a) Fixed backrest 

(b) Wheels only 

(c) Lumbar support 

(d) Wooden seat 

 

(iii) One of the key causes of poor air quality at the workplace is 

(a) Excessive lighting 

(b) Blocked ventilation 

(c) Cold weather 

(d) Empty bins 

 

(iv) First-aid for burns includes 

(a) applying ice directly. 

(b) covering with dirty cloth. 

(c) running cool water over the burn. 

(d) scrubbing the burn area. 

 

(v) A warning sign near electrical panels is an example of 

(a) safety hazard 

(b) risk management tool …….. 

(c) office design 

(d) equipment layout 

 

(vi) In the event of fire, one must 

(a) hide in a room 

(b) collect belongings 

(c) use the lift 

(d) evacuate immediately 

 

Section B: Subjective Type Questions [26 Marks] 

Answer any 3 out of the given 5 questions on Employability Skills. Answer each question in 

20-30 words.           (3×2=6) 

Question 6. 

What is the importance of feedback in the communication cycle? 

 

Question 7. 

Describe the qualities required to complete a task independently. 

 

Question 8. 

What is a file and how is it organised in a computer system? 

 

Question 9. 

Why is entrepreneurship a good career option? 

 



Information Technology Class X Sample Papers - Page 13 of 42 
 

Question 10. 

How can rainwater harvesting promote sustainable development? 

 

Answer any 4 out of the given 6 questions in 20-30 words each.    (4×2=8) 

Question 11. 

How can a new style be created using the ‘From Selection’ method in Writer? 

 

Question 12. 

What is the use of creating references between multiple sheets in Calc? 

 

Question 13. 

What is the process of accepting or rejecting changes in a shared spreadsheet? 

 

Question 14. 

Explain the process of creating a table in LibreOffice Base using the Wizard. 

 

Question 15. 

What are the key steps to follow during a fire emergency in the workplace? 

 

Question 16. 

What safety measures should be taken while handling office equipment? 

 

Answer any 3 out of the given 5 questions in 50-80 words each.    (3×4=12) 

Question 17. 

(a) What is the purpose of using templates in LibreOffice Writer? 

(b) Describe how you can modify a form in LibreOffice Writer. 

 

Question 18. 

Mr. Rajiv, a school administrator, manages monthly expenses in different sheets for 

departments like Sports, Library, and IT. He wants to summarise all expenses, create quick 

calculations and share the spreadsheet with department heads for feedback. 

(a) What feature should Mr. Rajiv use to combine department expenses into one sheet? 

(b) How can he simplify entering monthly budget headings across all department sheets? 

(c) Rajiv wants to test if reducing Library funds by 10% affects total expenses. Which tool 

should he use? 

(d) How can Mr. Rajiv ensure all changes by department heads are visible for review? 

 

Question 19. 

You are conducting a workshop for new recruits who spend 6 – 8 hours daily on computers. 

You must explain good ergonomic practices and health tips. 

(a) What are two ergonomic tips to follow while using a computer? 

(b) Name two health issues caused by prolonged computer use. 

 

Question 20. 

(a) What are the main advantages of using a Database Management System (DBMS) 

compared to traditional file-based systems? Explain briefly. 
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(b) What is a Relational Database Model and why is it widely used? 

 

Question 21. 

Consider the following table: 

Roll No Name Subject Marks 

101 

102 

103 

Neha 

Ravi 

Neha 

English 

Maths 

English 

78 

88 

78 

(a) Suggest suitable data types for the Roll_No and Marks fields 

(b) Which field should be set as the primary key and why? 

(c) Identify a possible alternate key and justify. 

(d) How many attributes and records are present? 
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Information Technology for Class X-Set 3 

Time: 2 Hours         Maximum Marks: 50 

Instructions: 

• Please read the instructions carefully. 

• This Question Paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions whereas Section B contains Subjective Type 

Questions. 

• Out of the given (5 + 16 = 21) questions, a candidate has to answer (5 + 10 = 15) 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A: Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• Marks allotted are mentioned against each question/part. 

• There is no negative marking. 

• Do as per the instructions given. 

• Section B: Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A: Objective Type Questions (24 Marks) 

Question 1. 

Answer any 4 out of the given 6 questions on Employability Skills.    (4×1=4) 

(i) While speaking to a teacher, Arun kept slouching and checking his watch repeatedly. 

What does Arun’s body language likely communicate? 

(a) He is respectful and attentive. 

(b) He is nervous but interested. 

(c) He is uninterested or impatient. 

(d) He is excited and ready. 

 

(ii) What does the SMART acronym stand for in goal setting? 

(a) Simple, Manageable, Accurate, Reliable, Timely 

(b) Specific, Measurable, Achievable, Relevant, Time-bound 

(c) Small, Medium, Achievable, Realistic, Trackable 

(d) Strong, Meaningful, Applicable, Reasonable, Time-efficient 

 

(iii) Zara enjoys long walks in the park after a hectic day at school to feel refreshed. This is 

an example of 

(a) nature walk as a stress buster. 

(b) peer pressure. 

(c) poor time management. 

(d) emotional dependence. 

 

(iv) In the Windows OS, right-clicking on a file and selecting ‘Rename’ allows a user to 

(a) Delete the tile 

(b) move the file to another folder 

(c) change the file name 
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(d) copy the file 

 

(v) Which of the following statements about entrepreneurship as a career is correct? 

(a) It has no scope. 

(b) It only suits rich people. 

(c) It offers independence and opportunities. 

(d) It is always easier than jobs. 

 

(vi) Which of these actions best reflects environmental citizenship? 

(a) Throwing waste in rivers 

(b) Conserving energy and water 

(c) Ignoring pollution rules 

(d) Wasting food and electricity 

 

Question 2. 

Answer any 5 out of the given 6 questions.       (5 x 1 = 5) 

(i) Varun created a business letter template and now wants to reuse it for another letter. 

What should he do? 

(a) Save as draft 

(b) Use in-built template 

(c) Open Template and save as new document 

(d) Print directly 

 

(ii) Priya added a watermark but it’s covering the text. What can she change? 

(a) Wrap setting 

(b) Layer order 

(c) Transparency 

(d) Paragraph style 

 

(iii) Which of the following is a style category for bullet points’ 

(a) Table 

(b) Character 

(c) List 

(d) Frame 

 

(iv) What does the term ‘Anchoring’ refer to in Writer? 

(a) Creating links 

(b) Fixing objects to a part of the document 

(c) Making styles 

(d) Writing formulas 

 

(v) Which menu helps in recording changes in a document? 

(a) Edit 

(b) View 

(c) Tools 

(d) File 
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(vi) Rajat deleted a Table of Contents by mistake, What is the best way to restore it? 

(a) Ctrl+Z 

(b) Reinsert using Insert → Table of Contents 

(c) Rebuild the whole document 

(d) Use Templates 

 

Question 3. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Which feature helps compare changes made by different users in a spreadsheet? 

(a) Coal Seek 

(b) Merge Document 

(c) Format Cells 

(d) Autofilt 

 

(ii) The Subtotal feature is found under 

(a) Format 

(b) Tools 

(c) Data 

(d) View 

 

(iii) After reviewing the changes, how can you stop others from editing the document further? 

(a) Disable sharing by unchecking ‘Share Document’ in Tools 

(b) Turn off the computer 

(c) Remove Track Changes only 

(d) Save itas a read.only document 

 

(iv) A hyperlink in Caic can be used to 

(a) add borders 

(b) insert comments 

(c) navigate to another document 

(d) calculate totals 

 

(v) The shortcut to add a new comment in a Cale cell is 

(a) Ctrl + M 

(b) Ctrl + Alt + C 

(c) Ctrl + Shift + C 

(d) Ctrl + F2 

 

(vi) In Calc, which feature lets you see what others have edited in a shared document? 

(a) Scenario Manager 

(b) Consolidate 

(c) Track Changes 

(d) Paste Special 
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Question 4. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Which feature in Base allows you to create structured output for printing data from tables 

or queries? 

(a) Report 

(b) Form 

(c) Table 

(d) Query 

 

(ii) Which one of the following data types stores decimal numbers? 

(a) Integer 

(b) Text 

(c) Numeric (Decimal) 

(d) Boolean 

 

(iii) What is the purpose of using a wizard in Base? 

(a) To enter data 

(b) To automate database tasks 

(c) To create database objects step-by-step 

(d) To write queries in SQL 

 

(iv) Which control is used to show static text on a form in Base? 

(a) Text Box 

(b) Label 

(c) Combo Box 

(d) List Box 

 

(v) A query that retrieves data based on specific criteria is known as 

(a) Static query 

(b) Conditional query 

(c) Filter query 

(d) Select query 

 

(vi) What ensures consistency and prevents orphaned records when tables are related? 

(a) Primary key 

(b) Foreign key 

(c) Referential integrity 

(d) Data type 

 

Question 5. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Which of the following is a correct safety practice while using a paper shredder? 

(a) Push papers in with your fingers 

(b) Turn it on before plugging in 

(c) Keep hands away from the opening 

(d) Shred one large pile at once 
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(ii) What should you avoid doing during a fire emergency? 

(a) Use the stairs 

(b) Help others evacuate 

(c) Use the elevator 

(d) Follow the fire escape plan 

 

(iii) What does Refer to MSDS mean when working with chemicals? 

(a) Maximum safe data score 

(b) Material Safety Data Sheet 

(c) Monthly supply demand system 

(d) Machine safety and disposal sheet 

 

(iv) Which of the following is a symptom of computer vision syndrome? 

(a) Knee pain 

(b) Dry eyes 

(c) Chest pain 

(d) Neck rash 

 

(v) Which one of these is considered an ergonomic device? 

(a) Adjustable chair 

(b) Paper file 

(c) Loudspeakers 

(d) Mirror 

 

(vi) What should be done immediately after any workplace accident? 

(a) Ignore it 

(b) Inform your supervisor 

(c) Wait till end of shift 

(d) Cover it up 

 

Section B: Subjective Type Questions [26 Marks] 

Answer any 3 out of the given 5 questions on Employability Skills. Answer each question in 

20-30 words. (3×2=6) 

Question 6. 

What is descriptive feedback? Give an example. 

 

Question 7. 

Why is the ability to work independently important? 

 

Question 8. 

Describe how to create, rename and delete a folder in a computer. 

 

Question 9. 

How can students prepare themselves to become future entrepreneurs? 
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Question 10. 

What are the benefits of respecting indigenous knowledge in sustainability? 

 

Answer any 4 out of the given 6 questions in 20-30 words each.    (4×2=8) 

Question 11. 

What does the Fill Format mode do in Writer? 

 

Question 12. 

What are subtotals in Calc and how are they applied? 

 

Question 13. 

What do you mean by recording changes in a spreadsheet? 

 

Question 14. 

Describe any two data types used in LibreOffice Base. 

 

Question 15. 

What is the importance of regular cleaning and hygiene at the workplace? 

 

Question 16. 

What precautions should be taken when working near electrical equipment? 

 

Answer any 3 out of the given 5 questions in 50-80 words each.    (3×4=12) 

Question 17. 

(a) What is the function of the Alignment option in positioning images? 

(b) How does the ‘Accept or Reject Changes’ feature help during document review? 

 

Question 18. 

An accountant, Mr. Suresh, maintains annual sales records. He wants to automate tax 

calculation, apply different tax rates and allow colleagues to comment on the file. 

(a) How can he automate tax calculations for all rows? 

(b) To apply two tax slabs ( 5% and 12% ) and see which benefits the company more, what 

tool should he use? 

(c) A colleague wants to suggest corrections. How can he add that in the file? 

(d) How can Mr. Suresh identify who made changes in the spreadsheet? 

 

Question 19. 

Your company has recently experienced minor electric shocks in a few departments. You’ve 

been asked to create a report and educate employees about the importance of electrical 

safety and how to respond during electrical emergencies. 

(a) What are two key electrical safety tips employees should follow? 

(b) Mention two first aid measures to be taken during an electrical emergency. 

 

Question 20. 

(a) What are reports in Base and how are they different from queries? 
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(b) How can you insert date and time in a Base report? 

 

Question 21. 

Consider the following table: 

Route_ID Start_Point End Point Driver.Name 

Ro1 

R02 

R03 

Sector 1 

Sector 5 

Sector 1 

School 

School 

School 

Rajesh 

Amil 

Rajesh 

(a) Suggest a suitable data type for the Route_ID and Driver_Name. 

(b) Which field should be set as the primary key and why? 

(c) Identify a possible alternate key and justify. 

(d) How many attributes and records are present? 
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Information Technology for Class X-Set 4 

Time: 2 Hours        Maximum Marks: 50 

Class 10 Textbooks 

Instructions: 

• Please read the instructions carefully. 

• This Question Paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions whereas Section B contains Subjective Type 

Questions. 

• Out of the given (5 + 16 = 21) questions, a candidate has to answer (5 + 10 = 15) 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A: Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• Marks allotted are mentioned against each question/part. 

• There is no negative marking. 

• Do as per the instructions given. 

• Section B: Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

Section A: Objective Type Questions [24 Marks] 

Question 1. 

Answer any 4 out of the given 6 questions on Employability Skills.    (4×1=4) 

(i) During a group activity, Sneha told her classmate, ‘Good job,’ without explaining what was 

good. What type of feedback did Sneha give? 

(a) Descriptive and specific 

(b) Written and formal 

(c) Vague and non-specific 

(d) Constructive and direct 

 

(ii) Which of the following best defines self-motivation? 

(a) Waiting for someone to guide you. 

(b) Taking breaks frequently. 

(c) Driving yourself to complete tasks willingly. 

(d) Asking others to finish your tasks. 

 

(iii) Kunal wrote an essay about his holiday trip to Manali where he had fun with family, 

explored nature and relaxed. This activity reflects 

(a) handling competition 

(b) memory test 

(c) reflective stress management 

(d) working under pressure 

 

(iv) The taskbar is generally located at the ………. of the screen and contains the Start 

menu, clock and open application icons. 

(a) top 
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(b) middle 

(c) bottom 

(d) side 

 

(v) Which of these is a good way to analyse strengths and weaknesses before starting a 

business? 

(a) Ignoring feedback 

(b) Group discussion on personal qualities 

(c) Avoiding challenges 

(d) Blindly following others 

 

(vi) Which of the following activities promotes sustainable development? 

(a) Deforestation 

(b) Excessive mining 

(c) Rainwater harvesting 

(d) Burning fossil fuels 

 

Question 2. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Meena has created a custom heading style and wants to reuse it in a new document. 

What should she do? 

(a) Use Save As 

(b) Load Styles from the existing document 

(c) Recreate manually 

(d) Use Fill Format 

 

(ii) Rishi inserted a table and wants to apply a uniform look to all similar tables. What can he 

use? 

(a) Table Template 

(b) Table Style 

(c) Page Style 

(d) Format Menu 

 

(iii) Which category of style would you use to format headings and body text? 

(a) Page Style 

(b) Character Style 

(c) Paragraph Style 

(d) List Style 

 

(iv) Which of these is not a valid option in the Styles and Formatting window? 

(a) All Styles 

(b) Custom Styles 

(c) Active Styles 

(d) Object Styles 

 

(v) Where can you find the option to edit a style? 

(a) Format → Edit Style 

(b) Tools → Style 
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(c) Insert → Template 

(d) View → Update 

 

(vi) Tanya has written a document and wants others to review it. She adds comments for 

clarity. Which menu will help her? 

(a) Insert → Comment 

(b) Tools → Spell Check 

(c) View → Review 

(d) Format → Note 

 

Question 3. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Which tool helps compare different scenarios by changing input values? 

(a) Subtotal 

(b) What-if Scenarios 

(c) Filter 

(d) Hyperlink 

 

(ii) To reference a cell in another sheet, the syntax used is 

(a) =Sheet 2.A1 

(b) =A1 

(c) =Group[A1] 

(d)=Call(A1) 

 

(iii) What is the default hyperlink type when linking to an external document? 

(a) Relative hyperlink 

(b) Absolute hyperlink 

(c) Internal hyperlink 

(d) Mixed hyperlink 

 

(iv) To record changes in a shared spreadsheet, which menu is used? 

(a) Data 

(b) Edit 

(c) Tools 

(d) View 

 

(v) Which menu option is used to insert a hyperlink? 

(a) Tools → Hyperlink 

(b) Insert → Hyperlink 

(c) Data → Hyperlink 

(d) Format → Hyperlink 

 

(vi) What tool allows you to automate repetitive tasks? 

(a) Subtotal 

(b) Macro 

(c) What-if Analysis 

(d) Consolidate 
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Question 4. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) What is the purpose of creating relationships in Base? 

(a) To link forms 

(b) To link queries 

(c) To link tables 

(d) To link reports 

 

(ii) Which field type should be used to store long paragraphs of text? 

(a) Text 

(b) Memo [Long Text] 

(c) Number 

(d) Varchar 

 

(iii) Which tool helps users view and manage table relationships visually? 

(a) Query Wizard 

(b) Report Builder 

(c) Relationship Tool 

(d) Table Designer 

 

(iv) Which of the following is a type of query used to modify data? 

(a) Update query 

(b) View query 

(c) Select query 

(d) Static query 

 

(v) In Base, a form control that displays current date automatically is 

(a) Label 

(b) Text Box 

(c) Date Field 

(d) Timer 

 

(vi) What is the purpose of inserting a Combo Box in a form? 

(a) To display images 

(b) To enter a long paragraph 

(c) To choose from a list of values 

(d) To show report output 

 

Question 5. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Which type of hazard can result from lifting heavy loads improperly? 

(a) Electrical 

(b) Fire 

(c) Physical 

(d) Ergonomic 

 

(ii) Using a damaged power cord falls under which hazard category? 

(a) Health hazard 
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(b) Electrical hazard 

(c) Physical hazard 

(d) Fire hazard 

 

(iii) Which one of the following is not a source of stress at the workplace? 

(a) Excessive workload 

(b) Supportive coworkers 

(c) Long hours 

(d) Job insecurity 

 

(iv) The purpose of evacuation drills in a workplace is to: 

(a) check fire alarms 

(b) train in safety procedures 

(c) clean office equipment 

(d) arrange furniture 

 

(v) Which body part is most affected by poor posture while using a computer? 

(a) Hands 

(b) Neck 

(c) Eyes 

(d) Feet 

 

(vi) Which guideline should be followed to avoid eye strain? 

(a) Sit in dark rooms 

(b) Work continuously without breaks 

(c) Adjust screen brightness and take breaks 

(d) Avoid using screens 

 

Section B: Subjective Type Questions [26 Marks] 

Answer any 3 out of the given 5 questions on Employability Skills. Answer each question in 

20-30 words.           (3×2=6) 

Question 6. 

What is one do and one don’t related to body language in communication? 

 

Question 7. 

What are the benefits of practicing yoga and meditation regularly? 

 

Question 8. 

How can you restore a file from the Recycle Bin? 

 

Question 9. 

What can we learn from first-generation and local entrepreneurs? 

 

Question 10. 

What does it mean to be an environmentally responsible citizen? 
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Answer any 4 out of the given 6 questions in 20-30 words each.    (4×2=8) 

Question 11. 

Explain the process of inserting an image using the ‘Insert Image’ option in Writer. 

 

Question 12. 

What is a macro in Calc? How does it help users? 

 

Question 13. 

Explain the difference between relative and absolute hyperlinks in Calc. 

 

Question 14. 

What is referential integrity in databases, and why is it important? 

 

Question 15. 

Mention any two musculoskeletal issues that arise from poor workstation setup. 

 

Question 16. 

What are general guidelines to reduce eye strain while working on a computer? 

 

Answer any 3 out of the given 5 questions in 50-80 words each.    (3×4=12) 

Question 17. 

(a) How do you group drawing objects in Writer, and what is its benefit? 

(b) What is anchoring, and how does it differ from alignment in Writer? 

 

Question 18. 

Ms. Riya is conducting a financial planning session. She wants to show clients multiple 

saving plans and link the summary report to an online document. 

(a) How can she show different savings outcomes based on varied interest rates? 

(b) She wants to link the spreadsheet to a PDF document online. What should she use? 

(c) Riya needs to pull stock prices live into the sheet. Which feature helps? 

(d) She needs to finalise a single document from two edited versions. What should she do? 

 

Question 19. 

In an office with glossy flooring and poor cable management, there have been multiple 

incidents of slips and falls. You are asked to draft safety guidelines to prevent such hazards. 

(a) What are two precautions to prevent slips and trips at work? 

Answer: 

(b) What should an employee do immediately after witnessing a slip-and-fall accident? 

 

Question 20. 

(a) How can you delete records from a table in Base and what precautions should be taken? 

(b) Explain how to sort data in a table in LibreOffice Base. 

 

Question 21. 

Consider the following table: 
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Member_ID Name Class Join_Date 

LM001 

LM002 

LM003 

Nisha 

Anil 

Nisha 

9 

10 

9 

2023-04-10 

2023-05-11 

2023-06-12 

(a) Suggest a suitable data type for the Member_ID and Class. 

(b) Which field should be set as the primary key and why? 

(c) Identify a possible alternate key and justify. 

(d) How many attributes and records are present? 
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Information Technology for Class X-Set 5 

Time: 2 Hours        Maximum Marks: 50 

Instructions: 

• Please read the instructions carefully. 

• This Question Paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions, where as Section B contains Subjective 

Type Questions. 

• Out of the given (5 + 16 = 21) questions, a candidate has to answer (5 + 10 = 15) 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A: Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• Marks allotted are mentioned against each question/part. 

• There is no negative marking. 

• Do as per the instructions given. 

• Section B: Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

 

Section A: Objective Type Questions [24 Marks] 

Question 1. 

Answer any 4 out of the given 6 questions on Employability Skills.    (4×1=4) 

(i) Raj sent a detailed email to his team explaining a new project. However, his team 

misunderstood several points. 

What is a likely disadvantage of written communication in this case? 

(a) It allows immediate feedback. 

(b) It is open to interpretation and may lack clarity. 

(c) It encourages better listening. 

(d) It is faster than verbal communication. 

 

(ii) Which of these qualities is most essential when planning and completing a task 

independently? 

(a) Imitation 

(b) Carelessness 

(c) Goal setting and time management 

(d) Over-dependence on others 

 

(iii) Nisha works on her science project alone by setting deadlines, researching on her own 

and completing the model without any help. This shows 

(a) group coordination 

(b) teamwork 

(c) working independently 

(d) depending on others 

 



Information Technology Class X Sample Papers - Page 30 of 42 
 

(iv) A ………… operating system is designed to manage multiple users at the same time. 

(a) Single-user 

(b) Batch processing 

(c) Multi-user 

(d) Real-time 

 

(v) What should be the first step when planning to start a business in a team? 

(a) Start selling immediately 

(b) Collect and analyse business-related data 

(c) Ignore market demand 

(d) Wait for a competitor to start 

 

(vi) Which of the following is a major problem affecting sustainable development? 

(a) Plantation of trees 

(b) Overuse of natural resources 

(c) Using solar power 

(d) Recycling plastic 

 

Question 2. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Neha imported a template but cannot find it in the template manager. What should she do 

next? 

(a) Reinstall Writer 

(b) Reopen the software 

(c) Click on Manage Templates and check under imported templates 

(d) Delete all other templates 

 

(ii) To place an image in the exact same location on every page, which anchoring method 

should be used? 

(a) Anchor to Character 

(b) Anchor to Paragraph 

(c) Anchor to Page 

(d) Anchor as Character 

 

(iii) Which tool helps to compare differences between two documents? 

(a) Review Document 

(b) Compare Document 

(c) Merge Documents 

(d) Check Differences 

 

(iv) What does the Text Wrapping option allow you to do? 

(a) Add watermark 

(b) Place text over image 

(c) Control how text flows around objects 

(d) Copy formatting 

 

(v) Which toolbar is used to resize or crop images in Writer? 

(a) Drawing toolbar 

(b) Image toolbar 
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(c) Standard toolbar 

(d) Review toolbar 

 

(vi) Farhan is collaborating on a group project. He wants to track who made which changes. 

Which Writer feature will help? 

(a) Commenting 

(b) Mail Merge 

(c) Track Changes 

(d) Clone Formatting 

 

Question 3. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Which feature in Calc helps combine totals from multiple sheets into one summary? 

(a) Subtotal 

(b) Consolidate 

(c) Goal Seek 

(d) Group 

 

(ii) What does the Subtotal tool do? 

(a) Creates macros 

(b) Groups rows and calculates aggregated values 

(c) Sorts data alphabetically 

(d) Inserts comments 

 

(iii) Goal Seek is found under which menu? 

(a) Tools 

(b) Data 

(c) Edit 

(d) Format 

 

(iv) What is the primary purpose of grouping rows or columns in LibreOffice Calc? 

(a) To sort the data 

(b) To hide or show details and summarise data 

(c) To apply conditional formatting 

(d) To validate data entry 

 

(v) What symbol is used to add a new sheet manually? 

(a) + 

(b) \% 

(c) * 

(d) / 

 

(vi) Which hyperlink type is used to link within the same file across sheets? 

(a) Relative hyperlink 

(b) Absolute hyperlink 

(c) Mixed hyperlink 

(d) Web hyperlink 
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Question 4. 

Answer any 5 out of the given 6 questions       (5×1=5) 

(i) Which one of the following helps in viewing only specific records from a table? 

(a) Form 

(b) Filter 

(c) Report 

(d) Table 

 

(ii) Which command is used to open an existing database in Base? 

(a) File → Open 

(b) Insert → Database 

(c) Tools → Database 

(d) Data → Open 

 

(iii) A group of related fields in a table is known as 

(a) Record 

(b) Table 

(c) Cell 

(d) Column 

 

(iv) What is the purpose of using queries in a database? 

(a) For designing tables 

(b) For inputting data 

(c) For retrieving specific data 

(d) For printing data 

 

(v) Which type of relationship exists when multiple records in one table relate to multiple 

records in another? 

(a) One-to-one 

(b) One-to-many 

(c) Many-to-many 

(d) Multi-link 

 

(vi) The control used to create titles and headers in a report is called 

(a) Text Box 

(b) Label 

(c) Title Tool 

(d) Heading Field 

 

Question 5. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Which of the following is a potential source of hazard in an office environment? 

(a) File cabinets 

(b) Paperclips 

(c) Wet floors 

(d) Office chairs 

 

(ii) Why is proper ventilation important in the workplace? 

(a) To save electricity 
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(b) To reduce noise 

(c) To improve air quality and health of employees 

(d) To avoid lighting issues 

 

(iii) An example of a fire hazard is 

(a) Open wires 

(b) First-aid kit 

(c) Safe water 

(d) Clean air 

 

(iv) A musculoskeletal disorder commonly caused by long hours of computer work is 

(a) Diabetes 

(b) Eye strain 

(c) Repetitive Strain Injury (RSI) 

(d) Asthma 

 

(v) Emergency exits must be 

(a) locked always 

(b) used only by staff 

(c) blocked with furniture 

(d) free of obstacles 

 

(vi) Which of the following is an example of a health hazard? 

(a) Slippery floor 

(b) Loud noise 

(c) Inhalation of harmful chemicals 

(d) Broken glass 

 

Section B: Subjective Type Questions [26 Marks] 

Answer any 3 out of the given 5 questions on Employability Skills. Answer each question in 

20-30 words.           (3×2=6) 

Question 6. 

Mention one advantage and one disadvantage of verbal communication. 

 

Question 7. 

Explain how taking nature walks can relieve stress. 

 

Question 8. 

Why is it important to clean computer components regularly? 

 

Question 9. 

What is the importance of an entrepreneur in economic development? 

 

Question 10. 

How do solar cookers contribute to sustainable development? 
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Answer any 4 out of the given 6 questions in 20-30 words each.    (4×2=8) 

Question 11. 

What is the purpose of the Paragraph Style in Writer and how is it used? 

 

Question 12. 

What is the purpose of Goal Seek in Calc? Explain with an example. 

 

Question 13. 

What is meant by linking to an external data source in Calc? How is it useful? 

 

Question 14. 

What are the three types of relationships in databases? Give a brief explanation of each. 

 

Question 15. 

What are key responsibilities of employees during emergencies like fires or evacuations? 

 

Question 16. 

What is the purpose of a safety checklist in the workplace? 

 

Answer any 3 out of the given 5 questions in 50-80 words each.    (3×4=12) 

Question 17. 

(a) What is the purpose of the Track Changes feature in Writer? 

(b) What steps are involved in exporting a template in LibreOffice Writer? 

 

Question 18. 

Mr. Karan manages employee attendance in different sheets per department. He now wants 

a summary sheet and wants to insert quick navigation links to each department. 

(a) How can Karan compile all department attendance into one sheet? 

(b) How can he link each department name in the summary sheet to its respective sheet? 

(c) Karan wants to protect data but allow comments. How? 

(d) He needs to keep record of who edited what. What option is useful? 

 

Question 19. 

During a fire drill in your company, employees were confused about the correct evacuation 

route. You are asked to provide clarity on evacuation and fire hazard protocols. 

(a) Mention two general evacuation guidelines in case of a fire. 

(b) Identify two fire hazard sources in offices. 

 

Question 20. 

(a) What is a form in LibreOffice Base and how is it useful? 

(b) How can a user modify a form in Libre Office Base? 

 

Question 21. 

Consider the following table: 



Information Technology Class X Sample Papers - Page 35 of 42 
 

Teacher_ID Name Subject Contact_No 

T01 

T02 

T03 

Mr. Joshi 

Mrs. Meena 

Mr. Joshi 

Physics 

Chemistry 

Physics 

9876512345 

8765412345 

7654312345 

(a) Suggest a suitable data type for the Teacher_ID and Contact_No. 

(b) Which field should be set as the primary key and why? 

(c) Identify a possible alternate key and justify. 

(d) How many attributes and records are present? 
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Information Technology for Class X-Set 6 

Time: 2 Hours        Maximum Marks: 50 

Instructions: 

• Please read the instructions carefully. 

• This Question Paper consists of 21 questions in two sections: Section A & Section B. 

• Section A has Objective Type Questions whereas Section B contains Subjective Type 

Questions. 

• Out of the given (5 + 16 = 21) questions, a candidate has to answer (5 + 10 = 15) 

questions in the allotted (maximum) time of 2 hours. 

• All questions of a particular section must be attempted in the correct order. 

• Section A: Objective Type Questions (24 Marks) 

• This section has 5 questions. 

• Marks allotted are mentioned against each question/part. 

• There is no negative marking. 

• Do as per the instructions given. 

• Section B: Subjective Type Questions (26 Marks) 

• This section has 16 questions. 

• A candidate has to do 10 questions. 

• Do as per the instructions given. 

• Marks allotted are mentioned against each question/part. 

 

Section A: Objective Type Questions [24 Marks] 

Question 1. 

Answer any 4 out of the given 6 questions on Employability Skills.    (4×1=4) 

(i) Rita is giving a presentation but keeps looking away from the audience, folds her arms 

tightly and avoids eye contact. 

What type of communication is Rita failing to use effectively? 

(a) Verbal Communication 

(b) Visual Communication 

(c) Non-verbal Communication 

(d) Written Communication 

 

(ii) What is the first step to demonstrate independent working skills effectively? 

(a) Avoid all responsibilities 

(b) Wait for detailed instructions 

(c) Set a clear goal and make a plan 

(d) Ask a friend to do the task 

 

(iii) Raghav always makes a daily schedule, sets small goals and tracks his progress to 

complete homework on time. This is an example of 

(a) procrastination 

(b) goal-oriented planning 

(c) external motivation 

(d) time wastage 

 

(iv) A …………. is a system software that manages hardware and software resources and 

provides services for computer programs. 

(a) File Manager 
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(b) Operating System 

(c) Anti-virus 

(d) Web browser 

 

(v) Reading or hearing about success stories of first-generation entrepreneurs helps 

students to – 

(a) copy their business idea. 

(b) understand entrepreneurial challenges and gain inspiration. 

(c) give up early. 

(d) avoid planning. 

 

(vi) Which of the following best defines sustainable development? 

(a) Rapid use of natural resources for profit. 

(b) Development that meets current needs without harming future generations. 

(c) Development focused only on industries. 

(d) Development without using any resources. 

 

Question 2. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) Reena inserted a drawing object in her document. She wants to duplicate it multiple times 

without redrawing. Which option should she use? 

(a) Copy and Paste 

(b) Insert Object 

(c) Clone Formatting 

(d) Redraw Tool 

 

(ii) Arjun is preparing a brochure and wants to organise multiple objects together as a single 

unit. Which option should he use? 

(a) Align 

(b) Anchor 

(c) Group 

(d) Wrap 

 

(iii) Which one is not a valid method to insert an image into Writer? 

(a) Insert → Image 

(b) Drag and Drop 

(c) Copy and Paste 

(d) Link from Clipboard 

 

(iv) What is the purpose of Fill Format in Styles and Formatting? 

(a) Deletes a style 

(b) Creates a paragraph 

(c) Applies a style quickly to multiple items 

(d) Resets styles 

 

(v) What is the purpose of hierarchy in headings? 

(a) It stores passwords. 

(b) It determines the print size. 
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(c) It helps in generating the Table of Contents. 

(d) It renames the title. 

 

(vi) Dev wants to update an existing style after changing text formatting. Which method 

should he use? 

(a) Load Style 

(b) Update Style from Selection 

(c) Clone Style 

(d) Fill Format 

 

Question 3. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) In LibreOffice Calc, which option is used to merge data from multiple sheets into a single 

sheet? 

(a) Goal Seek 

(b) Sort 

(c) Consolidate 

(d) Format Cells 

 

A. Mistake Alert 

Some students confuse consolidate with sort-sorting doesn’t combine data across sheets. 

(ii) What-if scenarios are useful for 

(a) sorting data. 

(b) data entry. 

(c) exploring different outcomes based on varying inputs. 

(d) printing documents. 

 

(iii) Which menu in LibreOffice Calc is used to run a recorded macro? 

(a) File → Open 

(b) Tools → Macros → Run Macro 

(c) Insert → Macro 

(d) View → Record Macro 

 

(iv) When you use a complete file path in a hyperlink, it is known as 

(a) Relative hyperlink 

(b) Absolute hyperlink 

(c) External hyperlink 

(d) Document hyperlink 

 

(v) Which option is used to compare two different versions of the same spreadsheet file in 

Calc? 

(a) Merge Document 

(b) Combine Cells 

(c) Compare Document 

(d) Scenario Manager 
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(vi) In Calc, which feature allows you to view the list of changes made by different users in a 

shared spreadsheet? 

(a) Share Document 

(b) Accept or Reject Changes 

(c) Insert Comment 

(d) Goal Seek 

 

Question 4. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) What is the main function of a report in Libre Office Base? 

(a) To enter data 

(b) To edit records 

(c) To present data in printable format 

(d) To relate tables 

 

(ii) Which of the following is an object in a Base database? 

(a) Slide 

(b) Cell 

(c) Table 

(d) Cell group 

 

(iii) Which control in a form is used to display a list of predefined options? 

(a) Label 

(b) Combo Box 

(c) Button 

(d) Text Box 

 

(iv) What kind of key is used to link two related tables? 

(a) Display Key 

(b) Secondary Key 

(c) Foreign Key 

(d) Data Key 

 

(v) Which form control allows users to add a command button like Submit? 

(a) Text Box 

(b) Push Button 

(c) Label 

(d) Option Box 

 

(vi) In the Form Design, to make the form visually appealing, you can use 

(a) Macros 

(b) Query Wizard 

(c) Label and Formatting tools 

(d) SQL command 

 

Question 5. 

Answer any 5 out of the given 6 questions.       (5×1=5) 

(i) What is the first step in handling an accident at the workplace? 

(a) Fill out a report 
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(b) Take photos 

(c) Attend to the injured person 

(d) Post on notice board 

 

(ii) Which of these is considered a physical hazard? 

(a) Improper lighting 

(b) Poor air quality 

(c) Excessive screen time 

(d) High stress level 

 

(iii) What is the full form of OHS? 

(a) Occupational Health and Security 

(b) Occupational Health and Safety 

(c) Office Health Service 

(d) Organizational Health Standard 

 

(iv) An accident caused by a box falling from a shelf is an example of 

(a) Trip hazard 

(b) Slipping hazard 

(c) Falling object hazard 

(d) Health hazard 

 

(v) A safety checklist is important because 

(a) it increases paperwork. 

(b) it reduces productivity. 

(c) it ensures hazards are identified and prevented. 

(d) it replaces fire drills. 

 

(vi) Water on the office floor is an example of a 

(a) Fire hazard 

(b) Health hazard 

(c) Slipping hazard 

(d) Noise hazard 

 

Section B: Subjective Type Questions [26 Marks] 

Answer any 3 out of the given 5 questions on Employability Skills. Answer each question in 

20-30 words.           (3×2=6) 

Question 6. 

What are the three basic methods of communication? 

 

Question 7. 

How do vacations and holidays help in stress management? 

 

Question 8. 

What is a maintenance schedule for a computer and why is it needed? 
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Question 9. 

How does entrepreneurship help in solving social problems? 

 

Question 10. 

Suggest two ways to overcome problems in sustainable development. 

 

Answer any 4 out of the given 6 questions in 20-30 words each.    (4×2=8) 

Question 11. 

What is the Frame Style category in LibreOffice Writer? 

 

Question 12. 

What is Data Consolidation in Calc? How can it be useful while working with multiple 

sheets? 

 

Question 13. 

What do you understand by the term Macro as a Function? Give one advantage of using it. 

 

Question 14. 

What are the main features of LibreOffice Base interface? 

 

Question 15. 

What are two key safety practices to follow while using a computer for long hours? 

 

Question 16. 

What actions should you take if someone receives an electric shock at the workplace? 

 

Answer any 3 out of the given 5 questions in 50-80 words each.    (3×4=12) 

Question 17. 

(a) Describe how to use the Image Toolbar to crop an image in Writer. 

(b) Explain the importance of hierarchy of headings in a document. 

 

Question 18. 

Mr. Prakash handles sales data for four branches. He uses multiple sheets and now wants 

better linking, editing tracking and user collaboration. 

(a) How can he create links from the summary sheet to each branch’s worksheet? 

(b) Prakash wants to track team edits in the sales file. What can he do? 

(c) A new team member wants to update the spreadsheet but needs to know which cells are 

editable. What should be done? 

(d) To find the effect of a discount on revenue, which tool should Prakash use? 

 

Question 19. 

An inspection revealed poor sanitation and low indoor air quality in your office. Management 

wants immediate improvements and awareness sessions on cleanliness and air quality. 

(a) Why is maintaining clean air and water important in workplaces? 
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(b) Give two workplace cleanliness practices that promote health. 

 

Question 20. 

(a) Define a primary key. Why is it important in a table? 

(b) Explain the difference between using a wizard and design view to create a table. 

 

Question 21. 

Consider the following table: 

Book_ID Title Author Price 

B101 

B102 

B103 

Science Wonders 

World Geography 

Science Wonders 

A. Verma 

K. Sharma 

A. Verma 

350 

400 

350 

(a) Suggest a suitable data type for the Book_ID and Price fields. 

(b) Which field should be set as the primary key and why? 

(c) Identify a possible alternate key and justify. 

(d) How many attributes and records are present? 
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gm_mÝ` {ZX}e … 
{ZåZ{b{IV {ZX}em| H$mo ~hþV gmdYmZr go n{‹T>E Am¡a CZH$m nmbZ H$s{OE … 
(i) Bg àíZ-nÌ _| 39 àíZ h¢Ÿ& g^r àíZ A{Zdm ©̀ h¢Ÿ& 
(ii) àíZ-nÌ nm§M IÊS>m| _| {d^m{OV h¡ - IÊS> H$, I, J, K VWm ‹S>Ÿ& 
(iii) IÊS> H$ _| àíZ g§»`m 1 go 20 VH$ ~hþ{dH$ënr` àH$ma Ho$ EH$-EH$ A§H$ Ho$ àíZ h¢Ÿ& 
(iv) IÊS> I _| àíZ g§»`m 21 go 26 VH$ A{V bKw-CÎmar` (VSA) àH$ma Ho$ Xmo-Xmo A§H$m| Ho$ 

àíZ h¢Ÿ& BZ àíZm| Ho$ CÎma 30 go 50 eãXm| _| {XE OmZo Mm{hEŸ& 
 (v) IÊS> J _| àíZ g§»`m 27 go 33 VH$ bKw-CÎmar` (SA) àH$ma Ho$ VrZ-VrZ A§H$m| Ho$ àíZ 

h¢Ÿ& BZ àíZm| Ho$ CÎma 50 go 80 eãXm| _| {XE OmZo Mm{hEŸ& 
(vi) IÊS> K _| àíZ g§»`m 34 go 36 VH$ XrK©-CÎmar` (LA) àH$ma Ho$ nm§M-nm§M A§H$m| Ho$ àíZ 

h¢Ÿ& BZ àíZm| Ho$ CÎma 80 go 120 eãXm| _| {XE OmZo Mm{hEŸ& 
(vii) IÊS> ‹S> _| àíZ g§»`m 37 go 39 VH$ òmoV AmYm[aV / àH$aU AmYm[aV BH$mB`m| Ho$ 

_yë`m§H$Z Ho$ Mma-Mma A§H$m| Ho$ àíZ (Cn-àíZm| g{hV) h¢Ÿ& 
(viii) àíZ-nÌ _| g_J« {dH$ën Zht {X`m J`m h¡Ÿ& `Ú{n, Hw$N> IÊS>m| _| AmÝV[aH$ {dH$ën {XE JE h¢Ÿ& 

 IÊS> - H$  
 (~hþ{dH$ënr` àíZ) 
1.  O~ nmoQ>¡{e`_ Am`moS>mBS> Am¡a boS> ZmBQ´>oQ> Ho$ Obr` {db`Z {_bVo h¢ Vmo EH$ A{dbò  nXmW© 

AbJ hmo OmVm h¡Ÿ& Bg_| hmoZo dmbr A{^{H«$`m H$m amgm`{ZH$ g_rH$aU h¡ … 1 
(a) KI + PbNO3 PbI + KNO3 

(b) 2KI + Pb(NO3)2 PbI2 + 2KNO3 

(c) KI + Pb(NO3)2 PbI + KNO3 

(d) KI + PbNO3 PbI2 + KNO3 

2.  O~ gmo{S>`_ ~mBH$m~m}ZoQ> hmBS´>moŠbmo[aH$ Aåb go A{^{H«$`m H$aVm h¡, Vmo : 1 

(a) hmBS´>moOZ J¡g {ZH$bVr h¡ Omo ObVr Vrbr go nm°n Üd{Z XoVr h¡Ÿ& 

(b) hmBS´>moOZ J¡g {ZH$bVr h¡ Omo MyZo Ho$ nmZr H$mo Xy{Y`m H$a XoVr h¡Ÿ& 

(c) H$m~©Z S>mBAm°ŠgmBS> J¡g {ZH$bVr h¡ Omo MyZo Ho$ nmZr H$mo Xy{Y`m H$a XoVr h¡Ÿ& 

(d) H$m~©Z S>mBAm°ŠgmBS> J¡g {ZH$bVr h¡ Omo ObVr Vrbr H$mo nm°n Üd{Z Ho$ gmW ~wPm XoVr h¡Ÿ& 
3.  Q>_mQ>a _| CnpñWV Aåb h¡ … 1 

(a) _oWmZm°BH$ Aåb (b) Eogr{Q>H$ Aåb 
(c) b¡pŠQ>H$ Aåb (d) Am°Šg¡{bH$ Aåb 

4.  {H$gr YmVw ‘X’ H$m [a~Z Am°ŠgrOZ _| MH$mMm¢Y H$aZo dmbo ídoV àH$me H$s Ádmbm go ObVm 
h¡ {Og_| H$moB© ídoV amI ‘Y’ ~ZVr h¡Ÿ& Bg A{^{H«$`m _| X,Y Am¡a hmoZo dmbr A{^{H«$`m Ho$ 
àH$ma H$m ghr {ddaU Bg àH$ma h¡ … 1 

(a) X = Ca ; Y = CaO ; A{^{H«$`m H$m àH$ma = {d`moOZ 

(b) X = Mg ; Y = MgO ; A{^{H«$`m H$m àH$ma = g§̀ moOZ 

(c) X = Al ; Y = Al2O3 ; A{^{H«$`m H$m àH$ma = D$î_r` {d`moOZ 

(d) X = Zn ; Y = ZnO ; A{^{H«$`m H$m àH$ma = D$î_memofr 
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GENERAL INSTRUCTIONS : 
Read the following instructions very carefully and follow them : 

(i) This question paper consists of 39 questions. All questions are compulsory. 

(ii) Question paper is divided into FIVE sections – Section A, B, C, D and E. 

(iii) In section A – question number 1 to 20 are multiple choice questions (MCQs) carrying  

1 mark each. 

(iv) In section B – question number 21 to 26 are very short answer (VSA) type questions carrying 

2 marks each. Answer to these questions should be in the range of 30 to 50 words. 

(v) In section C – question number 27 to 33 are short answer (SA) type questions carrying  

3 marks each. Answer to these questions should in the range of 50 to 80 words. 

(vi) In section D – question number 34 to 36 are long answer (LA) type questions carrying  

5 marks each. Answer to these questions should be in the range of 80 to 120 words. 

(vii) In section E – question number 37 to 39 are of 3 source based/case based units of 

assessment carrying 4 marks each with sub-parts. 

(viii) There is no overall choice. However, an internal choice has been provided in some sections. 

 SECTION – A 

 (Multiple Choice Questions) 

1. When aqueous solutions of potassium iodide and lead nitrate are mixed, an 

insoluble substance separates out. The chemical equation for the reaction 

involved is : 1 

(a) KI + PbNO3 PbI + KNO3 

(b) 2KI + Pb(NO3)2 PbI2 + 2KNO3 

(c) KI + Pb(NO3)2 PbI + KNO3 

(d) KI + PbNO3 PbI2 + KNO3 

2. When Sodium bicarbonate reacts with dilute hydrochloric acid, the gas 

evolved is : 1 

(a) Hydrogen; it gives pop sound with burning match stick. 

(b) Hydrogen; it turns lime water milky. 

(c) Carbon dioxide; it turns lime water milky. 

(d) Carbon dioxide; it blows off a burning match stick with a pop sound. 

3. Acid present in tomato is : 1 

(a) Methanoic acid (b) Acetic acid 

(c) Lactic acid (d) Oxalic acid 

4. A metal ribbon ‘X’ burns in oxygen with a dazzling white flame forming a 

white ash ‘Y’. The correct description of X, Y and the type of reaction is : 1 

(a) X = Ca ; Y = CaO ; Type of reaction = Decomposition 

(b) X = Mg ; Y = MgO ; Type of reaction = Combination  

(c) X = Al ; Y = Al2O3 ; Type of reaction = Thermal decomposition 

(d) X = Zn ; Y = ZnO ; Type of reaction = Endothermic  
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5.  Ob H$s H$R>moaVm H$mo Xya H$aZo Ho$ {bE Cn`moJ {H$E OmZo dmbo bdU H$m Zm_ h¡ … 1 

(a) gmo{S>`_ hmBS´>moOZ H$m~m}ZoQ> (NaHCO3) 

(b) gmo{S>`_ ŠbmoamBS> (NaCl) 

(c) gmo{S>`_ H$m~m}ZoQ> S>oH$mhmBS´>oQ> (Na2CO3.10H2O) 

(d) H¡$pëg`_ gë\o$Q> ho_rhmBS´>oQ> (CaSO4. 
1

2
H2O) 

6.  ŠbmoarZ Ho$ AUw H$s BboŠQ´>m°Z-{~ÝXw g§aMZm h¡ … 1 

(a)  (b)  

(c)  (d)  

 

7.  gmo{S>`_ hmBS´>m°ŠgmBS> jma (EoëH$br) h¡ O~{H$ \o$[aH$ hmBS´>m°ŠgmBS> jma (EoëH$br) Zht h¡, 
Š`m|{H$ … 1 

(a) gmo{S>`_ hmBS´>m°ŠgmBS> à~b jmaH$ h¡ O~{H$ \o$[aH$ hmBS´>m°ŠgmBS> Xw~©b jmaH$ h¡Ÿ& 

(b) gmo{S>`_ hmBS´>m°ŠgmBS> Eogm jmaH$ h¡ Omo Ob _| {dbò  h¡ O~{H$ \o$[aH$ hmBS´>m°ŠgmBS> ^r 
jmaH$ h¡ naÝVw `h Ob _| {dbò  Zht h¡Ÿ& 

(c) gmo{S>`_ hmBS´>m°ŠgmBS> à~b jmaH$ h¡ O~{H$ \o$[aH$ hmBS´>m°ŠgmBS> à~b Aåb h¡Ÿ& 

(d) gmo{S>`_ hmBS´>m°ŠgmBS> Am¡a \o$[aH$ hmBS´>m°ŠgmBS> XmoZm| hr à~b jmaH$ h¢ naÝVw gmo{S>`_ 
hmBS>m°ŠgmBS> H$s Ob _| {dbò Vm \o$[aH$ hmBS´>m°ŠgmBS> H$s Ob _| {dbò Vm H$s VwbZm _| 
A{YH$ h¡Ÿ& 

8.  a§Y«m| Ho$ IwbZo Am¡a ~ÝX hmoZo H$m H$maU h¡ … 1 

(a) H$mo{eH$mAm| Ho$ ^rVa J¡gm| H$m Cƒ Xm~ 

(b) Ûma H$mo{eH$mAm| _| Ob H$s ~mha Am¡a ^rVa J{V 

(c) Ûma H$mo{eH$mAm| _| àH$me H$m CÔrnZ 

(d) Ûma H$mo{eH$mAm| _| CO2 H$m ^rVa Am¡a ~mha {dgaU 

9. O‹S>m| _| Ob Ho$ àdoe H$aZo H$m H$maU h¡ … 1 

(a) O‹S>m| H$m Ob H$mo Ademo{fV H$aZo H$m H$m`© 

(b) _¥Xm Am¡a O‹S>m| Ho$ ~rM Am`Zm| H$s gm§ÐVm _| AÝVa 

(c) _¥Xm _| Ob Am{YŠ` H$s CnpñW{V 

(d) O‹S>m| _| Ob H$m {dgaU 
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5. The name of the salt used to remove permanent hardness of water is : 1 

(a) Sodium hydrogen carbonate (NaHCO3) 

(b) Sodium chloride (NaCl) 

(c) Sodium carbonate decahydrate (Na2CO3.10H2O) 

(d) Calcium sulphate hemihydrate (CaSO4. 
1

2
H2O) 

6. The electron dot structure of chlorine molecule is : 1 

(a)  (b)  

(c)  (d)  

 

7. Sodium hydroxide is termed an alkali while Ferric hydroxide is not 

because : 1 

(a) Sodium hydroxide is a strong base, while Ferric hydroxide is a weak 

base. 

(b) Sodium hydroxide is a base which is soluble in water while Ferric 

hydroxide is also a base but it is not soluble in water. 

(c) Sodium hydroxide is a strong base while Ferric hydroxide is a strong 

acid. 

(d) Sodium hydroxide and Ferric hydroxide both are strong base but the 

solubility of Sodium hydroxide in water is comparatively higher than 

that of Ferric hydroxide. 

8. Opening and closing of stomata is due to : 1 

(a) High pressure of gases inside the cells. 

(b) Movement of water in and out of the guard cells. 

(c) Stimulus of light in the guard cells. 

(d) Diffusion of CO2 in and out of the guard cells. 

9. Water in the root enters due to : 1 

(a) the function of the root to absorb water. 

(b) difference in the concentration of ions between the root and the soil. 

(c) excess water present in the soil. 

(d) diffusion of water in the roots. 
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10. ZrM {X`m J`m H$m¡Zgm H$WZ gË` h¡ ? 1 

(a) DNA _| {H$gr {deof bjU H$s nyU© gyMZm hmoVr h¡Ÿ& 

(b) DNA dh AUw h¡ Omo OZH$m| go g§V{V`m| _| d§emJV bjUm| Ho$ {bE CÎmaXm`r h¡Ÿ& 

(c) gyMZm _| n[adV©Z {^Þ àmoQ>rZ CËnÞ H$aoJmŸ& 

(d) àmoQ>rZ _| n[adV©Z hmoZo na bjU ({deofVmE§) g_mZ ah|JoŸ& 

11. {H$gr à{VdVu Mmn _| g§doXr V§{ÌH$m H$mo{eH$m gyMZm H$mo J«mhr H$mo{eH$mAm| go H$hm± VH$ nhþ§MmVr 
h¡ ? 1 

(a) _oê$ aÁOw (b) _pñVîH$ 

(c) H$m`©H$a A§J H$s no{e`m± (d) J«mhr A§J H$s ApñW`m± 

12.  ídoV nwînm| Ho$ _Q>a Ho$ nm¡Ym| (vv) Am¡a ~¢JZr nwînm| Ho$ _Q>a Ho$ nm¡Ym| (VV) Ho$ ~rM g§H$aU Ho$ 
n[aUm_ñdê$n F2 g§V{V àmá hþB©, {Og_| ~¢JZr (VV) Am¡a ídoV (vv) nwînm| dmbo nm¡Ym| H$m 
AZwnmV hmoJm … 1 

(a) 1 : 1 (b) 2 : 1 (c) 3 : 1 (d) 1 : 3 

13. {H$gr Ymamdmhr d¥ÎmmH$ma nme Ûmam CËnÞ Mwå~H$s` joÌ H$s Mwå~H$s` joÌ aoImAm| H$m ghr n¡Q>Z© h¡ … 1 

(a)  (b)  

(c)   (d)  
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10. Which one of the given statements is incorrect : 1 

(a) DNA has the complete information for a particular characteristic. 

(b) DNA is the molecule responsible for the inheritance of characters 

from parents to offsprings. 

(c) Change in information will produce a different protein. 

(d) Characteristics will remain the same even if protein changes. 

11. Sensory nerve of a reflex arc carries information from the receptor cells to 

the : 1 

(a) spinal cord 

(b) brain 

(c) muscles of the effector organ 

(d) bones of the receptor organ 

12. A cross between pea plant with white flowers (vv) and pea plant with 

violet flowers (VV) resulted in F2 progeny in which ratio of violet (VV) 

and white (vv) flowers will be : 1 

(a) 1 : 1 (b) 2 : 1 (c) 3 : 1 (d) 1 : 3 

13. The correct pattern of magnetic field lines of the field produced by a 

current carrying circular loop is : 1 

(a)   (b)  

 

 

(c)   (d)  
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14.  12W Am¡a 6W Ho$ Xmo LED ~ë~ loUr _| g§̀ mo{OV h¢Ÿ& `{X 12W Ho$ ~ë~ go 0.06A Ymam 
àdm{hV hmo ahr h¡, Vmo 6W Ho$ ~ë~ go àdm{hV Ymam hmoJr … 1 
(a) 0.04A (b) 0.06A (c) 0.08A (d) 0.12A 

15. Xem©E AZwgma H$moB© Eë\$m H$U {H$gr EH$g_mZ Mwå~H$s` joÌ _| àdoe H$aVm h¡Ÿ& Bg Eë\$m H$U 
H$s J{V H$s {Xem hmoJr … 1 

(a) Xm{hZr Amoa 

(b) ~mBª Amoa 

(c) H$mJµO _| ^rVa H$s Amoa OmVo hþE 

(d) H$mJµO go ~mha H$s Amoa AmVo hþEŸ 

16.  {H$gr à{VamoYH$ Ho$ _mZ H$mo KQ>mH$a CgHo$ àmapå^H$ _mZ H$m AmYm H$a {X`m J`m h¡Ÿ& `{X {dÚwV 
n[anW Ho$ AÝ` àmMbm| _| H$moB©© n[adV©Z Zht hmoVm h¡, Vmo à{VamoYH$ _| CËnÞ D$î_m hmoJr … 1 

(a) Mma JwZr 

(b) Xmo JwZr 

(c) AmYr 

(d) Mm¡WmB© 

àíZ g§»`m  17 go 20 VH$ A{^H$WZ Am¡a H$maU Am Ym[aV à íZ h¢Ÿ& 

BZ_| Xmo H$WZ, A{^H$WZ (A) Am¡a H$maU (R) {XE JE h¢Ÿ& ZrMo {XE JE {dH$ë nm| _| go Cn ẁ º $ 
{dH$ën H$m  M`Z H$aVo hþE BZ àíZm| Ho$ CÎma Xr{OEŸ& 

(a) (A) VWm (R) XmoZm| gË` h¢ Am¡a (R), (A) H$s ghr ì`m»`m H$aVm h¡Ÿ& 

(b) (A) VWm (R) XmoZm| gË` h¢ naÝVw (R), (A) H$s ghr ì`m»`m Zht H$aVm h¡Ÿ& 

(c) (A) gË` h¡ naÝVw (R) AgË` h¡Ÿ& 

(d) (A) AgË` h¡ naÝVw (R) gË` h¡Ÿ& 

17.  A{^H$WZ (A) … _mZdm| _| `{X H$mbo ZoÌm| Ho$ {bE OrZ (B) CÎmaXm`r h¡ Am¡a ŷao ZoÌm| Ho$ 

{bE OrZ (b) CÎmaXm`r h¡, Vmo {Og g§V{V H$m OrZ g§̀ moOZ Bb, bb AWdm BB h¡, Vmo CgHo$ 
ZoÌm| H$m dU© (a§J) Ho$db H$mbm hr hmoJmŸ& 

 H$maU (R) … ZoÌm| H$m H$mbm dU© à^mdr bjU h¡Ÿ& 1 

18.  A{^H$WZ (A) … {~Zm ~wPo MyZo H$s nmZr go A{^{H«$`m D$î_mjonr A{^{H«$`m h¡Ÿ& 

 H$maU (R) … {~Zm ~wPm MyZm nmZr go ~hþV Vrd« A{^{H«$`m H$aHo$ AË`{YH$ _mÌm _| D$î_m 

CËnÞ H$aVm h¡Ÿ& 1 
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14. Two LED bulbs of 12W and 6W are connected in series. If the current 

through 12W bulb is 0.06A the current through 6W bulb will be : 1 

(a) 0.04A (b) 0.06A (c) 0.08A (d) 0.12A 

15. An alpha particle enters a uniform magnetic field as shown. The direction 

of motion of the alpha particle is : 1 

(a) towards right 

(b) towards left 

(c) into the page 

(d) out of the page 

16. The resistance of a resistor is reduced to half of its initial value. If other 

parameters of the electrical circuit remain unaltered, the amount of heat 

produced in the resistor will become : 1 

(a) four times 

(b) two times 

(c) half  

(d) one fourth 

Q. No. 17 to 20 are Assertion – Reasoning based questions. 

These consist of two statements – Assertion (A) and Reason (R). Answer 

these questions selecting the appropriate option given below. 

(a) Both (A) and (R) are true and (R) is the correct explanation of (A). 

(b) Both (A) and (R) are true but (R) is not the correct explanation of (A). 

(c) (A) is true but (R) is false. 

(d) (A) is false but (R) is true. 

17. Assertion (A) : In humans, if gene (B) is responsible for black eyes and 

gene (b) is responsible for brown eyes, then the colour of eyes of the 

progeny having gene combination Bb, bb or BB will be black only.  

 Reason (R) : The black colour of the eyes is a dominant trait. 1 

18. Assertion (A) : Reaction of Quicklime with water is an exothermic 

reaction. 

 Reason (R) : Quicklime reacts vigorously with water releasing a large 

amount of heat. 1 
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19.  A{^H$WZ (A) … O~ {H$gr Ymamdmhr grYo MmbH$ H$mo Mwå~H$s` joÌ _| CgH$s {Xem Ho$ 
bå~dV² aIm OmVm h¡, Vmo dh MmbH$ ~b H$m AZw^d H$aVm h¡Ÿ& 

 H$maU (R) … {H$gr Ymamdmhr MmbH$ na ZoQ> Amdoe eyÝ` hmoVm h¡Ÿ& 1 

20. A{^H$WZ (A) … jwÐm§Ì Ho$ AmÝV[aH$ AmñVa na AZoH$ A§Jwbr O¡go àdY© hmoVo h¢, {OÝh| 

XrK©amo_ H$hVo h¢ Am¡a BZ_| é{Ya H$s ~hþVm`V hmoVr h¡Ÿ& 

 H$maU (R) … BZ XrK©amo_m| H$m n¥ð>r` joÌ\$b A{YH$ hmoVm h¡, Omo ^moOZ Ho$ nyU© nmMZ _| jwÐm§Ì 

H$s ghm`Vm H$aVm h¡Ÿ& 1 

 IÊS > - I 
 (A{V bKw-CÎmar` àíZ) 

21. Cg nmXn hm°_m}Z H$m Zm_ {b{IE Omo {H$gr nmXn Ho$ àamoh H$mo Cg g_` PwH$Zo Ho$ {bE 
CÎmaXm`r hmoVm h¡ O~ Cg na H$moB© EH${X{eH$ àH$me n‹S>Vm h¡Ÿ& `h hm°_m}Z {H$g àH$ma 
àH$memZwdV© H$mo ào[aV H$aVm h¡ ? 2 

22. (A) {H$gr N>mÌ Zo EH$ e§ŠdmH$ma âbmñH$ _| H$m°na Am°ŠgmBS> H$s Hw$N> _mÌm boH$a Cg_| 
{_lU H$mo bJmVma {dbmo{S>V H$aVo hþE VZw hmBS´>moŠbmo[aH$ Aåb {_bm`mŸ& CgZo {db`Z 
Ho$ a§J _| n[adV©Z H$m àojU {H$`mŸ& 2 

(i) ~ZZo dmbo `m¡{JH$ H$m Zm_ Am¡a CgH$m a§J {b{IEŸ& 

(ii) hmoZo dmbr A{^{H«$`m H$m g§Vw{bV amgm`{ZH$ g_rH$aU Xr{OEŸ& 

AWdm 

 (B) H$m°pñQ>H$ gmoS>m Ho$ Am¡Úmo{JH$ {Z_m©U H$s à{H«$`m _| {H$gr `m¡{JH$ ‘X’ Ho$ Obr` {db`Z 
H$m {dÚwV AnKQ>Z {H$`m OmVm h¡Ÿ& Bg à{H«$`m _| Xmo J¡g| ‘Y’ Am¡a ‘Z’ {ZH$bVr h¢Ÿ& 
‘Y’ H¡$WmoS> na {ZH$bVr h¡ Am¡a ‘Z’ Omo {H$ EoZmoS> na {ZH$bVr h¡, ewîH$ ~wPo hþE MyZo go 
A{^{H«$`m H$aHo$ H$moB© `m¡{JH$ ‘B’ ~ZmVr h¡Ÿ& X, Y, Z Am¡a B Ho$ Zm_ {b{IEŸ& 2 

23.  Xmo hao nm¡Ym| H$mo Am°ŠgrOZ a{hV nmÌm| _| ~ÝX H$aHo$ EH$ H$mo gỳ © Ho$ àH$me _| VWm Xygao H$mo 
A§Yoao _| aIm J`m h¡Ÿ& àojU H$aZo na `h nm`m J`m {H$ A§Yoao _| aIm J`m nm¡Ym A{YH$ g_` 
VH$ Or{dV Zht ah gH$mŸ& Bg àojU Ho$ {bE H$maU {b{IEŸ& 2 

24. "D$VH$ Vab' H$m AÝ` Zm_ Š`m h¡ ? BgHo$ Xmo H$m`© {b{IEŸ& 2 
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19. Assertion (A) : A current carrying straight conductor experiences a force 

when placed perpendicular to the direction of magnetic field.  

 Reason (R) : The net charge on a current carrying conductor is always 

zero. 1 

20. Assertion (A) : The inner walls of the small intestine have finger like 

projections called villi which are rich in blood.  

 Reason (R) : These villi have a large surface area to help the small 

intestine in completing the digestion of food. 1 

 SECTION – B 

 (Very Short Answer Questions) 

21. Name a plant hormone responsible for bending of a shoot of a plant when 

it is exposed to unidirectional light. How does it promote phototropism ? 2 

22. (A) A student took a small amount of copper oxide in a conical flask and 

added dilute hydrochloric acid to it with constant stirring. He 

observed a change in colour of the solution. 2 

(i) Write the name of the compound formed and its colour. 

(ii) Write a balanced chemical equation for the reaction involved. 

OR 

 (B) The industrial process used for the manufacture of caustic soda 

involves electrolysis of an aqueous solution of compound ‘X’. In this 

process, two gases ‘Y’ and ‘Z’ are liberated. ‘Y’ is liberated at 

cathode and ‘Z’, which is liberated at anode, on treatment with dry 

slaked lime forms a compound ‘B’. Name X, Y, Z and B. 2 

23. Two green plants are kept separately in oxygen free containers, one in the 

dark and other in sunlight. It was observed that plant kept in dark could not 

survive longer. Give reason for this observation. 2 

24. What is the other name of ‘tissue fluid’ ? Write its two functions. 2 
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25. “`Ú{n ~JrMm| H$m {Z_m©U _Zwî` Ûmam {H$`m OmVm h¡ naÝVw BÝh| nm[aV§Ì _mZm OmVm h¡Ÿ&'' Bg 
H$WZ H$s nw{ï> H$s{OEŸ& 2 

26. (A) ZrMo {XE JE AmaoI H$m àojU H$aHo$ {ZåZ{b{IV àíZm| Ho$ CÎma Xr{OE … 2 

 

 

 

 

 

 

(i) ZoÌ Ho$ Ñ{ï>Xmof H$mo nhMm{ZEŸ& 
(ii) Bg Xmof Ho$ Xmo H$maUm| H$s gyMr ~ZmBEŸ& 
(iii) Bg Ñ{ï>Xmof Ho$ g§emoYZ Ho$ {bE Cn`moJ {H$E OmZo dmbo b|g Ho$ àH$ma H$m Zm_ 

{b{IEŸ& 
AWdm 

 (B) n¥Ïdr go àojU H$aZo na ñdÀN> AmH$me H$m a§J Zrbm Ñ{ï>JmoMa hmoVm h¡ naÝVw A§V[aj _| 
`h H$mbm {XImB© XoVm h¡Ÿ& Š`m| ? 2 

 IÊS > - J 
 (bKw-CÎmar` àíZ) 

27. ZrMo {XE JE bdUm| na {dMma H$s{OE … 

(i) YCl (ii)   NH4X (iii)   ZCO3 

(a) `{X YCl _| Y gmo{S>`_ h¡ Vmo Bg bdU Ho$ {db`Z H$m pH Š`m hmoJm ? AnZo CÎma 
Ho$ {bE H$maU Xr{OEŸ& 

(b) `{X bdU NH4X _| X ZmBQ´>oQ> h¡, Vmo Bg bdU H$m {db`Z gm{d©H$ gyMH$ Ho$ gmW 
Š`m a§J XoJm ? Eogm Š`m| ? 

(c) `{X ZCO3 _| Z nmoQ>¡{e`_ h¡, Vmo Bg bdU H$m {db`Z Zrbo {bQ>_g {db`Z Ho$ a§J _| 
Š`m n[adV©Z H$aoJmŸ? 

28. (i) Ob H$m {dÚwV AnKQ>Z H$aVo g_` {dÚwV Ymam àdm{hV H$aZo go nyd© Ob _| {H$gr Aåb 
H$s Hw$N> ~y§X| {_bm`r OmVr h¢Ÿ& Š`m| ? H¡$WmoS> Am¡a EoZmoS> na _wº$ hmoZo dmbr J¡gm| Ho$ Zm_ 
{b{IEŸ& H¡$WmoS> na g§{MV J¡g Ho$ Am`VZ Am¡a EoZmoS> na g§{MV J¡g Ho$ Am`VZ Ho$ ~rM 
g§~§Y {b{IEŸ& 

 (ii) Cg g_` Amn Š`m àojU H$aVo h¢ O~ {gëda ŠbmoamBS> H$mo gỳ © Ho$ àH$me _| CX^m{gV 
{H$`m OmVm h¡Ÿ? hmoZo dmbr A{^{H«$`m Ho$ àH$ma H$m Zm_ {b{IEŸ& 

3 

3 
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25. “Although gardens are created by man but they are considered to be an 

ecosystem.” Justify this statement. 2 

26. (A) Observe the following diagram and answer the questions following  

it : 2 

 

 

 

 

 

(i) Identify the defect of vision shown. 

(ii) List its two causes. 

(iii) Name the type of lens used for the correction of this defect. 

OR 

 (B) The colour of clear sky from the earth appears blue but from the 

space it appears black. Why ? 2 

 SECTION – C 

 (Short Answer Questions) 

27. Consider the following salts : 

(i) YCl (ii)   NH4X (iii)   ZCO3 

(a) What would be the pH of the salt solution if in YCl, Y is sodium ? 

Give reason for your answer. 

(b) If in salt NH4X, X is nitrate, then its solution will give what colour 

with universal indicator ? Why ? 

(c) What would be the change in colour in blue litmus solution if ZCO3 

is added to it and Z is potassium ? 

28. (i) While electrolysing water before passing the current some drops of 

an acid are added. Why ? Name the gases liberated at cathode and 

anode. Write the relationship between the volume of gas collected at 

anode and the volume of gas collected at cathode. 

 (ii) What is observed when silver chloride is exposed to sunlight ? Give 

the type of reaction involved. 

3 

3 
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29. {H$gr Jmobr` Xn©U go 20 cm H$s Xyar na {H$gr {~å~ H$mo aIZo na CËnÞ AmdY©Z +1/2 h¡Ÿ& 
AmdY©Z H$mo KQ>mH$a +1/3 H$aZo Ho$ {bE {~å~ H$mo H$hm± aIm OmZm Mm{hEŸ? 3 

30. (A) (i) n¡am_r{e`_ AnZm ^moOZ {H$g àH$ma àmá H$aVm h¡ ? 3 

  (ii) h_mao nmMZ V§Ì _| {ZåZ{b{IV _| go àË`oH$ H$s ŷ{_H$m {b{IE …  

(a) hmBS´>moŠbmo[aH$ Aåb 

(b) {Q´>pßgZ 

(c) Am_me` H$s noer` {^{Îm`m± 

(d) bmbm ag (bma) 

AWdm 

 (B) (i) Xmoham n[ag§MaU {H$go H$hVo h¢ ? 3 

  (ii) öX` Ho$ Xm{hZo ^mJ Am¡a ~mE§ ^mJ H$m n¥WŠH$Z Š`m| Cn`moJr h¡ ? `h n{j`m| Am¡a 
ñVZnm{``m| H$s {H$g àH$ma ghm`Vm H$aVm h¡ ? 

31. (A) (i) àË`mdVu Ymam (A.C.) H$mo {Xï> Ymam (D.C.) H$s VwbZm _| {dÚwV e{º$ Ho$ gwXya 
ñWmZm| na àofU Ho$ {bE A{YH$ bm^H$mar Š`m| _mZm OmVm h¡ ? 

  (ii) Kaoby Amny{V© Ho$ {bE Cn`moJ hmoZo dmbr Bg àH$ma H$s Ymam ewîH$ gobm| AWdm 
~¡Q>[a`m| go àmá Ymam go {H$g àH$ma {^Þ hmoVr h¡Ÿ? 

  (iii) {dÚwV â`yO {H$g àH$ma {dÚwV n[anW Am¡a {dÚwV gm{YÌm| H$mo bKwnWZ AWdm 
A{V^maU Ho$ H$maU hmoZo dmbr g§^m{dV j{V go ~MmVm h¡Ÿ?  

AWdm 

 (B) Xem©̀ r J`r Ymamdmhr n[aZm{bH$m Ho$ Mwå~H$s` joÌ H$mo Amao{IV H$s{OE Am¡a H$maU 
g{hV ì`m»`m H$s{OE {H$ VrZ {~ÝXwAm| A, B Am¡a C _| {H$g {~ÝXw na joÌ H$s Vrd«Vm 
A{YH$V_ Am¡a {H$g na {ZåZV_ h¡Ÿ? 3 

 

  

 

32. O¡d {ZåZrH$aUr` Am¡a AO¡d {ZåZrH$aUr` An{eï>m| Ho$ ~rM EH$ AÝVa {b{IEŸ& BZ_| go 
àË`oH$ àH$ma Ho$ An{eï>m| Ho$ g§{MV hmoZo na n`m©daU na hmoZo dmbo Xmo-Xmo A{Yà^mdm| H$s gyMr 
~ZmBEŸ& 3 

3 
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29. The magnification produced when an object is placed at a distance of  

20 cm from a spherical mirror is +1/2. Where should the object be placed 

to reduce the magnification to +1/3. 3 

30. (A) (i) How does Paramecium obtain its food ? 3 

  (ii) List the role of each of the following in our digestive system : 

(a) Hydrochloric acid 

(b) Trypsin 

(c) Muscular walls of stomach 

(d) Salivary amylase 

OR 

 

(B) (i) What is double circulation ? 3 

 (ii) Why is the separation of the right side and the left side of the 

heart useful ? How does it help birds and mammals ?  

31. (A) (i) Why is an alternating current (A.C.) considered to be 
advantageous over direct current (D.C.) for the long distance 
transmission of electric power ? 

  (ii) How is the type of current used in household supply different 
from the one given by a battery of dry cells ? 

  (iii) How does an electric fuse prevent the electric circuit and the 
appliances from a possible damage due to short circuiting or 
overloading. 

OR 

 (B) For the current carrying solenoid as shown, draw magnetic field lines 
and give reason to explain that out of the three points A, B and C, at 
which point the field strength is maximum and at which point it is 
minimum ? 3 

 

32. Write one difference between biodegradable and non-biodegradable 

wastes. List two impacts of each type of the accumulated waste on 

environment if not disposed off properly. 3 

3 
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33. (A) ídoV àH$me Ho$ {djonU H$s n[a^mfm {b{IEŸ& H$m±M Ho$ {àµµÁ_ go JwOaZo na àH$me Ho$ Cg 
dU© (a§J) H$m C„oI H$s{OE Omo (i) g~go A{YH$, (ii) g~go H$_ _w‹S>Vm h¡Ÿ& ídoV àH$me 
Ho$ {djonU H$mo Xem©Zo Ho$ {bE AmaoI It{MEŸ& 3 

AWdm 

 (B) BÝÐYZwf Š`m hmoVm h¡ ? BgHo$ ~ZZo H$mo Xem©Zo Ho$ {bE Zm_m§{H$V AmaoI It{MEŸ& 3 

IÊS > - K 
(XrK©-CÎmar` àíZ) 

34. (i) hmBS´>m _| àojU H$s OmZo dmbr Ab¢{JH$ OZZ H$s Xmo {dYmAm| Ho$ Zm_ {b{IE Am¡a CZH$s 
ì`m»`m H$s{OEŸ&  

 (ii) H$m{`H$ àdY©Z {H$go H$hVo h¢Ÿ? Bg VH$ZrH$ H$mo Cn`moJ {H$E OmZo Ho$ Xmo bm^m| H$s gyMr 
~ZmBEŸ&  

35. (i) {H$gr MmbH$ Ho$ {gam| Ho$ ~rM {d^dmÝVa Am¡a Cggo àdm{hV Ymam nañna {H$g àH$ma 
g§~§{YV h¡ ?  

  Bg g§~§Y H$mo gË`m{nV H$aZo Ho$ {bE {dÚwV n[anW AmaoI It{MEŸ& 

 (ii) A_rQ>a H$m à{VamoY {ZåZ Š`m| hmoZm Mm{hE ? 

 (iii) Xmo à{VamoYH$m| Ho$ loUr Am¡a nmíd© g§̀ moOZm| Ho$ {bE Xmo V - I J«m\$ A Am¡a B AmaoI _| 
Xem©E JE h¢Ÿ& H$maU g{hV C„oI H$s{OE {H$ BZ_| go H$m¡Zgm J«m\$ à{VamoYH$m| Ho$ (a) 
loUr, (b) nmíd© g§̀ moOZ H$mo Xem©Vm h¡Ÿ& 

 

 

 

 

 

 

5 

5 
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33. (A) Define the term dispersion of white light. State the colour which 

bends (i) the most, (ii) the least while passing through a glass prism. 

Draw a diagram to show the dispersion of white light. 3 

OR 

 (B) What is a rainbow ? Draw a labelled diagram to show its formation. 3 

 SECTION – D 
 (Long Answer Questions) 

34. (i) Name and explain the two modes of asexual reproduction observed in 

hydra. 

 (ii) What is vegetative propagation ? List two advantages of using this 

technique. 

35. (i) How is electric current related to the potential difference across the 

terminals of a conductor ? 

  Draw a labelled circuit diagram to verify this relationship. 

 (ii) Why should an ammeter have low resistance ? 

 (iii) Two V - I graphs A and B for series and parallel combinations of two 

resistors are as shown. Giving reason state which graph shows  

(a) series, (b) parallel combination of the resistors. 

 

 

 

 

 

 

5 

5 
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36. (A) {ZåZ{b{IV Ho$ {bE g§Vw{bV amgm`{ZH$ g_rH$aU {b{IE … 

(i) _oW¡Z H$m XhZ (ii) EWZm°b H$m CnM`Z 

(iii) EWrZ H$m hmBS´>moOZrH$aU (iv) EñQ>arH$aU A{^{H«$`m 

(v) gm~wZrH$aU A{^{H«$`m 

AWdm 

(B) (i) ã`yQ>oZ Ho$ Xmo g§aMZmË_H$ g_md`d It{MEŸ& 

(ii) àmon¡Zm°b Am¡a àmon¡ZmoZ H$s g§aMZm It{MEŸ& 

(iii) {ZåZ{b{IV Ho$ Vrgao g_OmV H$m Zm_ {b{IE … 

(a) EoëH$mohm°b (b) EopëS>hmBS> 

(iv) {ZåZ{b{IV H$m Zm_ {b{IE … 

 

 

 

(a)  

 

 

(b) CH3−CH2CH = CH2 

(v) ZmBQ´>moOZ-AUw _| ghg§̀ moOr Am~§Y ~ZZm Xem©BEŸ& 

 IÊS > - ‹S > 
 (òmoV Am Ym[aV/àH$aU AmYm[aV àíZ) 

37. OZZ à{H«$`m H$m gdm©{YH$ àË`j {ZîH$f© g§V{V _| ì`{ï>`m| H$m g_ê$n {S>OmBZ hmoZm h¡, naÝVw 
b¢{JH$ OZZ _| do VÏ`V… g_ê$n Zht hmoVo h¢Ÿ& BZ_| g_ê$nVmE§ Am¡a {d{^ÞVmE§ gwñnï> hmoVr h¢Ÿ& 
d§emJ{V Ho$ {Z`_ Cg à{H«$`m H$mo {ZYm©[aV H$aVo h¢ {OgHo$ Ûmam bjU Am¡a {deofVmE§ 
{dídgZr`Vm go d§emZwJV hmoVr h¢Ÿ& d§emJ{V Ho$ {Z`_m| Ho$ AÜ``Z Ho$ {bE H$B© à`moJ {H$E JE 
h¢Ÿ& 

(i) b¢{JH$ OZZ _| _mZdm| H$s g§V{V AnZo OZH$m| H$s `WmVÏ` à{VH¥${V Š`m| Zht hmoVr h¡ ? 1 

5 

5 

4 
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36. (A) Write the chemical equation for the following : 5 

(i) Combustion of methane (ii) Oxidation of ethanol 

(iii) Hydrogenation of ethene (iv) Esterification Reaction 

(v) Saponification Reaction 

OR 

(B) (i) Draw two structural isomers of butane. 5 

(ii) Draw the structures of propanol and propanone. 

(iii) Name the third homologue of : 

(a) alcohols (b) aldehydes 

(iv) Name the following : 

 

 

 

(a)  

 

 

 

(b) CH3−CH2CH = CH2 

(v) Show the covalent bond formation in nitrogen molecule. 

 SECTION – E 

 (Source Based/Case Based Questions) 

37. The most obvious outcome of the reproductive process is the generation of 

individuals of similar design, but in sexual reproduction they may not be 

exactly alike. The resemblances as well as differences are marked. The 

rules of heredity determine the process by which traits and characteristics 

are reliably inherited. Many experiments have been done to study the rules 

of inheritance. 

(i) Why an offspring of human being is not a true copy of his parents in 

sexual reproduction ? 1 

4 
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(ii) nm¡Ym| _| d§emJ{V Ho$ à`moJm| H$mo H$aVo g_` F1 Am¡a F2 g§V{V Ho$ nm¡Ym| _| Š`m AÝVa 
nm`m OmVm h¡ ? 1 

(iii) (A) h_ `h Š`m| H$hVo h¢ {H$ {H$gr ñnrerµO Ho$ ApñVËd H$s d¥{Õ Ho$ {bE {d{^ÞVm 
Amdí`H$ h¡ ? 2 

AWdm 

(iii) (B) _|S>b Ho$ Xmo {dn`m©gr bjUm| dmbo Omo‹S>m| Ho$ nm¡Ym| Ho$ ~rM g§H$aU H$m AÜ``Z 
H$s{OEŸ&  2 

   RRYY × rryy 

   Jmob nrbo  PwauXma hao 

 CÝhmo§Zo F2 g§V{V Ho$ nm¡Ym| _| Mma àH$ma Ho$ g§̀ moOZm| H$m àojU {H$`mŸ& `o Mma Z`o g§̀ moOZ 
Š`m Wo ? F2 g§V{V _| dh ZE g§̀ moOZ, Omo OZH$ nm¡Ym| _| CnpñWV Zht Wo, Š`m| 
Ñ{ï>JmoMa hþEŸ? 

38. {H$gr _mÜ`_ H$s àH$me H$mo And{V©V H$aZo H$s j_Vm H$mo CgHo$ àH$m{eH$ KZËd Ho$ nXm| _| 
ì`º$ {H$`m OmVm h¡Ÿ& àH$m{eH$ KZËd H$m EH$ {ZpíMV g§n¥º$mW© h¡Ÿ& `h Ðì`_mZ KZËd Ho$ 
g_mZ Zht h¡Ÿ& Xmo _mÜ`_m| H$s VwbZm H$aZo na {Og nXmW© H$m AndV©Zm§H$ A{YH$ hmoVm h¡ dh 
Xygao nXmW© H$s VwbZm _| A{YH$ àH$m{eH$ gKZ _mÜ`_ H$hm OmVm h¡Ÿ& AÝ` _mÜ`_ {OgH$m 
AndV©Zm§H$ {ZåZ h¡, àH$m{eH$ {dab hmoVm h¡Ÿ& {H$gr {XE JE _mÜ`_ _| àH$me H$s Mmb CgHo$ 
àH$m{eH$ KZËd Ho$ ì`wËH«$_mZwnmVr hmoVr h¡Ÿ& 

(i) `{X hrao H$m {Zdm©V Ho$ gmnoj AndV©Zm§H$ 2.42 h¡, Vmo hrao _| àH$me H$s Mmb {ZYm©[aV 
H$s{OEŸ& {Zdm©V _| àH$me H$s Mmb 3×108 m/s h¡Ÿ& 1 

(ii) H$m±M, Ob Am¡a H$m~©Z S>mBgë\$mBS> Ho$ AndV©Zm§H$ H«$_e… 1.5, 1.33 Am¡a 1.62 h¢Ÿ& 

`{X H$moB© àH$me {H$aU BZ _mÜ`_m| na g_mZ H$moU (_mZ br{OE θ) na AmnVZ H$aVr 
h¡, Vmo BZ _mÜ`_m| _| AndV©Z H$moUm| H$mo Amamohr (~‹T>Vo) H«$_ _| {b{IEŸ& 1 

(iii) (A) H$m±M _| àH$me H$s Mmb 2×108 m/s Am¡a Ob _| àH$me H$s Mmb  
2.25×10

8
 m/s h¡Ÿ& 2 

4 



 

31/4/3  [P.T.O. 21

(ii) While performing experiments on inheritance in plants, what is 

the difference between F1 and F2 generation ? 1 

(iii) (A) Why do we say that variations are useful for the survival of 

a species over time ? 2 

OR 

(iii) (B) Study Mendel’s cross between two plants with a pair of 

contrasting characters. 2 

  RRYY × rryy 

  Round Yellow  Wrinkled Green 

 He observed 4 types of combinations in F2 generation. 

Which of these were new combinations ? Why do new 

features which are not present in the parents, appear in F2 

generation ? 

38. The ability of a medium to refract light is expressed in terms of its optical 

density. Optical density has a definite connotation. It is not the same as 

mass density. On comparing two media, the one with the large refractive 

index is optically denser medium than the other. The other medium with a 

lower refractive index is optically rarer. Also the speed of light through a 

given medium is inversely proportional to its optical density. 

(i) Determine the speed of light in diamond if the refractive index of 

diamond with respect to vacuum is 2.42. Speed of light in vacuum is 

3×10
8
 m/s. 1 

(ii) Refractive indices of glass, water and carbon disulphide are 1.5, 1.33 

and 1.62 respectively. If a ray of light is incident in these media at the 

same angle (say θ), then write the increasing order of the angle of 

refraction in these media. 1 

(iii) (A) The speed of light in glass is 2×10
8
 m/s and in water is  

2.25×10
8
 m/s. 2 

  

4 



  

31/4/3  22

(a) BZ_| go H$m¡Z A{YH$ àH$m{eH$ gKZ h¡ Am¡a Š`m| ? 

(b) {H$gr Ob go ^ao _moQ>o H$m±M Ho$ nmÌ Ho$ H$m±M-Ob AÝVamn¥ð> na H$moB© àH$me 
{H$aU A{^bå~dV² AmnVZ H$aVr h¡Ÿ& Bg {H$aU Ho$ H$m±M _| àdoe H$aZo Ho$ 
níMmV² nW H$m Š`m hmoJm ? H$maU Xr{OEŸ& 

AWdm 

(iii) (B) Ob Am¡a H$m±M Ho$ {Zanoj AndV©Zm§H$ H«$_e… 4/3 Am¡a 3/2 h¢Ÿ& `{X H$m±M _| 
àH$me H$s Mmb 2×108 m/s h¡, Vmo (i) {Zdm©V Am¡a (ii) Ob _| àH$me H$s Mmb 
kmV H$s{OEŸ& 2 

39. Hw$N> Am`Zr `m¡{JH$m| Ho$ JbZm§H$ Am¡a ŠdWZm§H$ ZrMo {XE JE h¢ … 4 

`m¡{JH$ JbZm§H$ (K) ŠdWZm§H$ (K) 

NaCl 

LiCl 

CaCl2 

CaO 

MgCl2 

1074 

887 

1045 

2850 

981 

1686 

1600 

1900 

3120 

1685 

 BZ `m¡{JH$m| H$mo Am`{ZH$ `m¡{JH$ H$hZo H$m H$maU `h h¡ {H$ `o YmVw go AYmVw _| BboŠQ´>m°Zm| Ho$ 
ñWmZmÝVaU Ûmam ~ZVo h¢Ÿ& Bg àH$ma Ho$ `m¡{JH$m| _| BboŠQ´>m°Zm| Ho$ ñWmZmÝVaU H$mo, BZ `m¡{JH$m| Ho$ 
~ZZo _| ^mJ boZo dmbo VÎdm| Ho$ BboŠQ´>m°Z-{dÝ`mg {Z`§{ÌV H$aVo h¢Ÿ& àË`oH$ VÎd H$s AnZr 
{ZH$Q>V_ CËH¥$ï> J¡g Ho$ nyU© ê$n go ^ao g§̀ moOH$Vm H$moe AWdm ñWm`r Aï>H$ H$mo àmá H$aZo H$s 
àd¥{Îm hmoVr h¡Ÿ& 

(i) _¡¾r{e`_ ŠbmoamBS> Ho$ ~ZZo _| hmoZo dmbo BboŠQ´>m°Z-ñWmZmÝVaU H$mo Xem©BEŸ& 1 

(ii) Cƒ JbZm§H$ Am¡a Cƒ ŠdWZm§H$ Ho$ A{V[aº$ Am`Zr `m¡{JH$m| Ho$ {H$Ýht AÝ` Xmo JwUY_m] 
H$s gyMr ~ZmBEŸ& 1 

(iii) (A) {H$gr Am`Zr `m¡{JH$ O¡go gmo{S>`_ ŠbmoamBS> _| gmo{S>`_ na_mUw {H$g àH$ma ñWm`r 
{dÝ`mg àmá H$aVm h¡Ÿ? 2 

AWdm 

 (iii) (B) H$maU Xr{OE … 2 

(i) Am`Zr `m¡{JH$ R>mog AdñWm _| {dÚwV MmbZ Š`m| Zht H$aVo h¢ ? 

(ii) gmo{S>`_ ŠbmoamBS> Ho$ Obr` {db`Z _| Ymam àdm{hV H$aZo na H¡$WmoS> na 
Š`m $hmoVm h¡Ÿ? 
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(a) Which one of the two is optically denser and why ? 

(b) A ray of light is incident normally at the water-glass 

interface when it enters a thick glass container filled 

with water. What will happen to the path of the ray 

after entering the glass ? Give reason. 

OR 

(iii) (B) The absolute refractive indices of water and glass are 4/3 and 

3/2 respectively. If the speed of light in glass is 2×10
8
 m/s, find 

the speed of light in (i) vacuum and (ii) water.  2  

39. The melting points and boiling points of some ionic compounds are given 

below : 4 

Compound Melting Point (K) Boiling Point (K) 

NaCl 

LiCl 

CaCl2 

CaO 

MgCl2 

1074 

887 

1045 

2850 

981 

1686 

1600 

1900 

3120 

1685 

 These compounds are termed ionic because they are formed by the transfer 

of electrons from a metal to a non-metal. The electron transfer in such 

compounds is controlled by the electronic configuration of the elements 

involved. Every element tends to attain a completely filled valence shell of 

its nearest noble gas or a stable octet.  

(i) Show the electron transfer in the formation of magnesium chloride. 1 

(ii) List two properties of ionic compounds other than their high 

melting and boiling points. 1 

(iii) (A) While forming an ionic compound say sodium chloride how 

does sodium atom attain its stable configuration ? 2 

OR 

(iii) (B) Give reasons : 2 

(i) Why do ionic compounds in the solid state not conduct 

electricity ? 

(ii) What happens at the cathode when electricity is passed 

through an aqueous solution of sodium chloride ? 
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1. On an outline map of India list the areas placed below and label them 

a. Congress session 

i. 1920 Calcutta 

ii. 1920 Nagpur 

iii. 1927 Madras 

b. Satyagraha Movement 

i. Kheda 

ii. Champaran 

iii. Ahmedabad 

c. Jallianwala Bagh 

d. Dandi 

2. Case-Based Study: Multinational Corporations(MNCs) and Globalisation 

With the acceleration of globalisation after the 1991 economic reforms, Multinational 

Corporations (MNCs) emerged as key drivers of India’s integration into the global 

economy. MNCs are companies that own or control production in more than one 

country and operate through networks of subsidiaries, suppliers, and contractors. In 

India, MNCs entered sectors such as automobiles, electronics, food processing, retail, 

pharmaceuticals, and information technology. 

 

One major reason for the expansion of MNCs in India was the availability of cheap 

labour, a large consumer market, and supportive government policies. To attract 

foreign investment, the Indian government reduced import tariffs, relaxed foreign 

investment norms, and created Special Economic Zones (SEZs). As a result, MNCs 

established production units or partnered with Indian firms through joint ventures. In 

many cases, instead of setting up factories directly, MNCs outsourced production to 

local companies, allowing them to reduce costs while maintaining global quality 

standards. 

 

This integration with MNCs transformed patterns of production. Indian companies that 

collaborated with MNCs gained access to modern technology, managerial skills, and 

international markets. Some domestic firms became globally competitive, exporting 

goods and services worldwide. Consumers benefited from better-quality products and 

a wider choice at lower prices. 

 

However, the presence of MNCs also exposed structural weaknesses in the Indian 

economy. Small producers and traditional industries often failed to meet the quality 

and cost requirements imposed by global corporations. Many were excluded from 



global supply chains, leading to closures and job losses. Workers employed by MNC 

suppliers frequently faced long working hours, low wages, and insecure employment, 

as firms tried to remain competitive in the global market. 

 

MNCs also exerted significant influence over economic decision-making. State 

governments competed with each other to attract investment by offering tax 

concessions, cheap land, and relaxed labour and environmental regulations. Critics 

argue that this “race to the bottom” weakened labour protection and environmental 

safeguards, limiting the government’s ability to regulate corporate activities in the 

public interest. 

 

Thus, while MNCs have played a crucial role in promoting globalisation and economic 

growth, their impact on employment, inequality, and state sovereignty remains deeply 

contested. The Indian experience demonstrates that globalisation driven by MNCs 

produces both opportunities and challenges that require careful regulation and policy 

intervention. 

i. Explain the role of Multinational Corporations in promoting globalisation in 

India. Analyse how their methods of investment and production link the Indian 

economy to global markets.     5 marks 

ii. Assess the impact of Multinational Corporations on small producers and 

workers in India. Why have these groups benefited less from globalisation? 

Support your answer using the case study.   5 marks 

iii. “Multinational Corporations influence not only markets but also government 

policies in developing countries.” 

Critically examine this statement in the context of India’s experience with 

globalisation.       5 marks 

 

3. Case-Based Study: Print Culture and the Making of Modern Society 

The invention of the printing press and the gradual spread of print culture marked a 

turning point in human history. Before the age of print, books were expensive, 

handwritten, and accessible only to a privileged few such as the clergy and the nobility. 

Knowledge circulated slowly, and control over information remained concentrated in 

the hands of elites. The development of printing technology in Europe during the 

fifteenth century transformed this situation by enabling the mass production of texts at 

relatively low cost. 

 

As printed books became cheaper and more widely available, literacy expanded and 

new groups of readers emerged. Merchants, artisans, peasants, and women increasingly 

gained access to printed material. This expansion of readership changed the nature of 

knowledge itself. Print created the possibility of standardized texts, wider debates, and 

the circulation of new ideas beyond local boundaries. The Protestant Reformation is a 

striking example of how print culture challenged existing authority. Reformers like 



Martin Luther used pamphlets and translated religious texts to question the dominance 

of the Catholic Church, allowing ordinary people to interpret religious ideas 

independently. 

 

Over time, print culture became closely linked with the rise of modern political 

consciousness. Newspapers, journals, and pamphlets helped shape public opinion and 

encouraged discussion on social and political issues. In many parts of the world, print 

became a powerful tool for spreading nationalist ideas. In colonial societies such as 

India, print played a dual role. On the one hand, colonial authorities used printed laws, 

reports, and textbooks to consolidate administrative control. On the other hand, Indian 

reformers and nationalists used print to critique colonial rule and mobilise resistance. 

 

Vernacular newspapers, novels, and essays made political ideas accessible to a wider 

audience, including those unfamiliar with English. Print also contributed to social 

reform movements by questioning practices such as caste discrimination, superstition, 

and gender inequality. At the same time, the spread of print created anxiety among 

rulers. Colonial governments introduced censorship laws, press regulations, and 

surveillance mechanisms to control what was printed and circulated. 

 

However, print culture was not free from limitations. Not all social groups benefited 

equally. Illiteracy, poverty, and language barriers restricted access for many. Moreover, 

print could also spread rumours, communal ideas, and misinformation, sometimes 

intensifying social divisions. Thus, while print culture played a crucial role in shaping 

modern societies, its impact was complex, contested, and deeply connected to power 

relations. 

 

i. Analyse how the expansion of print culture transformed the relationship 

between knowledge and power. In your answer, examine both its emancipatory 

role and its limitations.      5 marks 

ii. Evaluate the role of print culture in the growth of nationalism in colonial 

societies like India. Why did colonial governments view the printed word as a 

threat?        5 marks 

iii. “Print culture did not merely reflect social change; it actively shaped and 

directed it.” 

Critically examine this statement with reference to political, religious, and 

social developments.      5 marks 

 

4. Case-Based Study: Democracy, Power Sharing and Political Accountability 

Modern democracies are built on the principle that political power should not be 

concentrated in the hands of a single individual or group. Instead, power must be 

distributed among different institutions, levels of government, and social groups to 



prevent the misuse of authority. This idea of power sharing is central to democratic 

governance and is closely linked to political stability and social harmony. 

 

In many democratic countries, constitutional arrangements divide power horizontally 

among the legislature, executive, and judiciary. Each institution exercises distinct 

powers while also placing checks on the others. This ensures that no single institution 

becomes all-powerful. At the same time, power is shared vertically between different 

levels of government—national, state, and local—allowing citizens to participate in 

decision-making closer to their everyday lives. 

 

However, power sharing is not merely an administrative arrangement; it also has a 

social dimension. In societies marked by cultural, linguistic, or religious diversity, 

democracy faces the challenge of accommodating differences while maintaining unity. 

When political power is monopolised by a majority community, minority groups often 

feel excluded from decision-making processes. Such exclusion can lead to political 

instability, protests, and even violent conflict. 

 

India’s democratic experience illustrates both the possibilities and challenges of power 

sharing. The Indian Constitution provides for federalism, independent institutions, and 

universal adult franchise, ensuring representation across regions and social groups. 

Policies such as reservations in legislatures and local bodies aim to include historically 

marginalised communities in political processes. At the grassroots level, local self-

government institutions like Panchayati Raj have increased political participation, 

particularly among women and disadvantaged groups. 

 

Despite these constitutional safeguards, democratic practice often falls short of 

democratic ideals. Political power tends to concentrate in the hands of a few leaders or 

parties, reducing internal party democracy. Decision-making sometimes occurs without 

adequate public consultation, weakening accountability. In certain cases, democratic 

institutions are used to legitimise majoritarian policies that overlook minority rights, 

raising concerns about the quality of democracy. 

 

Thus, democracy is not defined only by the presence of elections, but by how power is 

exercised, shared, and controlled. The effectiveness of democratic institutions depends 

on citizens’ awareness, active participation, and the willingness of political actors to 

respect constitutional values. Power sharing, therefore, is not merely a technical 

arrangement but a continuous democratic process aimed at balancing authority with 

accountability. 

 

i. Examine how power sharing acts as both a moral principle and a practical 

necessity in a democracy. Use examples from the case study to support your 

answer.        5 marks 



ii. Analyse the role of constitutional institutions in preventing the concentration of 

political power. Why is institutional balance essential for democratic 

accountability?       5 marks 

iii. “Elections alone do not guarantee democracy.” 

Critically evaluate this statement in the context of power sharing, minority 

rights, and citizen participation.     5 marks 
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Solve the following sample question paper. 
CLASS – X 

SUBJECT -MATHEMATICS  
 

 

S.No QUESTION 

SECTION A [1X20 =20] 

1 Which are the zeroes of p(x) = 6x2 – 7x – 3 

(a) 5, –2 (b) –5, 2 (c) –5, –2 (d) none of these 

2 The ratio in which the X-axis divides the line segment joining A(3, 6) and B (12, -3) is: 

(a) 2:1 (b)1:2 (c) -2:1 (d) 1: -2 

3 The nth term of an A.P. 5, 2, -1, -4, -7 ... is 

(a) 2n + 5 (b) 2n - 5 (c) 8 - 3n (d) 3n – 8 



 

 

4 The total surface area of a solid hemisphere of radius 7 cm mounted on a hollow  cylinder of 

same radius and height 3cm is : 

(a) 447π cm2 (b) 239π cm2 (c) 175π cm2 (d) 140π cm2 

5 If one zero of the quadratic equation 𝑥² + 3𝑥 + 𝑘 is 2, then the value of 𝑘 is 

(a) 10 (b) -10 (c) 5 (d) -5 

6 The difference of median and mode of a data is 24, then find the difference of mean and 

median is 

a.8 b. 12 c. 24 d 36 

7  MARK 15-20 20-25 25-30 30-35 35-40 40-45  

NO.OF 

STUDENTS 

3 8 9 10 3 6 

Find the upper limit of the modal class 

a.  10 b. 30 c. 9 d.35 

8 A point Q which is 13 cm away from the centre of a circle , the length of tangent PQ to the 

circle is 12 cm. The radius of the circle (in cm ) is 

a)25 (b) √313 (c)5 (d)1 

9 Find the value of k for which the lines −2𝑥 + 5𝑦 = 15 and −10𝑥 − 𝑘𝑦 = 75 have infinite 

number of solutions. 

(a). 5 (b) -5 (c) 25 (d) -25 

10 The distance between the points (a, b) and (-a, -b) is:   

(a). 2a (b) 2√(𝑎2 + 𝑏2) (c) 2b (d) 2√(𝑎2 − 𝑏2) 

11 A sphere and a cube have equal surface areas. The ratio of the volume of the sphere to 

that of cube is 
        

(a) √𝜋 ∶ √6 b) √6 ∶ √𝜋 (c) √𝜋 ∶ √3 (d) √3 ∶ √𝜋 

12 Find the value of Cos 60° sin 30° + Sin 60°cos 30° 

(a) -1 (b) 1 (c) 2 (d) 3 

13 A card is randomly selected from a pack of 52 cards. What is the probability of getting 

neither a red king nor a black king 

a) 12/13 b) 7/13  c) 12/26 d) none of these 

14 (sec A + tan A) (1 –sin A ) = 

(a) sec A (b) sin A          (c) cosec A   (d) cos A 

15 If P(E) = 0.23, what is the probability of ‘not E’? 



 

 

 
 

a) 0.77 b) 0.023 c) 23 d) 0.0023 

16 If radii of two concentric circles are 4 cm and 5 cm ,then find the length of chord of larger 

circle which is tangent to the other circle. 

(a)8                  (b) 3 (c) 6           (d) None of These 

17 In the given figure, if PR is tangent to the circle at P and O is the centre of the circle and 

∠QPR =60°, then ∠POQ = 
 

 

 

(a) 110° (b) 100° (c) 120° (d) 90° 

18 If α, β are the zeroes of the polynomial x² – 16, then αβ (α +β) 

(a) -4 (b) -16 (c) 0 (d) 16 

19 Statement A (Assertion): Area swept by minute hand of a clock of length 7 cm in 15 

minutes is 38.5 sq.cm . (𝜋 = 22) 
7 

Statement R (Reason) : The angle formed by minute hand of the clock in 15 minute is 90 

degree. Area of sector = sector angle /360°  x 𝜋 ( radius)² 

Which of the following is correct ? 

(a) Both assertion (A) and reason (R) are true and reason (R) is the correct explanation of 

assertion (A) 

(b) Both assertion (A) and reason (R) are true and reason (R) is not correct explanation 

of assertion (A) 

(c) Assertion (A) is true but reason (R) is false. 

(d)Assertion (A) is false but rason (R) is true. 

20 Statement A (Assertion):- T h e L C M o f 5 6 a n d 2 9 4 is four times the larger number. 

Statement R (Reason) : The ratio of product of two numbers to  its HCF is equal to the 

ratio of their LCM to HCF 

Which of the following is correct ? 

 
(a) Both assertion (A) and reason (R) are true and reason (R) is the correct explanation of 
assertion (A) 



 

 

 (b) Both assertion (A) and reason (R) are true and reason (R) is not correct explanation 

of assertion (A) 

(c) Assertion (A) is true but reason (R) is false. 

(d)Assertion (A) is false but reason (R) is 

true. 

SECTION B [2 X 5 =10]  

21. In what ratio does the point P (-4,y) divide the line segment joining the points A (-6,10) 

and B (3,-8) if it lies on AB ? Hence find the value of y. 

OR 

Find the ratio in which the y -axis divides the line segment joining the points (-1, - 4) 

and (5, - 6). Also find the coordinates of the point of intersection. 

 

22 If A(0,1) is equidistant from B(5,-3) and C(x,6) find value of x  

23 Evaluate 2 tan2 450 + 2 cos2 45 0 – 2 sin2 450 + cot2 450 

OR 

If cos A = 2/5, find the value of 4 + 4 tan2 A 

 

24 Find the smallest number divisible by 60, 84 leaves remainder 2 in each case.  

25 A card is drawn from a well shuffled pack of 52 cards. Find probability of getting 

i. A red picture card 

ii. A Queen or an Ace. 

 

 SECTION C [3 X 6 =18]  

26 Prove that: (sin A + cosec A)2 + (cos A + sec A)2 = 7 + tan2 A + cot2 A 

OR 

Prove that SecA (1-SinA) (SecA+ Tan A) =1 

 

27 In the figure LM ∥ CB and LN ∥ CD then prove that 

𝐴𝑀 𝐵𝑀 
= 

𝐴𝑁 𝐷𝑁 

 
OR 

 

 



 

 In the figure DE ∥ AC and DF ∥ AE , Prove that 

BE2 = BF.BC 

28 Prove that √5 is an irrational number. 

29 In a circle of radius 21cm, an arc subtends an angle of 60° at the centre. Find 

i) The length of the arc 

ii) Area of the sector formed by the arc.(use 𝜋 = 22 ) 
7 

30. Divide 27 into two parts such that the sum of their reciprocals is 3 . 
20 

OR 
A two digit number is such that product of its digits is18 and if 63 is subtracted from it the digits 
got interchanged. Find the number. 

31 If one zero of the polynomial (a2 + 9) x2 + 13x + 6a is reciprocal of the other .Find the value 

of a. 

OR 

Find a quadratic polynomial whose zeroes are three times the zeroes of P(x) = 2x2+7x+6 

SECTION D [5 X 4 = 20] 

32 If the median of the distribution table given below is 28.5, find the values of x and y. 

 Class interval 0-10 10-20 20-30 30-40 40-50 50-60 Total  

frequency 5 x 20 15 y 5 60 

33 (a) Prove that the tangents drawn from an external point to a circle are equal in length.   

(b)If a quadrilateral PQRS circumscribes a circle then prove that PQ +RS = PS + QR 

OR 

▲ PQR is drawn to circumscribe a circle of radius 4 cm such that the segments QD and 

RD of QR are of lengths 8 cm and 6 cm respectively. Find PQ and PR. 

 

 
 



 

 

34 Places A and B are 100 km apart on a highway. One car starts from A and another from B at the 

same time. If the cars travel in the same direction at different speeds, they meet in 5 hours. If they 

travel towards each other, they meet in 1 hour. What are the speeds of the two cars? 

OR 

 
Solve the linear equations 2x+y = 6 and 2x-y+2 =0 Graphically. Also find the area of the triangular 

region bounded by these lines with Y axis. 

35 The angle of elevation of the top of a tower from a point A on the ground is 300. On moving a 

distance of 20 meters towards the foot of the tower to a point B, the angle of elevation 

increases to 600.Find the height of the tower and the distance of the tower from the point 

A.(√3=1.732) 

SECTION E (CASE BASED) [4 X 3= 12] 

36 
For a camp of NCC different tents are to be made at the Camp 

site.A tent is in the shape of cylinder surmounted by a conical 

top of same diameter as shown in the figure. If the height and 

diameter of cylindrical part of the tent are 2.1 m and 4.4 m 

respectively and the slant height of its conical part must be 2.8 

m to accommodate 5 cadets . 

(i) Find the vertical height of the conical part of tent. 

(ii) Find the volume  of air inside the tent. 

 
(iii) Find the cost of canvas needed to make one such tent as the previous tents are outdated 

and torn. Canvas is available at the rate of Rs.500 per square meter 

.  Or 

Find the weight of the tent if 1 sq. m of Canvas weigh 2 kg without any rope and 
essentials. 

37 For supplying water to each house of a village pipes are brought to be laid to each house. For this 

purpose, 200 such long pipes are purchased and stacked in the following manner, 20 pipes in the 

bottom row, 19 in the next row, 18 in the next to it and so on. 

 

 

(i) In how many rows are the 200 pipes placed? 

(ii) How many pipes are there in the topmost row? 



 

 

 Or 

Find the number of pipes lying between the top and bottom row 

(iii)If one such stack of 105 pipes is arranged in 6 rows,  find the number of pipes at the bottom. 

38 SAM is a student of class X. A mobile tower is fixed near his house. He wants to find the height of 

the tower using the concept of similarity for triangles that he learnt. The height of a tree near 

SAM’S house is 40 metre when it casts a shadow of 8-metre-long on the ground. But SAM’s 

house casts a shadow of 15- metre-long on the same ground. 

 

  

Answer the following questions 
based on the information given above 

a. . At the same time the tower casts a shadow of 30-metre-long on the ground then find height 

of the tower? 

b. Find the difference between the height of the tower and  SAM’s house when the difference 

of their shadows is 1.2 meter. 

OR, 

Two more buildings along the road standing parallel to each other and their heights are in a ratio 

of 3:1 and the smaller house casts a shadow of 2 m . Find the length of shadow cast by the 

larger house. 

 

c. Find the difference between the 

height of man and his shadow if the 

lamp post of 14 m casts a shadow of 

70cm 

 
………………………………………….. END……………………………………………… 



Vacation Homework  

Class X Maths  

Prepare neat and clean concept maps for the following chapter:   

1. Quadratic Equation  

2. Arithmetic Progressions  

3. Triangles   

4. Co-ordinate Geometry   

5. Introduction to Trigonometry 

6. Surface area and volumes  

7. Statistics  

Sample concept maps are given below for your reference.  
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निर्धारित समय: 3 घंटे अधिकतम अंक: 80


सामान्य निर्देश:

इस प्रश्नपत्र में चार खंड हैं - क, ख, ग और घ

खंड क में अपठित गदयांश से प्रश्न पूछे गए हैं, जिनके  उत्तर दिए गए निर्देशों का पालन करते हुए दीजिए।

खंड ख में व्यावहारिक व्याकरण से प्रश्न पूछे गए हैं, आंतरिक विकल्प भी दिए गए हैं।

खंड ग पाठ्यपुस्तक पर आधारित है, निर्देशानुसार उत्तर दीजिए।

खंड घ रचनात्मक लेखन पर आधारित है आंतरिक विकल्प भी दिए गए हैं।

प्रश्न पत्र में कु ल 16 प्रश्न हैं, सभी प्रश्न अनिवार्य है।

यथासंभव सभी खंडों के  प्रश्नों के  उत्तर क्रमशः लिखिए।

खंड क - अपठित बोध

1. निम्नलिखित गद्यांश को ध्यानपूर्वक पढ़कर पूछे गए प्रश्नों के  उत्तर दीजिए।

चीन के  महान दार्शनिक संत ताओ बू बीन के  पास चुंगसिन नामक एक व्यक्ति पहुँचा, उसने उनसे धर्म की शिक्षा देने की प्रार्थना की,

संत ताओ बू ने उस व्यक्ति को कु छ समय तक अपने पास रखा और उसे दीन-दुखियों की सेवा में लगा दिया, कु छ समय बाद चुंगसिन

ने संतजी से निवेदन किया, "महाराज इतने दिन हो गए, आपने मुझे धर्म की शिक्षा नहीं दी, संत ने कहा, "तेरा तो जीवन ही धर्ममय हो

गया है, फिर मैं धर्म के  विषय में तुझे क्या बताता? तू अपने कर्तव्यों का पालन निष्ठापूर्वक करता है, तुझसे बड़ा धार्मिक कौन होगा?"


चुंगसिन समझ गया, आप भी समझ गए होंगे कि कर्तव्य का पालन ही जीवन में सर्वोपरि है, चाहें तो हम उसे मानव का परम धर्म कह

सकते हैं।


हमारे युवा पाठकों में प्रायः प्रत्येक किसी-न-किसी परीक्षा के  लिए तैयारी का संकल्प करते है। क्या आप में प्रत्येक को विश्वास है कि वह

पूरी निष्ठा के  साथ परीक्षा या प्रतियोगिता के  संदर्भ में अपने कर्तव्य का पालन कर रहा/रही है? परीक्षा की तैयारी के  अतिरिक्त आपके

लिए अन्य कोई कार्यक्रम महत्त्व नहीं रखता है, कु छ ऐसे छात्र-छात्राएं  देखने में आते हैं जो घर से पढ़ने के  लिए कॉलेज आते हैं परन्तु वे

कक्षाओं में न जाकर मटरगश्ती करते हैं, अथवा कै ण्टीन में बैठकर दोस्तों के  साथ बातें करते हैं। तब क्या वे अपने कर्तव्य की अवहेलना,

एवं माता-पिता के  साथ विश्वासघात नहीं करते हैं? हम चाहते हैं कि हमारे युवा पाठक शांत चित्त से विचार करके  देखें कि वे उक्त श्रेणी

के  अनुत्तरदायी वर्ग के  अन्तर्गत तो नहीं आते हैं, परीक्षा एवं प्रतियोगिता में असफल होने के  मूल में प्रायः हमारे युवावर्ग द्वारा पूरी तरह

से अपने कर्तव्य का पालन न करना होता है, वे यदि अपने कर्तव्य का पालन पूरी निष्ठा के  साथ करें, तो हम पूरी दृढ़ता के  साथ कह

सकते हैं कि उनकी सफलता की संभावनाएँ  कई गुना बढ़ जाएँ गी।

कर्तव्य-पालन के  संदर्भ में यह नहीं सोचना चाहिए कि यदि सफलता नहीं मिलती है, तो क्या होगा? कर्तव्य-पालन को लक्ष्य करके

हमारे मन-मस्तिष्क में एक ही विचार रहना चाहिए कि मैं इसका सम्यक निर्वाह एवं पालन किस प्रकार कर सकता हूँ ?


1. ताओ ने चुंगसिन को सबसे बड़ा धार्मिक क्यों कहा? (1)


(क) क्योंकि चुंगसिन पहले से ही धार्मिक था।


(ख) क्योंकि चुंगसिन कर्तव्यों का पालन निष्ठापूर्वक करता था। 


(ग) क्योंकि चुंगसिन आश्रम का सारा काम करता था।


(घ) क्योंकि चुंगसिन ताओ की सेवा करता था।

2. कथन (A) और कारण (R) को पढ़कर उपयुक्त विकल्प चुनिए:
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कथन (A): जीवन में कर्तव्य-पालन ही मानव का परम धर्म है।


कारण (R): कर्तव्य का पालन निष्ठापूर्वक करने से सफलता की संभावनाएँ  कई गुना बढ़ जाती हैं।

विकल्प:

(क) कथन (A) गलत है, किंतु कारण (R) सही है।


(ख) कथन (A) और कारण (R) दोनों ही गलत हैं।


(ग) कथन (A) सही है और कारण (R) कथन (A) की सही व्याख्या है।


(घ) कथन (A) सही है किंतु कारण (R) कथन (A) की सही व्याख्या नहीं है।

3. मानव का परम धर्म किसे कहा गया है? (1)


(क) दीन-दुखियों की सेवा करना


(ख) गुरु की सेवा करना


(ग) माता पिता का आदर करना 


(घ) निष्ठापूर्वक अपने कर्तव्य का पालन करना

4. कर्तव्य के  प्रति निष्ठा व्यक्ति के  चरित्र को निरुत्तर कर देती है। उदाहरण द्वारा उत्तर की पुष्टि कीजिए। (2)

5. क्यों कहा गया है कि कु छ विद्यार्थी माता-पिता के  साथ छल करते हैं? (2)

2. निम्नलिखित गद्यांश को ध्यानपूर्वक पढ़कर पूछे गए प्रश्नों के  उत्तर लिखिए-


संस्कृ तियों के  निर्माण में एक सीमा तक देश और जाति का योगदान रहता है। संस्कृ ति के  मूल उपादान तो प्रायः सभी सुसंस्कृ त और

सभ्य देशों में एक सीमा तक समान रहते हैं, किंतु बाह्य उपादानों में अंतर अवश्य आता है। राष्ट्री य या जातीय संस्कृ ति का सबसे बड़ा

योगदान यही है कि वह हमें अपने राष्ट्र  की परंपरा से संपृक्त बनाती है, अपनी रीति-नीति की संपदा से विच्छिन्न नहीं होने देती। आज के

युग में राष्ट्री य एवं जातीय संस्कृ तियों के  मिलन के  अवसर अति सुलभ हो गए हैं, संस्कृ तियों का पारस्परिक संघर्ष भी शुरू हो गया है।

कु छ ऐसे विदेशी प्रभाव हमारे देश पर पड़ रहे हैं, जिनके  आतंक ने हमें स्वयं अपनी संस्कृ ति के  प्रति संशयालु बना दिया है। हमारी

आस्था डिगने लगी है। यह हमारी वैचारिक दुर्बलता का फल है।

अपनी संस्कृ ति को छोड़, विदेशी संस्कृ ति के  विवेकहीन अनुकरण से हमारे राष्ट्री य गौरव को जो ठेस पहुँच रही है, वह किसी राष्ट्र प्रेमी

जागरूक व्यक्ति से छिपी नहीं है। भारतीय संस्कृ ति में त्याग और ग्रहण की अद्भुत क्षमता रही है। अत: आज के  वैज्ञानिक युग में हम

किसी भी विदेशी संस्कृ ति के  जीवंत तत्वों को ग्रहण करने में पीछे नहीं रहना चाहेंगे, किंतु अपनी सांस्कृ तिक निधि की उपेक्षा करके

नहीं। यह परावलंबन राष्ट्र  की गरिमा के  अनुरूप नहीं है। यह स्मरण रखना चाहिए कि सूर्य की आलोकप्रदायिनी किरणों से पौधे को चाहे

जितनी जीवनशक्ति मिले, किंतु अपनी जमीन और अपनी जड़ों के  बिना कोई पौधा जीवित नहीं रह सकता। अविवेकी अनुकरण

अज्ञान का ही पर्याय है।

1. राष्ट्री य संस्कृ ति की हमारे प्रति सबसे बड़ी देन क्या है? (1)


(क) वह हमें अच्छा नागरिक बनाती है। 


(ख) वह हमें देशभक्ति सिखाती है।


(ग) वह हमें अपने राष्ट्र  की परंपरा और रीति-नीति से जोड़े रखती है।


(घ) वह हमें दुश्मनों से लड़ना सिखाती है।

2. कथन (A) और कारण (R) को पढ़कर उपयुक्त विकल्प चुनिए:

कथन (A): भारतीय संस्कृ ति में त्याग और ग्रहण की अद्भुत क्षमता रही है, जो आज के  वैज्ञानिक युग में विदेशी संस्कृ ति के  तत्वों

को ग्रहण करने की प्रवृत्ति को दर्शाती है।


कारण (R): विदेशी संस्कृ ति के  अनुकरण से भारतीय संस्कृ ति की आस्थाएँ  डिगने लगी हैं, जो राष्ट्री य गौरव को ठेस पहुँचा रही हैं।

विकल्प:

(क) कथन (A) गलत है, किंतु कारण (R) सही है।


(ख) कथन (A) और कारण (R) दोनों ही गलत हैं।


(ग) कथन (A) सही है और कारण (R) कथन (A) की सही व्याख्या है।


(घ) कथन (A) सही है किंतु कारण (R) कथन (A) की सही व्याख्या नहीं है।
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खंड ख - व्यावहारिक व्याकरण

खंड ग - गद्य खंड (पाठ्यपुस्तक)

3. अज्ञान का पर्याय क्या है? (1)


(क) अविवेकी संस्कृ ति


(ख) अविवेकी संस्कार 


(ग) अविवेकी ज्ञान 


(घ) अविवेकी अनुकरण

4. आधुनिक युग में संस्कृ तियों पर परस्पर संघर्ष प्रारंभ होने का प्रमुख कारण बताइए। (2)

5. हम अपनी संस्कृ ति के  प्रति शंकालु क्यों हो गए हैं? (2)

3. निम्नलिखित वाक्यों में से कोई चार कीजिए।

i. तताँरा बेहद शांत, सभ्य और भोला युवक था। रेखांकित पदबंध की पहचान कीजिए।

ii. क़िस्मत का मारा मैं कनकौआ लूटने दौड़ा चला जा रहा था। वाक्य में सर्वनाम पदबंध छाँटिये।

iii. वह भागा-भागा मेले की ओर दौड़ा। रेखांकित पदबंध की पहचान कीजिए।

iv. वह लाल तेल वाले डॉक्टर शरफु द्दीन का बेटा था। वाक्य में विशेषण पदबंध ढूँ ढ कर लिखिए।

v. हरिहर काका के  भाई चिंता, परेशानी और आश्चर्य से घिर गए। इस वाक्य में संज्ञा पदबंध छाँटिये।

[4]

4. नीचे लिखें वाक्यों में से किन्हीं चार वाक्यों का निर्देशानुसार रचना के  आधार पर वाक्य रूपांतरण कीजिए-

i. आकाश में बादल होते ही घनघोर वर्षा होने लगी। (संयुक्त वाक्य में)

ii. वह बगल के  कमरे में कु छ बरतन ले आया। तौलिए से बरतन साफ़ किए। (संयुक्त वाक्य में)

iii. लिखकर अभ्यास करने से कु छ भूल नहीं सकते। (मिश्र वाक्य में)

iv. सीमा पर लड़ने वाले सैनिक ऐसे हैं कि जान हथेली पर लिए रहते हैं। (सरल वाक्य में)

v. भाई साहब ने उछलकर पतंग की डोर पकड़ ली। (संयुक्त वाक्य में)

[4]

5. 'समास' पर आधारित पाँच प्रश्नों में से किन्हीं चार प्रश्नों के  उत्तर लिखिए - [4]

i. समास और मुहावरे के  बीच क्या भिन्नता है? [1]

ii. 'तत्पुरुष समास' में संज्ञा और विशेषण के  बीच संबंध को स्पष्ट कीजिए। [1]

iii. 'मंगलवार' शब्द का समास विग्रह कीजिए और इसके  भेद को विस्तार से समझाइए। [1]

iv. 'द्विगु समास' की विशेषताएँ  और उदाहरण दीजिए। [1]

v. 'कर्मधारय समास' के  भेद और उदाहरण दीजिए। [1]

6. 'मुहावरे' पर आधारित पाँच प्रश्नों में से किन्हीं चार प्रश्नों के  उत्तर लिखिए - [4]

i. Fill in the blanks:

ब्राह्मण शेर से बचने के  लिए अंत तक ________ रहा। (उपयुक्त मुहावरे द्वारा रिक्त स्थान की पूर्ति कीजिए।)

[1]

ii. Fill in the blanks:

किसी भी कठिन परिस्थिति से निकलने के  लिए हमें ________ पड़ता है। (उपयुक्त मुहावरे द्वारा रिक्त स्थान की पूर्ति

कीजिए।)

[1]

iii. 'दांतों तले अंगुली दबाना' और 'आंखें फटी की फटी रह जाना' में क्या अंतर है? [1]

iv. 'नाक में दम करना' का वाक्य लिखिए। [1]

v. "कड़ी मेहनत के  बिना जीवन में कोई मुराद पूरी नहीं होती।" इस पंक्ति में दिए गए मुहावरे को पहचानिए और उसका वाक्य में

प्रयोग कीजिए।

[1]

7. अनुच्छेद को ध्यानपूर्वक पढ़कर निम्नलिखित प्रश्नों के  उत्तर दीजिये:

मगर टाइम-टेबिल बना लेना एक बात है, उस पर अमल करना दूसरी बात। पहले ही दिन उसकी अवहेलना शुरू हो जाती। मैदान की

वह सुखद हरियाली, हवा के  हलके -हलके  झोंके , फु टबाल की वह उछल-कू द, कबड्डी के  वह दाँव-घात, वॉलीबाल की वह तेज़ी और

फु रती, मुझे अज्ञात और अनिवार्य रूप से खींच ले जाती और वहाँ जाते ही मैं सब कु छ भूल जाता। वह जानलेवा टाइम-टेबिल, वह

[5]
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खंड ग - काव्य खंड (पाठ्यपुस्तक)

आँखफोड़ पुस्तकें , किसी की याद न रहती और भाई साहब को नसीहत और फ़ज़ीहत का अवसर मिल जाता। मैं उनके  साये से

भागता, उनकी आँखों से दूर रहने की चेष्टा करता, कमरे में इस तरह दबे पाँव आता कि उन्हें खबर न हो। उनकी नज़र मेरी ओर उठी

और मेरे प्राण निकले। हमेशा सिर पर एक नंगी तलवार-सी लटकती मालूम होती। फिर भी जैसे मौत और विपत्ति के  बीच भी आदमी

मोह और माया के  बंधन में जकड़ा रहता है, मैं फटकार और घुड़कियाँ खाकर भी खेल-कू द का तिरस्कार न कर सकता था।

क) टाइम-टेबिल बनाना सरल कार्य नहीं है और

उस पर अमल करना उससे भी कठिन है।

ख) टाइम-टेबिल तो सब बना लेते हैं लेकिन उसके

अनुरूप दिनचर्या निर्वाह सबके  बस का नहीं।

ग) टाइम-टेबिल के  अनुरूप कार्य करने में बहुत

कठिनाई होती है।

घ) टाइम-टेबिल बनाने में पेन ही उठाना होता है

अमल करने में मन-मस्तिष्क लगाना होता है।

i. लेखक ने ऐसा क्यों कहा कि टाइम-टेबिल बनाना और उस पर अमल करना अलग-अलग बातें हैं?

क) कथन और कारण दोनों ग़लत हैं। ख) कथन सही है, लेकिन कारण उसकी ग़लत

व्याख्या करता है।

ग) कथन ग़लत है, लेकिन कारण सही है। घ) कथन और कारण दोनों सही हैं तथा कारण,

कथन की सही व्याख्या करता है।

ii. निम्नलिखित कथन तथा कारण को पढ़कर दिए गए विकल्पों में से कोई एक सही विकल्प चुनकर लिखिए:


कथन: मैदान में पहुँचते ही छोटा भाई सब कु छ भूल जाता।


कारण: खेल का मैदान, वहाँ की हरियाली, हवा और स्वच्छंदता छोटे भाई को अपने आगोश में समेट लेती।

क) वह टाइम-टेबिल के  अनुसार चलता। ख) छोटा भाई टाइम-टेबिल बना लेता।

ग) पढ़ाई के  लिए बैठता और नहीं पढ़ता। घ) टाइम-टेबिल-पुस्तकों से मुँह मोड़ लेता।

iii. भाई साहब को छोटे भाई को उपदेश देने का मौका मिल जाता, जब:

क) बड़े भाई साहब के  फे ल होने के  कारण ख) बड़े भाई की डाँट-डपट के  कारण

ग) प्रधानाचार्य की शिकायत के  कारण घ) दोनों भाइयों का एक ही कक्षा में होने के  कारण

iv. छोटा भाई अपने बड़े भाई से दूर रहने का प्रयास क्यों करता है?

क) 1 - (I), 2 - (II), 3 - (III) ख) 1 - (I), 2 - (III), 3 - (II)

ग) 1 - (II), 2 - (III), 3 - (I) घ) 1 - (III), 2 - (II), 3 - (I)

v. गद्यांश के  संदर्भ में स्तंभ-I को स्तंभ-II से सुमेलित कीजिए और सही विकल्प का चयन करके  लिखिए:

स्तंभ-I स्तंभ-II

1. सिर पर नंगी तलवार लटकी रहती। (I) खेलकू द से प्रेम

2. नसीहत और फ़ज़ीहत का अवसर मिलता। (II) कथानायक

3. मोह-माया का बंधन (III) बड़े भाई साहब

8. निम्नलिखित प्रश्नों में से किन्हीं तीन प्रश्नों के  उत्तर लगभग 25-30 शब्दों में दीजिए: [6]

i. मोनुमेंट के  नीचे सभा क्यों की जा रही थी? 'डायरी का एक पन्ना' पाठ के  आधार पर लिखिए। [2]

ii. गांधीजी आदर्श एवं व्यावहारिकता का समन्वय किस प्रकार करते थे? गिन्नी का सोना पाठ के  आधार पर लिखिए। [2]

iii. कारतूस एकांकी के  आधार पर सोदाहरण स्पष्ट कीजिए कि सआदत अली जैसे लोगों ने सदैव देश का अहित ही किया है। [2]

iv. तीसरी कसम फ़िल्म में दुख के  भाव को किस प्रकार प्रस्तुत किया गया है? दुख के  वीभत्स रुप से यह दुख किस प्रकार भिन्न

है? लिखिए।

[2]

9. अनुच्छेद को ध्यानपूर्वक पढ़कर निम्नलिखित प्रश्नों के  उत्तर दीजिये: [5]
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खंड ग - संचयन (पूरक पाठ्यपुस्तक)

विचार लो कि मर्त्य हो न मृत्यु से डरो कभी,

मरो, परंतु यों मरो कि याद जो करें सभी।


हुई न यों सुमृत्यु तो वृथा मरे, वृथा जिए,

मरा नहीं वही कि जो जिया न आपके  लिए।

वही पशु-प्रवृत्ति है कि आप आप ही चरे,


वही मनुष्य है कि जो मनुष्य के  लिए मरे।।

क) मृत्यु तो अवश्यंभावी है ख) मृत्यु के  बाद नया शरीर मिलता है

ग) जन्म-मरण ईश्वर के  हाथ में है घ) मृत्यु से यश प्राप्त होता है

i. कवि ने ऐसा क्यों कहा कि मृत्यु से नहीं डरना चाहिए?

क) स्वार्थ सिद्ध करते समय हुई मृत्यु ख) महान उद्देश्य के  लिए मरने वाले की मृत्यु

ग) अपनों के  हित प्राप्त होने वाली मृत्यु घ) बिना किसी पीड़ा के  हुई मृत्यु

ii. कवि कै सी मृत्यु को सुमृत्यु कहता है?

क) दूसरों के  लिए संघर्ष करते हुए प्राप्त मृत्यु ख) जिस मृत्यु को याद न किया जाए

ग) देश हित प्राप्त होने वाली मृत्यु घ) मृत्यु के  बाद जो हमेशा याद रहे

iii. कै सी मृत्यु व्यर्थ है?

क) अपने लिए जीना-खाना ख) दूसरों की भावनाओं को ठेस पहुँचाना

ग) दूसरों के  लिए जीना-खाना घ) परोपकार का भाव रखना

iv. पशु प्रवृत्ति क्या है?

क) I, III ख) के वल I

ग) II, III घ) II, IV

v. कौन-सा/से वाक्य पद्यांश से मेल खाता है/खाते हैं?

I. उदार मनुष्य दूसरों के  लिए जीता-मरता है।

II. पशु प्रवृत्ति को समझ के  साथ अपनाना चाहिए।

III. मनुष्य जीवन की सार्थकता परोपकार में है।

IV. जीवन में कु छ पाने के  लिए स्वार्थी होना पड़ता है।

10. निम्नलिखित प्रश्नों में से किन्हीं तीन प्रश्नों के  उत्तर लगभग 25-30 शब्दों में दीजिए: [6]

i. मीरा अपने आराध्य कृ ष्ण से क्या विनती करती हैं और उन्हें उनके  कर्तव्य का स्मरण करवाने के  लिए क्या करती हैं? [2]

ii. सहस्र दृग-सुमन से क्या तात्पर्य है? कवि ने इस पद का प्रयोग किसके  लिए किया होगा? [2]

iii. फ़तह का जश्न इस जश्न के  बाद है - कर चले हम फिदा कविता से उद्धृत प्रस्तुत पंक्ति में ‘इस जश्न' से कवि का क्या आशय है

और उसे बाद में मनाने के  पीछे क्या कारण है?

[2]

iv. आत्मत्राण कविता में किसी सहायक पर निर्भर न रहने की बात कवि क्यों कहता है? स्पष्ट कीजिए। [2]

11. निम्नलिखित प्रश्नों में से किन्हीं दो प्रश्नों के  उत्तर लगभग 50-60 शब्दों में दीजिए: [6]

i. हरिहर काका भाइयों पर गुस्सा करके  घर से बाहर जा रहे थे, तब उनकी भेंट महंत से हुई और वे उन्हें ठाकु रबारी ले गए।

हरिहर काका को ठाकु रबारी ले जाकर महंत ने उनके  साथ किस प्रकार का व्यवहार किया? हरिहर काका कहानी के  आधार

पर लिखिए।

[3]

ii. विद्यार्थियों में अनुशासन की भावना विकसित करने के  लिए कठोर दंड वाली विधि अधिक उपयुक्त है या वर्तमान समय की

मनोवैज्ञानिक विधियाँ? सपनों के -से दिन पाठ के  आधार पर लिखिए।

[3]
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खंड घ - रचनात्मक लेखन

iii. टोपी शुक्ला कहानी हमें क्या सन्देश देती है? भारतीय समाज के  लिए यह कै से लाभकारी हो सकता है? तर्क  सहित उत्तर

दीजिए।

[3]

12. निम्नलिखित में से किसी एक विषय पर लगभग 120 शब्दों में अनुच्छेद लिखिये: [5]

i. सड़कों को कचरे से बचाओ विषय पर दिए गए संके त बिंदुओं के  आधार पर अनुच्छेद लिखिए।


संके त-बिंदु

हर कोई फें क रहा कचरा

सोच बदलने की जरूरत

स्वच्छता के  लिए जागरूकता अपेक्षित

[5]

ii. जनसंख्या नियंत्रण विषय पर दिए गए संके त बिंदुओं के  आधार पर 80-100 शब्दों में अनुच्छेद लिखिए।

जनसंख्या वृद्धि की समस्या

नियंत्रण की आवश्यकता क्यों

नियंत्रण कै से?

[5]

iii. स्वदेशी अपनाओ विषय पर दिए गए संके त बिंदुओं के  आधार पर अनुच्छेद लिखिए।

संके त बिंदु: क्या, आवश्यकता क्यों?, देश की अर्थव्यवस्था पर इसका प्रभाव, सुझाव

[5]

13. आपसे अपने बचत खाते की चैक बुक खो गई है। इस सम्बन्ध में तत्काल उचित कार्यवाही करने के  लिए निवेदन करते हुए बैंक प्रबंधक

को पत्र लिखिए।

[5]

अथवा

अस्पताल कर्मचारियों के  सद्व्यवहार की प्रशंसा करते हुए मुख्य चिकित्सा अधिकारी को लगभग 80-100 शब्दों में पत्र लिखिए।

14. हरियाणा शहरी विकास प्राधिकरण, फरीदाबाद में नर्सिंग होम के  लिए जगह नीलाम करना चाहता है। इसके  लिए नीलामी सूचना 25-

30 शब्दों में तैयार कीजिए।

[4]

अथवा

आप अपने विद्यालय में विद्यार्थी परिषद् के  सचिव हैं। विद्यालय में होने वाली चित्रकला प्रतियोगिता के  लिए 40-50 शब्दों में सूचना तैयार

कीजिए।

15. ज्वैलरी शॉप के  लिए एक विज्ञापन लगभग 25-50 शब्दों में बनाइए। [3]

अथवा

ए.टी.एम. कें द्रों पर सावधानी बरतने संबंधी निर्देश देते हुए पंजाब नेशनल बैंक की ओर से लगभग 25-50 शब्दों में एक विज्ञापन तैयार

कीजिए।

16. अपने क्षेत्र के  विद्युत विभाग के  अधिकारी (1912@pspcl.in) को विद्युत बिल ठीक कराने के  लिए एक ईमेल लिखिए। [5]

अथवा

संगति का फल शीर्षक विषय पर लगभग 100 शब्दों में एक लघुकथा लिखिए।
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खंड क - अपठित बोध

1. 1. (ख) क्योंकि चुंगसिन अपने कर्तव्यों का पालन निष्ठापूर्वक करता था इसलिए ताओ ने उसे सबसे बड़ा धार्मिक कहा।
2. (ग) कथन (A) सही है और कारण (R) कथन (A) की सही व्याख्या है।
3. (घ) मानव का परम धर्म है-निष्ठापूर्वक अपने कर्तव्य का पालन करना।
4. कर्तव्य के  प्रति निष्ठा व्यक्ति और उसके  चरित्र को महान बनाती है। चुंगसिन ने निष्ठापूर्वक अपने कर्तव्य का पालन किया इसलिए उसे महान धार्मिक कहा

गया।
5. कु छ विद्यार्थी घर से पढ़ने के  लिए कॉलेज आते हैं पर कक्षाओं में न जाकर वे मटरगश्ती करते हैं और इस प्रकार अपने माता-पिता के  साथ छल करते

हैं।

1. 2. (ग) राष्ट्री य संस्कृ ति की हमारे प्रति सबसे बड़ी देन यही है कि वह हमें अपने राष्ट्र  की परंपरा और रीति-नीति से जोड़े रखती है।
2. (ग) कथन (A) सही है और कारण (R) कथन (A) की सही व्याख्या है।
3. (घ) अविवेकी अनुकरण अज्ञान का ही पर्याय है।
4. आधुनिक युग में संस्कृ तियों में परस्पर संघर्ष  प्रारंभ होने का प्रमुख कारण यह है कि भिन्न संस्कृ तियों के  निकट आने के  कारण अतिक्रमण एवं विरोध

स्वाभाविक है।
5. हम अपनी संस्कृ ति के  प्रति शंकालु इसलिए हो गए हैं, क्योंकि नई पीढ़ी ने विदेशी संस्कृ ति के  कु छ तत्वों को स्वीकार करना प्रारंभ कर दिया है।

खंड ख - व्यावहारिक व्याकरण

i. 3. विशेषण पदबंध
ii. क़िस्मत का मारा
iii. क्रिया-विशेषण पदबंध
iv. लाल तेल वाले
v. हरिहर काका के  भाई

i. 4. आकाश में बादल हैं इसीलिए घनघोर वर्षा होने लगी।
ii. वह बगल के  कमरे से कु छ बरतन ले आया और उन्हें तौलिए से साफ़ किया।
iii. जो लिख कर अभ्यास करते हैं,वे कु छ भूल नहीं सकते।
iv. सीमा पर लड़ने वाले सैनिक जान हथेली पर लिए रहते हैं।
v. भाई साहब उछले और पतंग की डोर पकड़ ली।

5. 'समास' पर आधारित पाँच प्रश्नों में से किन्हीं चार प्रश्नों के  उत्तर लिखिए -
समास में दो शब्द मिलकर एक संक्षिप्त अर्थ  प्रदान करते हैं, जबकि मुहावरे में शब्दों का समूह एक विशेष भावार्थ  व्यक्त करता है।

समास: "राजपुत्र" (राजा का पुत्र)।
मुहावरा: "राजा की तरह रहना" (ऐश्वर्यपूर्ण  जीवन)।

(i)

तत्पुरुष समास में संज्ञा और विशेषण के  बीच संबंध स्पष्ट होता है, जहां पूर्व  पद संज्ञा को विशेषता प्रदान करता है।

उदाहरण: "चंद्रमामा" (चंद्र+मामा) में "चंद्र" संज्ञा है और "मामा" विशेषण है जो चंद्र को संबोधित करता है।

(ii)

'मंगलवार' शब्द का समास विग्रह और उसका भेद निम्नलिखित है:
विग्रह:
मंगल + वार

यहां:

मंगल = शुभ, अच्छा
वार = दिन

अर्थ: "मंगलवार" शब्द का अर्थ  है वह दिन जो मंगल (शुभ) से संबंधित हो, यानी शुभ दिन।
समास का भेद:
"मंगलवार" में तत्पुरुष समास का प्रयोग हुआ है।
तत्पुरुष समास वह समास होता है, जिसमें पहले शब्द का गुण या विशेषता दूसरे शब्द में व्यक्त होती है। इस समास में दोनों शब्दों का संबंध इस
प्रकार होता है कि पहले शब्द का अर्थ  दूसरे शब्द को विशेष रूप से निर्धारित करता है।

(iii)

विशेषताएँ: द्विगु समास में पहला पद किसी संख्या को व्यक्त करता है और दूसरा पद उसे विशेषता प्रदान करता है।

उदाहरण: "द्वादशपद" (12 पंख) - "द्वादश" (12) और "पद" (पंख) मिलकर यह अर्थ  बनाते हैं कि 12 पंख हैं।

(iv)

भेद:

i. वर्णक कर्मधारय: विशेषण के  रूप में।
ii. सामान्य कर्मधारय: सामान्य अर्थ  में।

(v)
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6. 'मुहावरे' पर आधारित पाँच प्रश्नों में से किन्हीं चार प्रश्नों के  उत्तर लिखिए -

खंड ग - गद्य खंड (पाठ्यपुस्तक)
7. अनुच्छेद को ध्यानपूर्वक पढ़कर निम्नलिखित प्रश्नों के  उत्तर दीजिये:

मगर टाइम-टेबिल बना लेना एक बात है, उस पर अमल करना दूसरी बात। पहले ही दिन उसकी अवहेलना शुरू हो जाती। मैदान की वह सुखद हरियाली,
हवा के  हलके -हलके  झोंके , फु टबाल की वह उछल-कू द, कबड्डी के  वह दाँव-घात, वॉलीबाल की वह तेज़ी और फु रती, मुझे अज्ञात और अनिवार्य  रूप से
खींच ले जाती और वहाँ जाते ही मैं सब कु छ भूल जाता। वह जानलेवा टाइम-टेबिल, वह आँखफोड़ पुस्तकें , किसी की याद न रहती और भाई साहब को
नसीहत और फ़ज़ीहत का अवसर मिल जाता। मैं उनके  साये  से भागता, उनकी आँखों से दूर रहने की चेष्टा करता, कमरे में इस तरह दबे पाँव आता कि उन्हें
खबर न हो। उनकी नज़र मेरी ओर उठी और मेरे प्राण निकले। हमेशा सिर पर एक नंगी तलवार-सी लटकती मालूम होती। फिर भी जैसे मौत और विपत्ति के
बीच भी आदमी मोह और माया के  बंधन में जकड़ा रहता है, मैं फटकार और घुड़कियाँ खाकर भी खेल-कू द का तिरस्कार न कर सकता था।

8. निम्नलिखित प्रश्नों में से किन्हीं तीन प्रश्नों के  उत्तर लगभग 25-30 शब्दों में दीजिए:

खंड ग - काव्य खंड (पाठ्यपुस्तक)

उदाहरण:

i. "सत्यवादी" (सत्य + वादी) - सत्य बोलने वाला।
ii. "दीनदयाल" (दीन + दयाल) - दीनों का दयालु।

हाथ-पाँव मारना(i)
एड़ी-चोटी का जोर लगाना(ii)
दांतों तले अंगुली दबाना: आश्चर्यचकित होना।

आंखें फटी की फटी रह जाना: किसी दृश्य को देखकर दंग रह जाना।

(iii)

छोटे बच्चे ने पूरे दिन शोर मचाकर मेरी नाक में दम कर दिया।(iv)
मुहावरा: मुराद पूरी होना।

वाक्य: उसकी वर्षों की तपस्या के  बाद आखिर उसकी मुराद पूरी हुई।

(v)

(ख)
टाइम-टेबिल तो सब बना लेते हैं लेकिन उसके  अनुरूप दिनचर्या निर्वाह सबके  बस का नहीं।


व्याख्या:
टाइम-टेबिल तो सब बना लेते हैं लेकिन उसके  अनुरूप दिनचर्या निर्वाह सबके  बस का नहीं।

(i)

(घ)
कथन और कारण दोनों सही हैं तथा कारण, कथन की सही व्याख्या करता है।


व्याख्या:
कथन और कारण दोनों सही हैं तथा कारण, कथन की सही व्याख्या करता है।

(ii)

(घ)
टाइम-टेबिल-पुस्तकों से मुँह मोड़ लेता।


व्याख्या:
टाइम-टेबिल-पुस्तकों से मुँह मोड़ लेता।

(iii)

(ख)
बड़े भाई की डाँट-डपट के  कारण


व्याख्या:
बड़े भाई की डाँट-डपट के  कारण

(iv)

(ग)
1 - (II), 2 - (III), 3 - (I)


व्याख्या:
1 - (II), 2 - (III), 3 - (I)

(v)

अखिल भारतीय राष्ट्री य कांग्रेस की ओर से 26 जनवरी 1930 को स्वतंत्रता दिन मनाने का आह्वान किया गया था। अगले वर्ष  यानी 26 जनवरी
1931 को यादगार बनाने के  लिए तथा लोगों में प्रेरणा निर्माण करने के  लिए कलकत्ता में मोनुमेंट के  नीचे सभा आयोजित की जा रही थी। इस सभा
के  द्वारा भारत को अंग्रेज़ों की दासता से पूर्ण  रूप से मुक्त कराने के  लिए शहरवासियों में जागृति निर्माण की जा सकती थी।

(i)

महात्मा गांधी ने शुद्ध आदर्श  की तुलना सोने से और व्यावहारिकता की तुलना ताँबे से की है क्योंकि शुद्ध आदर्श  में कभी कोई खोट नहीं होता। वह
खरे सोने के  समान होता है। व्यावहारिकता ताँबे के  समान होती है। उसे आभूषण बनाने के  लिए सोने में मिलाया जाता है। इसी प्रकार आदर्श  को
व्यावहारिक बनाने के  लिए समझौते करने पड़ते हैं। आदर्शो को व्यावहारिकता के  स्तर पर न लाकर व्यावहारिकता को आदर्श  के  स्तर तक
ऊपर उठाते थे।

(ii)

सआदत अली जैसे लोग हमेशा देश का अहित हीं करते हैं | ' कारतूस ' एकांकी के  आधार पर उदाहरण निम्नलिखित है:
i. सआदत अली कर्नल का खास दोस्त और एक अय्याश आदमी था। वो अपने अय्याशीयों के  लिए कु छ भी कर सकता था ।

ii. उसने ये  जानते हुए भी कि अंग्रेज देश के  खिलाफ षड्यन्त्र कर रहे हैं | उसने अपनी जायदाद का आधा भाग और दस लाख रुपये  अंग्रेजों को
दे दिए |

(iii)

'तीसरी कसम' फ़िल्म में दु ख के  भाव को सहज स्थिति में प्रकट किया गया है। इस फ़िल्म में दु खों को जीवन के  सापेक्ष रूप में प्रस्तुत किया है।
दु ख के  वीभत्स रूप से यह सर्वथा भिन्न है क्योंकि यहाँ दु खों से घबराकर लोग पीठ नहीं दिखाते। दु खों से हमें घबराना नहीं चाहिए। दु खों का
साहसपूर्वक सामना करना चाहिए। दु ख के  इस रूप को देखकर मनुष्य 'व्यथा' व 'करुणा' को सकारात्मक ढंग से स्वीकार करता है। वह दु खों से
परास्त नहीं होता, निराश नहीं होता। इस फ़िल्म में दु ख की सहज स्थिति लोगों को आशावादी बनाती है।

(iv)
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9. अनुच्छेद को ध्यानपूर्वक पढ़कर निम्नलिखित प्रश्नों के  उत्तर दीजिये:
विचार लो कि मर्त्य  हो न मृत्यु से डरो कभी,

मरो, परंतु यों मरो कि याद जो करें सभी।

हुई न यों सुमृत्यु तो वृथा मरे, वृथा जिए,

मरा नहीं वही कि जो जिया न आपके  लिए।
वही पशु-प्रवृत्ति है कि आप आप ही चरे,

वही मनुष्य है कि जो मनुष्य के  लिए मरे।।

10. निम्नलिखित प्रश्नों में से किन्हीं तीन प्रश्नों के  उत्तर लगभग 25-30 शब्दों में दीजिए:

खंड ग - संचयन (पूरक पाठ्यपुस्तक)
11. निम्नलिखित प्रश्नों में से किन्हीं दो प्रश्नों के  उत्तर लगभग 50-60 शब्दों में दीजिए:

(क)
मृत्यु तो अवश्यंभावी है


व्याख्या:
मृत्यु तो अवश्यंभावी है

(i)

(ख)
महान उद्देश्य के  लिए मरने वाले की मृत्यु


व्याख्या:
महान उद्देश्य के  लिए मरने वाले की मृत्यु

(ii)

(ख)
जिस मृत्यु को याद न किया जाए


व्याख्या:
जिस मृत्यु को याद न किया जाए

(iii)

(क)
अपने लिए जीना-खाना


व्याख्या:
अपने लिए जीना-खाना

(iv)

(क)
I, III


व्याख्या:
I, III

(v)

मीरा अपने आराध्य कृ ष्ण से यह विनती करती हैं कि वे लोगों के  साथ-साथ उनकी भी पीड़ा को हरें। उन्हें उनके  कर्तव्य का स्मरण करवाने के
लिए, वे द्रौपदी, प्रह्लाद और गजराज के  उदाहरण देती हैं और अपने आराध्य की क्षमताओं का गुणगान करती हैं।

(i)

कविता के  अनुसार सहस्र दृग-सुमन से तात्पर्य  है हज़ारों पुष्प जो कि आँखों के  समान प्रतीत होते हैं। कवि ने इसका प्रयोग पर्वत पर खिले हजारों
पुष्पों के  लिए किया है जो पर्वत के  आँखों के  समान हैं और जिनका प्रयोग पर्वत नीचे जल में अपना विशाल आकार देखने के  लिए कर रहे हैं।

(ii)

'फ़तह का जश्र इस जश्र के  बाद है' कहकर कवि अन्य सैनिकों को बलिदान देने के  लिए प्रेरित करना चाहता है। उसका मानना है कि यदि देश
रक्षा के  कार्यों को अधूरा छोड़ दिया जाएगा, तो शहीदों का बलिदान व्यर्थ  हो जायेगा। अतः शहीदों के  बाद अन्य सैनिकों को भी बहादु री से शत्रुओं
के  साथ तब तक लड़ना होगा, जब तक देश पूरी तरह सुरक्षित न हो जाए। जीत का उत्सव हम तभी मना सकें गे , जब बलिदान का यह सिलसिला
थम जायेगा।

(iii)

आत्मत्राण कविता में कवि सहायक के  न मिलने पर किसी पर निर्भर न रहने की बात इसलिए कहता है कि यदि ऐसी परिस्थिति आ जाए कि कोई
सहायता करने वाला न हो तो ऐसी विषम परिस्थिति में उसका आत्मबल, हिम्मत, साहस और बल-पौरुष बना रहे। साथ ही ईश्वर पर उसका
विश्वास डिगे  नहीं। कवि ईश्वर से साहस माँग रहा है ताकि वह दुः खों का सामना कर सके ।

(iv)

हरिहर काका को ठाकु रबारी ले जाकर महंत ने जायदाद के  लालच में उनकी बहुत आवभगत की। वे उन्हें ठाकु रबारी ले आए और उन्हें तरह-
तरह से बहला-फु सलाकर जायदाद को ठाकु र जी के  नाम करने के  लिए समझाने लगे। वे किसी भी तरह से उनकी जायदाद को अपने नाम
लिखवाना चाहते थे, परन्तु हरिहर काका ने ऐसा करने से साफ़ इंकार कर दिया तो उन्हें अपने पुजारियों से पिटवाया और कोरे कागज़ पर उनके
अंगूठे के  निशान ले लिए। उन्होंने हरिहर काका को जान से मरवाने का भी प्रयास किया।

(i)

'सपनों के  से दिन' पाठ में विद्यार्थियों को अनुशासित रखने के  लिए कठोर दंड जैसे मार-पीट जैसी युक्तियाँ अपनाई गई हैं पर वर्तमान समय में इस
प्रकार की युक्तियों को निंदनीय माना गया है। इस प्रकार की युक्तियों के  कारण विद्यार्थी विद्यालय में आने से डरते हैं। वर्तमान में शिक्षकों को इस
प्रकार प्रशिक्षित किया जाता है कि वे विद्यार्थियों की भावनाओं को समझे और उन्हें प्यार से उनकी गलतियों का एहसास करवाएँ  न कि उन्हें मारे-
पीटे। जब वे बच्चों के  साथ प्यार और ममता का व्यवहार रखेंगे  तो विद्यार्थी भी अपनी समस्याओं को उनके  साथ साझा करेंगे  और ख़ुशी-ख़ुशी
विद्यालय आएँगे। अतः विद्यार्थियों को अनुशासित करने के  लिए वर्तमान समय की मनोवैज्ञानिक विधि सर्वाधिक उपयुक्त है।

(ii)

'टोपी शुक्ला' कहानी के  माध्यम से कहानीकार ने हमें यह संदेश दिया है और प्रेरणा भी दी है कि हमें यह समझना चाहिए कि सभी मनुष्य एक
समान हैं। वे पहले इंसान हैं और बाद में हिंदू-मुसलमान। हमें टोपी शुक्ला कहानी के  अनुसार सांप्रदायिक भेदभावों को आड़े नहीं आने देना चाहिए।
सांप्रदायिक एकता और सद्भावना बनाए रखने का प्रयास करना चाहिए। यह सद्भावना ही तनाव, झगड़ों को समाप्त कर सामाजिक सौहार्द  की
स्थापना कर सकती है।

भारत जैसे विभिन्न धर्मावलंबियों वाले राष्ट्र  में इसके  अनेक लाभ हैं। इससे सांप्रदायिक विवाद समाप्त होंगे , सहिष्णुता का माहौल बनेगा जो संगठित
व शक्तिशाली राष्ट्र  के  निर्माण में सहायक होगा और विकास के  पथ में अग्रसर हो सके गा।

इफ़्फ़न और टोपी शुक्ला की मित्रता में जाति व धर्म का कोई बंधन नहीं था। इस प्रकार की मित्रता सामाजिक सौहार्द  बढ़ाने में सहायक होती है।

(iii)

Page 9 of 13



खंड घ - रचनात्मक लेखन
12. निम्नलिखित में से किसी एक विषय पर लगभग 120 शब्दों में अनुच्छेद लिखिये:

13. प्रसेवा में,

प्रबन्धक
पंजाब नेशनल बैंक

विकासपुरी (नई दिल्ली)

विषय-चैक बुक खो जाने के  संबंध में 

महोदय,

निवेदन है कि प्रार्थी आपकी शाखा का नियमित उपभोक्ता है और मेरी बचत खाता संख्या 6918 आपकी शाखा में ही हैं। जिसमें (लगभग 55,000/-रु.) जमा
हैं। मैंने कु छ दिन पहले आपके  बैंक से एक चेकबुक 20 चेकों की ली थी, जिसमें से अभी तक के वल 2 चेक ही निर्गत हुए हैं। अभी 18 चेक उसमें मौजूद हैं।
कल शाम को मेरा बैग विकासपुरी से कै लाशपुरी आते समय गाड़ी से कहीं गिर गया है जिसमें कु छ कागजातों के  साथ चेकबुक भी थी, काफी प्रयास के  बाद
भी नहीं मिली। अतः आपसे निवेदन है कि आप उस चेकबुक के  किसी भी चेक का भुगतान मेरे खाते से रोकने का कष्ट करें अन्यथा मैं भरी संकट में पड़
जाऊँ गा | इस पत्र के  साथ अन्य आवश्यक कागज जैसे पासबुक,आधारकार्ड  आदि संग्लग्न हैं। यद्यपि इस विषय में मैंने अपने क्षेत्रीय थाने में भी सूचना दर्ज
करा दी है। 
अत: सूचनार्थ  एवं निवेदन हेतु पत्र आपकी शाखा में प्रस्तुत है।

आशा है आप भुगतान नहीं करेंगे।

भवदीय
गोविन्द सिंह पंचायत अधिकारी

विकासपुरी नई दिल्ली

दिनांक 17 जनवरी, 2019

अथवा
मकान नं.- p-276

गोविन्द मोहल्ला

गिरीश नगर

दिनांक- 21-08-2020


ऐसी मित्रता में कोई भेदभाव भी नहीं होता, न पारिवारिक स्तर पर और न ही सामाजिक स्तर पर। इससे दो अलग-अलग भाषाओं व संस्कृ तियों
को जोड़ने में सहायता मिलती है।

हमारे आसपास की सड़कें  कचरे से अटी पड़ी हैं। हर कोई बेख़ौफ होकर कचरा फें क रहा है, जिससे हमारे शहरों की सुंदरता और स्वच्छता
दोनों प्रभावित हो रही हैं। यह समस्या के वल सरकार या नगर निगम की नहीं है, बल्कि हम सभी की है। हमें अपनी सोच बदलने की जरूरत है।
कचरे को कू ड़ेदान में डालना हमारी जिम्मेदारी है।

स्वच्छता के  प्रति जागरूकता फै लाना बहुत जरूरी है। हमें लोगों को समझाना होगा कि कचरा फें कना कितना गलत है और इससे हमारे पर्यावरण
को कितना नुकसान होता है। स्कू लों, कॉलेजों और समुदायों में स्वच्छता अभियान चलाकर हम इस समस्या का समाधान ढूँ ढ़ सकते हैं। आइए
हम सभी मिलकर अपने शहरों को स्वच्छ और सुंदर बनाने का संकल्प लें।

(i)

किसी राष्ट्र  की प्रगति के  लिए जनसंख्या एक महत्वपूर्ण  संसाधन होती है, पर जब यह एक सीमा से अधिक हो जाती है तब यह समस्या का रूप ले
लेती है। जनसंख्या वृद्धि एक ओर स्वयं समस्या है तो दूसरी ओर यह अनेक समस्याओं की जननी भी है। यह परिवार, समाज और राष्ट्र  की
प्रगति पर बुरा असर डालती है। जनसंख्या वृद्धि के  साथ देश के  विकास की स्थिति &ढाक के  तीन पात वाली बनकर रह जाती है। प्रकृ ति ने
लोगों के  लिए भूमि, वन आदि जो संसाधन प्रदान किए है, जनाधिक्य के  कारण वे कम पड़ने लगते है तब मनुष्य प्राकृ तिक असंतुलन का खतरा
पैदा होता है जिससे नाना प्रकार की समस्याएँ  उत्पन्न होती है। भारत को बढ़ती आबादी की समस्या का सामना करना पड़ रहा है। दु निया की
करीब 17% आबादी भारत में रहती है जिससे यह दु निया के  सबसे अधिक आबादी वाले देशों में से एक है। जनसंख्या वृद्धि के  लिए हम भारतीय
की सोच काफी हद तक जिम्मेदार है। यहाँ की पुरूष प्रधान सोच के  कारण घर में पुत्र जन्म आवश्यक माना जाता है। भले ही एक पुत्र की चाहत में
छह, सात लडकियाँ क्यों न पैदा हो जाएँ  पर पुत्र के  बिना न तो लोग अपना जन्म सार्थक मानते हैं और न ही उन्हें स्वर्ग  की प्राप्ति होती दिखती है।
इसके  अलावा अशिक्षा, गरीबी और मनोरंजन के  साधनों का अभाव भी जनसंख्या वृद्धि में योगदान देता है। जनसंख्या वृद्धि रोकने के  लिए लोगों
का इसके  दु ष्परिणामों से अवगत कराकर जन जागरूकता फै लाई जानी चाहिए। और सरकार द्वारा परिवार नियोजन के  साधनों का मुफ्त वितरण
किया जाना चाहिए तथा जनसंख्या वृद्धि को पाठ्यक्रम में शामिल करना चाहिए।

(ii)

स्वदेशी अपनाओ
स्वदेशी का अर्थ  है - 'अपने देश का' अथवा 'अपने देश में निर्मित'। हमें स्वदेशी साधनों के  उपयोग पर बल देना चाहिए। आज के  दौर में स्वदेशी
और आत्मनिर्भरता की ज़रूरत फिर से महसूस होने लगी है। विकसित देश उन्हीं के  होते हैं, जिनमें स्वदेशी उत्पादों का उत्पादन होता है। यदि
हम दूसरे देशों पर निर्भर रहेंगे , तो वे हमें मजबूरी में ऊँ चे दाम पर चीजें बेचेंगे  और हमें उन्हें खरीदने की आवश्यकता होगी।

इसलिए हमें स्वदेशी साधनों को प्रोत्साहित करने की आवश्यकता है। इन साधनों के  उपयोग से न के वल देश की आर्थिक स्थिति में सुधार होगा
बल्कि यह रोज़गार के  अवसरों को भी बढ़ाएगा। इसलिए, हमें सभी देशवासियों को स्वदेशी सामग्री का प्रचार-प्रसार करने और स्वदेशी उत्पादों
का समर्थन करने के  लिए प्रोत्साहित करना चाहिए। इससे स्वदेशी अपनाओ आंदोलन को बढ़ावा मिलेगा और हम आत्मनिर्भर बनेंगे। स्वदेशी
अपनाने से देश की तरक्की में यह महत्वपूर्ण  योगदान होगा और हम गर्व  से कह सकें गे  - 'हम स्वदेशी के  समर्थन में हैं, हम स्वदेश का सम्मान करते
हैं।'

(iii)
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सेवा में

मुख्य चिकित्सा अधिकारी जी

हरि अस्पताल

अ.ब.स. नगर
विषय- कर्मचारियों के  सद्व्यवहार की प्रशंसा हेतु पत्र

महोदय,

मैं अ.ब.स.नगर का निवासी हूँ । विगत कु छ दिनों से मेरा एक प्रियजन आपके  अस्पताल में ज्वर रोग से ग्रसित होकर भर्ती था। दवा के  प्रभाव और ईश्वर की
अनुकं पा से वह आज ही आपके  अस्पताल से मुक्त होकर घर पहुँ चा है। उससे बात करने पर पता चला कि आपके  अस्पताल में चिकित्सा उपचार और
संबंधित सुविधाएं  बहुत ही उत्तम दर्जे की है। उसने बताया कि आपके  अस्पताल के  कर्मचारियों ने उसके  साथ अत्यंत आत्मीय व्यवहार किया था। उनके
आत्मीय और स्नेहपूर्ण  व्यवहार के  कारण ही वह जल्दी स्वस्थ हो सका है।
महाशय, हम सभी आपके  अस्पताल कर्मचारियों को उनके  व्यवहार के  कारण हृदय से धन्यवाद ज्ञापित करते हैं तथा उनके  सुनहरे भविष्य की कामना
करते हैं। विश्वास है, भविष्य में भी उन सबका व्यवहार ऐसा ही रहेगा।

इसके  लिए हम सदैव आपके  आभारी रहेंगे।

सधन्यवाद
आपका विश्वासी

गौतम सिंघानिया

14. 

हरियाणा शहरी विकास प्राधिकरण

फरीदाबाद में नर्सिंग होम/क्लीनिक

की नीलामी की घोषणा करता है


स्थल का विवरण

नर्सिंग होम अस्थायी क्षेत्र 1000 वर्ग  गज


सेक्टर - 5

नियम एवं शर्तें: (नर्सिंग होम/क्लीनिक)

यह स्थल पूर्ण  स्वामित्व पर आधारित है। आवंटी को कब्जे की पेशकश के  2 वर्षों के  भीतर नर्सिंग होम\क्लीनिक का निर्माण कार्य  संपन्न करना होगा।
बोली राशि का 10% अंश बोली छू टते ही नगद या संपदा अधिकारी, जी.एस.हुड्डा, फरीदाबाद के  पक्ष में डिमांड ड्राफ्ट के  रूप में जमा करवाना होगा तथा
अभीष्ट बोलीदाता को नीलामी में भाग लेने से पूर्व  200000/- रुपये  धरोहर राशि के  रूप में जमा करवानी होगी। यह राशि नीलामी के  पश्चात् लौटा दी
जाएगी। नीलामी की पूर्ण  राशि आवंटन पत्र जारी होने की तिथि से 30 दिनों के  भीतर जमा करवानी आवश्यक होगी।

नीलामी की तिथि . . . . . . . . . . को पूर्वाह्न .00 बजे

स्थान: योजना आयोग परिसर 


सेक्टर-12, फरीदाबाद

ह० .........................

संपदा अधिकारी, जी.एस. हुड्डा, फरीदाबाद

ह०.........................
प्रशासक, हुड्डा, फरीदाबाद

अथवा

बसंत पब्लिक स्कू ल, दिल्ली

सूचना

दिनांक: 20 अगस्त, 20
चित्रकला का आयोजन
विद्यालय के  सभी छात्र-छात्राओं को सूचित किया जाता है कि 25 अगस्त को दोपहर 2:00 बजे से हमारे विद्यालय के  खेल मैदान में चित्रकला का आयोजन
किया जाएगा। विद्यालय के  सभी शिक्षकों एवं विद्यार्थियों से आग्रह है कि वह इस समारोह में अवश्य उपस्थित हो। जिससे यह प्रतियोगिता सफल हो सके ।
आज्ञा से

गिरीश सिंह राठौर

विद्यालय सचिव

"चमचमाते नगीनों से चमकते

सोने व डायमण्ड ज्वैलरी से दमकते


हर रेंज़ में कराते हैं उपलब्ध

द वेडिंग ज्वैलरी कलेक्शन।"
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15. 




"""'चंचल ज्वैलर्स"""'
हमारे यहाँ बहुत ही कम कीमत में गहने तैयार किये  जाते हैं |

शाखाएँ: दिल्ली, मुंबई, कोलकाता, अहमदाबाद

अथवा

सावधान ! सावधान ! सावधान ! सावधान !

पंजाब नेशनल बैंक, गोविन्दम् नगर


ए.टी.एम. कें द्रों पर जाने से पहले निम्नलिखित सावधानी बरतें

अपना पिन कोड किसी को न बताएँ 


किसी अनजान व्यक्ति की कभी सहायता न लें

अपना कार्ड  किसी को न दें


जाँच लें कि ए.टी.एम. कें द्र में कोई विद्युत यंत्र तो नहीं लगा है

जाँच लें कि कोई आपकी निगरानी तो नहीं कर रहा है


लेन-देन की प्रक्रिया पूरी करने के  बाद कैं सिल बटन को दबाना न भूलें

सावधान रहें, सुरक्षित रहें
सावधानी में ही सुरक्षा है 


पंजाब नेशनल बैंक द्वारा जनहित में जारी!

सावधान ! सावधान ! सावधान ! 

किसी विशेष परिस्थिति या संदेह होने पर निम्न मो. नं. पर संपर्क  करें-9885५२XXX

16. From: pawan@mycbseguide.com

To: 1912@pspcl.in

CC ...

BCC ...
विषय - बिजली का बिल ठीक करवाने हेतु

महोदय,

मेरे घर की जनवरी - फरवरी 2022 तक की बिजली की मीटर रीडिंग 8819 दिखाई गई है, जबकि आज के  दिन तक हमारा मीटर 7999 तक ही पहुँ चा है।
अतः इसका तो यही अर्थ  है कि बिजली की रीडिंग लेने के  संबंध में लापरवाही हुई है और बिना मीटर देखे ही किसी कर्मचारी ने अपने तरीके  से विद्युत बिल
संबंधी प्रपत्र तैयार कर दिया।
अतः आपसे अनुरोध है कि इस संबंध में शीघ्र ही उचित कार्यवाही की जाए तथा मेरा बिल जल्द-से-जल्द ठीक करके  सही बिल भेजा जाए, ताकि मैं उसे
समय से जमा करवा सकूँ ।
पवन

अथवा
एक छोटे गांव में राम और श्याम, दो मित्र, रहते थे। वे अनेक विषयों पर वार्ता करते थे, परंतु कभी-कभी उनकी बातें विरोधाभास में परिणत हो जाती थीं। एक
दिन, एक विषय पर उनकी बहस बढ़ गई - क्या संगति लोगों के  विचारों का प्रभाव डालती है या नहीं।

राम ने कहा, "संगति हमें बदलती दृष्टिकोण देती है और नई दिशा में ले जाती है।"

श्याम ने मुस्कराते हुए जवाब दिया, "हाँ, लेकिन इसका फल होता है कि बार-बार विभिन्नता और समृद्धि समझने की क्षमता विकसित होती है। विरोधाभास
हमें सोचने पर मजबूर करता है और सही निर्णय लेने में मदद करता है।"
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दोनों मित्र ने एक-दूसरे के  विचारों का सम्मान करते हुए देखा कि संगति से विभिन्न दृष्टिकोणों का संयोजन हमें सबके  लिए बेहतर विकल्पों की दिशा में अग्रसर
कर सकता है।
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निर्धारित समय: 3 घंटे अधिकतम अंक: 80


सामान्य निर्देश:

इस प्रश्नपत्र में चार खंड हैं - क, ख, ग और घ

खंड क में अपठित गदयांश से प्रश्न पूछे गए हैं, जिनके  उत्तर दिए गए निर्देशों का पालन करते हुए दीजिए।

खंड ख में व्यावहारिक व्याकरण से प्रश्न पूछे गए हैं, आंतरिक विकल्प भी दिए गए हैं।

खंड ग पाठ्यपुस्तक पर आधारित है, निर्देशानुसार उत्तर दीजिए।

खंड घ रचनात्मक लेखन पर आधारित है आंतरिक विकल्प भी दिए गए हैं।

प्रश्न पत्र में कु ल 16 प्रश्न हैं, सभी प्रश्न अनिवार्य है।

यथासंभव सभी खंडों के  प्रश्नों के  उत्तर क्रमशः लिखिए।

खंड क - अपठित बोध

1. निम्नलिखित गद्यांश को ध्यानपूर्वक पढ़कर पूछे गए प्रश्नों के  उत्तर लिखिए- 


विद्वानों का यह कथन बहुत ठीक है कि विनम्रता के  बिना स्वतंत्रता का कोई अर्थ नहीं। इस बात को सब लोग मानते हैं कि आत्मसंस्कार

के  लिए थोड़ी-बहुत मानसिक स्वतंत्रता परमावश्यक है-चाहे उस स्वतंत्रता में अभिमान और नम्रता दोनों का मेल हो और चाहे वह

नम्रता ही से उत्पन्न हो। यह बात तो निश्चित है कि जो मनुष्य मर्यादापूर्वक जीवन व्यतीत करना चाहता है, उसके  लिए वह गुण अनिवार्य

है, जिससे आत्मनिर्भरता आती है और जिससे अपने पैरों के  बल खड़ा होना आता है।


युवा को यह सदा स्मरण रखना चाहिए कि वह बहुत कम बातें जानता है, अपने ही आदर्श से वह बहुत नीचे है और उसकी आकांक्षाएँ

उसकी योग्यता से कहीं बढ़ी हुई हैं। उसे इस बात का ध्यान रखना चाहिए कि वह अपने बड़ों का सम्मान करे, छोटों और बराबर वालों

से कोमलता से व्यवहार करे, ये बातें आत्ममर्यादा के  लिए आवश्यक हैं। यह सारा संसार, जो कु छ हम हैं और जो कु छ हमारा है-हमारा

शरीर, हमारी आत्मा, हमारे भोग, हमारे घर और बाहर की दशा, हमारे बहुत-से अवगुण और थोड़े गुण-सब इसी बात की आवश्यकता

प्रकट करते हैं कि हमें अपनी आत्मा को नम्र रखना चाहिए।

नम्रता से मेरा अभिप्राय दब्बूपन से नहीं है, जिसके  कारण मनुष्य दूसरों का मुँह ताकता है, जिससे उसका संकल्प क्षीण और उसकी

प्रज्ञा मंद हो जाती है, जिसके  कारण वह आगे बढ़ने के  समय भी पीछे रहता है और अवसर पड़ने पर चट-पट किसी बात का निर्णय नहीं

कर सकता। मनुष्य का बेड़ा उसके  अपने ही हाथ में है, उसे वह चाहे जिधर ले जाए। सच्ची आत्मा वही है, जो प्रत्येक दशा में, प्रत्येक

स्थिति के  बीच अपनी राह आप निकालती है।


1. सच्ची आत्मा किसे कहा गया है? (1)


(क) जिसकी आकांक्षाएँ  उसकी योग्यता से कहीं बढ़ी हुई हैं।


(ख) जो मर्यादापूर्वक जीवन व्यतीत करना चाहता है।


(ग) जो प्रत्येक दशा में, प्रत्येक स्थिति के  बीच अपनी राह आप निकालती है।


(घ) जिससे संकल्प क्षीण और प्रज्ञा मंद हो जाती है।

2. कथन (A) और कारण (R) को पढ़कर उपयुक्त विकल्प चुनिए:

कथन (A): नम्रता के  बिना स्वतंत्रता का कोई अर्थ नहीं है।


कारण (R): आत्मसंस्कार के  लिए मानसिक स्वतंत्रता जरूरी है, जो नम्रता से उत्पन्न होती है।

विकल्प:

[7]
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(क) कथन (A) गलत है, किंतु कारण (R) सही है।


(ख) कथन (A) और कारण (R) दोनों ही गलत हैं।


(ग) कथन (A) सही है और कारण (R) कथन (A) की सही व्याख्या है।


(घ) कथन (A) सही है किंतु कारण (R) कथन (A) की सही व्याख्या नहीं है।

3. नम्रता, अनिवार्य का विलोम लिखिए। (1)


(क) नम्रता - विनम्रता , अनिवार्य - ऐच्छिक


(ख) नम्रता - उदंडता, अनिवार्य - आवश्यक


(ग) नम्रता - झुकना, अनिवार्य - ज़रूरी


(घ) नम्रता - आनंद, अनिवार्य - बहुमूल्य

4. 'विनम्रता के  बिना स्वतंत्रता का कोई अर्थ नहीं।' इस कथन का आशय स्पष्ट कीजिए। (2)

5. मर्यादापूर्वक जीने के  लिए किन गुणों का होना अनिवार्य है और क्यों? (2)

2. निम्नलिखित गद्यांश को ध्यानपूर्वक पढ़कर पूछे गए प्रश्नों के  उत्तर लिखिए- 


प्रजातंत्र के  तीन मुख्य अंग हैं-कार्यपालिका, विधायिका और न्यायपालिका। प्रजातंत्र की सार्थकता एवं दृढ़ता को ध्यान में रखते हुए

और जनता के  प्रहरी होने की भूमिका को देखते हुए मीडिया (दृश्य, श्रव्य और मुद्रित) को प्रजातंत्र के  चौथे स्तंभ के  रूप में देखा जाता

है। समाचार-माध्यम या मीडिया को पिछले वर्षों में पत्रकारों और समाचार-पत्रों ने एक विश्वसनीयता प्रदान की है और इसी कारण विश्व

में मीडिया एक अलग शक्ति के  रूप में उभरा है।


कार्यपालिका और विधायिका की समस्याओं, कार्य-प्रणाली और विसंगतियों की चर्चा प्राय: होती रहती है और सर्वसाधारण में वे विशेष

चर्चा के  विषय रहते ही हैं। इसमें समाचार-पत्र, रेडियो और टी०वी० समाचार अपनी टिप्पणी के  कारण चर्चा को आगे बढ़ाने में योगदान

करते हैं, पर न्यायपालिका अत्यंत महत्वपूर्ण होने के  बावजूद उसके  बारे में चर्चा कम ही होती है। ऐसा के वल अपने देश में ही नहीं, अन्य

देशों में भी कमोबेश यही स्थिति है।

स्वराज-प्राप्ति के  बाद और एक लिखित संविधान के  देश में लागू होने के  उपरांत लोकतंत्र के  तीनों अंगों के  कर्तव्यों, अधिकारों और

दायित्वों के  बारे में जनता में जागरूकता बढ़ी है। संविधान-निर्माताओं का उद्देश्य रहा है कि तीनो अंग परस्पर ताल-मेल से कार्य करेंगे।

तीनों के  पारस्परिक संबंध भी संविधान द्वारा निर्धारित, फिर भी समय के  साथ-साथ कु छ समस्याएँ  उठ खड़ी होती हैं। आज लोकतंत्र

यह महसूस करता है कि न्यायपालिका में भी अधिक पारदर्शिता हो, जिससे उसकी प्रतिष्ठा और सम्मान बढ़े।


'जिस देश में पंचों को परमेश्वर मानने की परंपरा, वहाँ न्यायमूर्तियों पर आक्षेप दुर्भाग्यपूर्ण है।'

1. लोकतंत्र का चौथा अंग किसे माना जाता है? (1)


(क) मीडिया


(ख) कार्यपालिका


(ग) विधायिका


(घ) न्यायपालिका

2. कथन (A) और कारण (R) को पढ़कर उपयुक्त विकल्प चुनिए:

कथन (A): मीडिया को प्रजातंत्र के  चौथे स्तंभ के  रूप में देखा जाता है, क्योंकि यह सरकार की कार्यप्रणाली और समाज की

समस्याओं पर प्रकाश डालता है।

कारण (R): न्यायपालिका के  बारे में चर्चा कम होने के  कारण, न्यायपालिका में अधिक पारदर्शिता की आवश्यकता महसूस की

जाती है।

विकल्प:

(क) कथन (A) गलत है, किंतु कारण (R) सही है।


(ख) कथन (A) और कारण (R) दोनों ही गलत हैं।


(ग) कथन (A) सही है और कारण (R) कथन (A) की सही व्याख्या है।


(घ) कथन (A) सही है किंतु कारण (R) कथन (A) की सही व्याख्या नहीं है।

3. मीडिया के  कोई दो उदाहरण दीजिए। (1)


(क) रेडियो और टेलिस्कोप 


[7]
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खंड ख - व्यावहारिक व्याकरण

खंड ग - गद्य खंड (पाठ्यपुस्तक)

(ख) समाचार-पत्र और रेडियो


(ग) टेलीविज़न और पुस्तक 


(घ) धार्मिक ग्रंथ

4. लोकतंत्र में मीडिया की भूमिका स्पष्ट कीजिए। (2)

5. अत्यंत महत्वपूर्ण अंग होने के  बावजूद न्यायपालिका के  बारे में मीडिया में कम चर्चा क्यों होती है? (2)

3. निम्नलिखित वाक्यों में से किन्हीं चार प्रश्नों के  उत्तर दीजिए।

i. महँगी खरीदी हुई शॉल फट गई है। रेखांकित पदबंध का नाम लिखिए।

ii. अब दरवाजा खोला जा सकता है। क्रिया पदबंध को पहचान कर लिखिए।

iii. सामने की दुकान पर चाय पीने वाला लड़का अपने घर चला गया। रेखांकित पदबंध का नाम लिखिए।

iv. चोट खाए हुए तुम भला क्या खेलोगे? इस वाक्य में सर्वनाम पदबंध कौन सा है?

v. दशरथ पुत्र राम ने रावण को मार गिराया। संज्ञा पदबंध की पहचान कीजिए ।

[4]

4. नीचे लिखें वाक्यों में से किन्हीं चार वाक्यों का निर्देशानुसार रचना के  आधार पर वाक्य रूपांतरण कीजिए-

i. रात होते ही आकाश में तारों का मेला लग गया। (मिश्र वाक्य)

ii. वह मुंबई गया। उसने वहाँ नया व्यापार शुरू किया। (संयुक्त वाक्य)

iii. नीरजा ने कहानी सुनाई। नमिता रो पड़ी (सरल वाक्य)

iv. उसके  पिता जी की इच्छा थी। उनका बेटा वकील बने। (मिश्र वाक्य)

v. वामीरो से मिलने के  बाद तताँरा के  जीवन में परिवर्तन आया। (मिश्र वाक्य में)

[4]

5. 'समास' पर आधारित पाँच प्रश्नों में से किन्हीं चार प्रश्नों के  उत्तर लिखिए - [4]

i. द्वंद्व समास में दोनों पदों की भूमिका को स्पष्ट कीजिए। [1]

ii. 'अव्ययीभाव समास' के  उदाहरण देकर पूर्व पद और उत्तर पद की भूमिका बताइए। [1]

iii. 'तत्पुरुष समास' के  भेदों को उदाहरण सहित समझाइए। [1]

iv. 'विद्युत्मान' शब्द का समास विग्रह करते हुए भेद लिखिए। [1]

v. 'अव्ययीभाव समास' की विशेषता बताते हुए एक उदाहरण दीजिए। [1]

6. 'मुहावरे' पर आधारित पाँच प्रश्नों में से किन्हीं चार प्रश्नों के  उत्तर लिखिए - [4]

i. Fill in the blanks:

सरकार द्वारा अनेक योजनाएँ  चलाने के  बाद भी गरीबों की स्थिति ________ । (उपयुक्त मुहावरे द्वारा रिक्त स्थान की पूर्ति

कीजिए।)

[1]

ii. Fill in the blanks:

पुलिस की पहरेदारी के  बाद भी चोर ________। (उपयुक्त मुहावरे द्वारा रिक्त स्थान की पूर्ति कीजिए।)

[1]

iii. 'नौ दो ग्यारह होना' और 'पांचों उंगलियां घी में होना' में अंतर समझाइए। [1]

iv. 'बाल की खाल निकालना' मुहावरे का वाक्य बनाइए। [1]

v. "उसके  व्याख्यान में गागर में सागर भरने की कला है।" इस वाक्य का मुहावरा पहचानकर प्रयोग करें। [1]

7. अनुच्छेद को ध्यानपूर्वक पढ़कर निम्नलिखित प्रश्नों के  उत्तर दीजिये:

ग्वालियर से बंबई की दूरी ने संसार को काफ़ी कु छ बदल दिया है। वर्सेवा में जहाँ आज मेरा घर है, पहले यहाँ दूर तक जंगल था। पेड़ थे,

परिंदे थे और दूसरे जानवर थे। अब यहाँ समंदर के  किनारे लंबी-चौड़ी बस्ती बन गई है। इस बस्ती ने न जाने कितने परिंदों-चरिंदों से

उनका घर छीन लिया है। इनमें से कु छ शहर छोड़कर चले गए हैं। जो नहीं जा सके  हैं उन्होंने यहाँ-वहाँ डेरा डाल लिया है। इनमें से दो

कबूतरों ने मेरे फ्लै ट के  एक मचान में घोंसला बना लिया है। बच्चे अभी छोटे हैं। उनके  खिलाने-पिलाने की ज़िम्मेदारी अभी बड़े कबूतरों

की है। वे दिन में कई-कई बार आते-जाते हैं। और क्यों न आएँ -जाएँ  आखिर उनका भी घर है। लेकिन उनके  आने-जाने से हमें परेशानी

भी होती है। वे कभी किसी चीज़ को गिराकर तोड़ देते हैं। कभी मेरी लाइब्रेरी में घुसकर कबीर या मिर्जा गालिब को सताने लगते हैं। इस

[5]
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खंड ग - काव्य खंड (पाठ्यपुस्तक)

रोज़-रोज़ की परेशानी से तंग आकर मेरी पत्नी ने उस जगह जहाँ उनका आशियाना था, एक जाली लगा दी है, उनके  बच्चों को दूसरी

जगह कर दिया है। उनके  आने की खिड़की को भी बंद किया जाने लगा है। खिड़की के  बाहर अब दोनों कबूतर रात-भर खामोश और

उदास बैठे रहते हैं। मगर अब न सोलोमेन है जो उनकी जुबान को समझकर उनका दुख बाँटे, न मेरी माँ है, जो इनके  दुखों में सारी रात

नमाज़ों में काटे।

क) उनकी उदासी को समझने वाला कोई नहीं है ख) उनकी जुबान को समझ इनका दुख बांटने वाला

कोई नहीं है

ग) वह बोल नहीं सकते घ) उनके  रहने की जगह छीन ली गई है

i. दोनों कबूतर आपके  घर के  बाहर खामोश और उदास क्यों बैठे रहते हैं?

क) लेखक की पत्नी को ख) लेखक को

ग) उनकी खुद की जिम्मेदारी है घ) बड़े कबूतरों को

ii. छोटे कबूतरों को खाना खिलाने की जिम्मेदारी किसकी है?

क) कथन (A) तथा कारण (R) दोनों सही हैं तथा

कारण (R) कथन (A) की सही व्याख्या करता

है।

ख) कथन (A) गलत है लेकिन कारण (R) सही है।

ग) कथन (A) तथा कारण (R) दोनों गलत है। घ) कथन (A) सही है लेकिन कारण (R) उसकी

गलत व्याख्या करता है।

iii. निम्नलिखित कथन (A) तथा कारण (R) को ध्यानपूर्वक पढ़िए। उसके  बाद दिए गए विकल्पों में से कोई एक सही विकल्प चुनकर

लिखिए।

कथन (A): अब यहाँ समंदर के  किनारे लंबी-चौड़ी बस्ती बन गई है। इस बस्ती ने न जाने कितने परिंदों-चरिंदों से उनका घर छीन

लिया है।


कारण (R): इनमें से कु छ शहर छोड़कर चले गए हैं। जो नहीं जा सके  हैं उन्होंने यहाँ-वहाँ डेरा डाल लिया है।

क) लेखक के  परिवार को बहुत परेशान करते थे ख) वे अपना दुख किसी से कह नहीं सकते

ग) उनके  रहने की जगह सही नहीं थी घ) अब उनके  दुख को समझने वाला कोई नहीं है

iv. कबूतरों को उनके  बच्चों से क्यों अलग कर दिया गया?

क) जंगल ख) कार्यालय

ग) बाजार घ) कारखाने

v. लेखक का घर अभी जहाँ है, वहाँ पहले क्या था?

8. निम्नलिखित प्रश्नों में से किन्हीं तीन प्रश्नों के  उत्तर लगभग 25-30 शब्दों में दीजिए: [6]

i. 'बड़े भाई साहब' कहानी में बड़े भाई द्वारा घमंड को एक बुराई के  रूप में दिखाया गया है। घमंड का विरोध करने के  लिए बड़े

भाई द्वारा कौन-कौन से उदाहरण दिए गए हैं ?

[2]

ii. तताँरा-वामीरो कथा के  अनुसार गाँव वाले तताँरा के  सदाचारी व्यक्तित्व से परिचित और प्रभावित थे फिर भी वामीरो के

मामले में उन्होंने उसका साथ क्यों नहीं दिया?

[2]

iii. वज़ीर अली के  मन में अंग्रेज़ो के  प्रति नफ़रत क्यों थी? कारतूस पाठ के  आधार पर बताइए। [2]

iv. तीसरी कसम फिल्म को सैल्यूलाइड पर लिखी कविता क्यों कहा गया है? [2]

9. अनुच्छेद को ध्यानपूर्वक पढ़कर निम्नलिखित प्रश्नों के  उत्तर दीजिये:

राह कु र्बानियों की न वीरान हो


तुम सजाते ही रहना नए काफ़िले


फ़तह का जश्न इस जश्न के  बाद है


[5]
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खंड ग - संचयन (पूरक पाठ्यपुस्तक)

खंड घ - रचनात्मक लेखन

ज़िंदगी मौत से मिल रही है गले

बाँध लो अपने सर से कफ़न साथियो

अब तुम्हारे हवाले वतन साथियों

क) सैनिक सोच-समझकर आगे बढ़ें। ख) बलिदानी सैनिक आगे बढ़ने की सोच में रहे।

ग) सैनिक देश के  बारे में सोचते रहें। घ) बलिदानी सैनिकों की परंपरा बनी रहे।

i. राह कु र्बानियों की न वीरान हो - से क्या तात्पर्य है?

क) जश्न मनाने वालों को ख) भारतमाता को

ग) बलिदानी सैनिकों के  काफिलों को घ) देश की कु र्बानियों को

ii. सैनिक किसे सजाने के  लिए कह रहे हैं?

क) देश पर बलिदान होने की ओर ख) सिर बचाने की ओर

ग) सिर पर मुकु ट बाँधने की ओर घ) जीवित रहने की ओर

iii. सर पर कफ़न बाँधने के  माध्यम से किस ओर संके त किया गया है?

क) बलिदान की खुशी ख) आगे बढ़ने की खुशी

ग) मृत्यु की खुशी घ) जीत की खुशी

iv. फ़तह का जश्न से क्या तात्पर्य है?

क) सेवकों के  लिए  ख) देश पर मर मिटने वालों के  लिए 

ग) युवाओं के  लिए  घ) तीर्थ यात्रियों के  लिए 

v. काव्यांश में प्रयुक्त 'काफ़िले' शब्द का प्रयोग किसके  लिए हुआ है ?

10. निम्नलिखित प्रश्नों में से किन्हीं तीन प्रश्नों के  उत्तर लगभग 25-30 शब्दों में दीजिए: [6]

i. मीराबाई रचित द्वितीय पद के  अनुसार अपने आराध्य को पाने के  लिए मीरा क्या-क्या करना चाहती हैं और क्यों? [2]

ii. पर्वतीय प्रदेश में पावस कविता में झरनों का वर्णन किस रूप में हुआ है? अपने शब्दों में लिखिए। [2]

iii. मनुष्यता कविता में कवि ने कै से जीवन को व्यर्थ बताया है, और क्यों? [2]

iv. तोप कविता के  आलोक में विरासत में मिली चीज़ों के  महत्त्व पर अपना दृष्टिकोण लिखिए। [2]

11. निम्नलिखित प्रश्नों में से किन्हीं दो प्रश्नों के  उत्तर लगभग 50-60 शब्दों में दीजिए: [6]

i. महंत द्वारा हरिहर काका का अपहरण, उसके  चरित्र की किस सच्चाई को सामने लाता है? इससे ठाकु रबाड़ी जैसी संस्थाओं

के  प्रति आपके  मन में कै सी धारणा बनती है? इस विषय में अपने विचार लिखिए।

[3]

ii. सपनों के -से दिन पाठ के  अभिभावकों की तरह आजकल के  कु छ अभिभावक अपने बच्चों को खेलकू द में रुचि लेने से रोकते

हैं, और समय बरबाद न करने की सलाह देते हैं। क्या बच्चे के  सर्वांगीण विकास के  लिए यह सही है? तर्क  सहित अपने विचार

लिखिए।

[3]

iii. आपका घनिष्ठ मित्र दूसरे मज़हब का है, आपके  घर पर उसका आदर-सत्कार किस प्रकार होता है? टोपी शुक्ला पाठ के  संदर्भ

में विस्तार से उत्तर दीजिए।

[3]

12. निम्नलिखित में से किसी एक विषय पर लगभग 120 शब्दों में अनुच्छेद लिखिये: [5]

i. जल ही जीवन है विषय पर दिए गए संके त बिंदुओं के  आधार पर अनुच्छेद लिखिए।

जल का महत्त्व

संरक्षण

जल-चेतना

[5]
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ii. परहित सरिस धर्म नहि भाई विषय पर दिए गए संके त बिंदुओं के  आधार पर अनुच्छेद लिखिए।


संके त बिंदु-

अर्थ

जीवन की सार्थकता

आनंद का स्रोत

[5]

iii. वही मनुष्य है कि जो मनुष्य के  लिए मरे विषय पर लगभग 80 से 100 शब्दो में अनुच्छेद लिखिए। [5]

13. नगर निगम को एक पत्र लिखिए जिसमें नालियों की सफ़ाई एवं कीटनाशक दवाओं के  छिड़काव का सुझाव हो। [5]

अथवा

अपने विद्यालय के  प्रधानाचार्य को शुल्क-मुक्ति (फीस माफ) करने हेतु प्रार्थना-पत्र लिखिए।

14. आप सोसाइटी के  अध्यक्ष हैं। सोसाइटी को स्वस्छ रखने हेतु सूचनापट्ट पर 25-30 शब्दों में सूचना लिखिए। [4]

अथवा

सागर अपार्टमेन्ट के  सचिव की ओर से अपार्टमेन्ट में रहने वाले लोगों को जल की बर्बादी रोकने हेतु 50 शब्दों में एक सूचना लिखिए।

15. सैल फ़ोन विक्रे ता हेतु एक विज्ञापन लगभग 25-50 शब्दों में बनाइए। [3]

अथवा

किसी दैनिक समाचार-पत्र में प्रकाशित करने के  लिए विज्ञापन का प्रारूप लगभग 40 शब्दों में तैयार कीजिए जिसमें आपके  पिताजी द्वारा

बेची जाने वाली कार की विस्तृत जानकारी दी गई हो।

16. विद्यालय से दो दिन के  अवकाश हेतु प्रधानाचार्य abcschool@gmail.com को एक ईमेल लिखिए क्योंकि आपको बुखार आ गया है। [5]

अथवा

सफलता की सीढ़ी-परिश्रम विषय पर एक लघुकथा लिखिए।
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खंड क - अपठित बोध

1. 1. (ग) जो प्रत्येक दशा में, प्रत्येक स्थिति के  बीच अपनी राह आप निकालती है।
2. (ग) कथन (A) सही है और कारण (R) कथन (A) की सही व्याख्या है।
3. (ख) नम्रता - उदंडता, अनिवार्य  - ऐच्छिक
4. किसी भी व्यक्ति में स्वतंत्रता का भाव आते ही उसके  मन में अहंकार आ जाता है। इस अहंकार के  कारण वह अपनी मनुष्यता खो बैठता है। इससे व्यक्ति

के  आचरण में इतना बदलाव आ जाता है कि वह दूसरों को खुद से हीन समझने लगता है। ऐसे में स्वतंत्रता के  साथ विनम्रता का होना आवश्यक है,
अन्यथा स्वतंत्रता अर्थहीन हो जाएगी।

5. मर्यादापूर्वक जीवन जीने के  लिए मानसिक स्वतंत्रता आवश्यक है। इस स्वतंत्रता के  साथ नम्रता का मेल होना आवश्यक है। इससे व्यक्ति में
आत्मनिर्भरता आती है। आत्मनिर्भरता के  कारण वह परमुखापेक्षी नहीं रहता। उसे अपने पैरों पर खड़ा होने की कला आ जाती है।

1. 2. (क) लोकतंत्र के  तीन मुख्य अंग हैं-कार्यपालिका, विधायिका और न्यायपालिका। चौथा अंग मीडिया को माना जाता है। इसमें दृश्य, श्रव्य व मुद्रित
मीडिया होते हैं।

2. (ग) कथन (A) सही है और कारण (R) कथन (A) की सही व्याख्या है।
3. (ख) समाचार-पत्र, रेडियो और टी०वी०
4. लोकतंत्र में मीडिया की अहं भूमिका है। यह कार्यपालिका व विधायिका की समस्याओं, कार्य-प्रणाली तथा विसंगतियों की चर्चा करती है, पर

न्यायपालिका पर किसी प्रकार की टिप्पणी करने से बचती है।
5. न्यायपालिका प्रजातंत्र का अत्यंत महत्वपूर्ण  अंग है, परंतु इसकी चर्चा मीडिया में कम होती है, क्योंकि उसमें पारदर्शिता अधिक होती है। दूसरे,

न्यायपालिका अपने विशेषाधिकारों के  प्रयोग से मीडिया को दबा देती है।

खंड ख - व्यावहारिक व्याकरण

i. 3. विशेषण पदबंध
ii. खोला जा सकता है।
iii. विशेषण पदबंध
iv. सर्वनाम पदबंध
v. दशरथ पुत्र राम

i. 4. जैसे ही रात हुई वैसे ही आकाश में तारों का मेला लग गया।
ii. वह मुंबई गया और उसने वहाँ नया व्यापार शुरू किया।
iii. नीरजा की कहानी सुनकर नमिता रो पड़ी।
iv. उसके  पिता जी की इच्छा थी कि उनका बेटा वकील बने।
v. जब तताँरा वामीरो से मिला तब उसके  जीवन में परिवर्तन आया।

5. 'समास' पर आधारित पाँच प्रश्नों में से किन्हीं चार प्रश्नों के  उत्तर लिखिए -

6. 'मुहावरे' पर आधारित पाँच प्रश्नों में से किन्हीं चार प्रश्नों के  उत्तर लिखिए -

द्वंद्व समास में दोनों पद एक-दूसरे के  समान होते हैं और दोनों मिलकर एक संयुक्त अर्थ  उत्पन्न करते हैं। उदाहरण - "पुस्तकालय" (पुस्तक +
पुस्तकालय) में दोनों शब्द समान रूप से जुड़े हुए हैं।

(i)

अव्ययीभाव समास में पूर्व  पद एक अव्यय होता है जो मुख्य रूप से किसी क्रिया, संज्ञा या विशेषण के  साथ जुड़ा होता है।

उदाहरण: "यथाशक्ति" (शक्ति के  अनुसार) में "यथा" (पूर्व  पद) अव्यय है और "शक्ति" (उत्तर पद) एक संज्ञा है।

(ii)

भेद:
निष्ठा भेद: जिसमें एक शब्द विशेषण हो।
साधक भेद: जिसमें एक शब्द क्रिया हो।

उदाहरण:
"द्वारपाल" (द्वार + पाल) - द्वार की रक्षा करने वाला।
"ज्ञानवर्धन" (ज्ञान + वर्धन) - ज्ञान को बढ़ाने वाला।

(iii)

विग्रह: विद्युत + मान

भेद: यह तत्पुरुष समास है, जिसमें "विद्युत" (बिजली) और "मान" (मानक या रूप) मिलकर "विद्युत्मान" (बिजली से संबंधित) का अर्थ  बनाते हैं।

(iv)

विशेषता: अव्ययीभाव समास में पहला पद अव्यय (बिना रूप बदलने वाला) होता है और दूसरा पद संज्ञा या विशेषण होता है।

उदाहरण: "यथाशक्ति" (शक्ति के  अनुसार) में "यथा" (अव्यय) और "शक्ति" (संज्ञा) मिलकर नया अर्थ  उत्पन्न करते हैं।

(v)

ज्यों की त्यों बनी हुई है(i)
रफू चक्कर हो गया(ii)
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खंड ग - गद्य खंड (पाठ्यपुस्तक)
7. अनुच्छेद को ध्यानपूर्वक पढ़कर निम्नलिखित प्रश्नों के  उत्तर दीजिये:

ग्वालियर से बंबई की दूरी ने संसार को काफ़ी कु छ बदल दिया है। वर्सेवा में जहाँ आज मेरा घर है, पहले यहाँ दूर तक जंगल था। पेड़ थे, परिंदे थे और दूसरे
जानवर थे। अब यहाँ समंदर के  किनारे लंबी-चौड़ी बस्ती बन गई है। इस बस्ती ने न जाने कितने परिंदों-चरिंदों से उनका घर छीन लिया है। इनमें से कु छ
शहर छोड़कर चले गए हैं। जो नहीं जा सके  हैं उन्होंने यहाँ-वहाँ डेरा डाल लिया है। इनमें से दो कबूतरों ने मेरे फ्लै ट के  एक मचान में घोंसला बना लिया है। बच्चे
अभी छोटे हैं। उनके  खिलाने-पिलाने की ज़िम्मेदारी अभी बड़े कबूतरों की है। वे दिन में कई-कई बार आते-जाते हैं। और क्यों न आएँ-जाएँ  आखिर उनका भी
घर है। लेकिन उनके  आने-जाने से हमें परेशानी भी होती है। वे कभी किसी चीज़ को गिराकर तोड़ देते हैं। कभी मेरी लाइब्रेरी में घुसकर कबीर या मिर्जा
गालिब को सताने लगते हैं। इस रोज़-रोज़ की परेशानी से तंग आकर मेरी पत्नी ने उस जगह जहाँ उनका आशियाना था, एक जाली लगा दी है, उनके  बच्चों
को दूसरी जगह कर दिया है। उनके  आने की खिड़की को भी बंद किया जाने लगा है। खिड़की के  बाहर अब दोनों कबूतर रात-भर खामोश और उदास बैठे
रहते हैं। मगर अब न सोलोमेन है जो उनकी जुबान को समझकर उनका दु ख बाँटे, न मेरी माँ है, जो इनके  दु खों में सारी रात नमाज़ों में काटे।

8. निम्नलिखित प्रश्नों में से किन्हीं तीन प्रश्नों के  उत्तर लगभग 25-30 शब्दों में दीजिए:

खंड ग - काव्य खंड (पाठ्यपुस्तक)
9. अनुच्छेद को ध्यानपूर्वक पढ़कर निम्नलिखित प्रश्नों के  उत्तर दीजिये:

राह कु र्बानियों की न वीरान हो

तुम सजाते ही रहना नए काफ़िले

फ़तह का जश्न इस जश्न के  बाद है

ज़िंदगी मौत से मिल रही है गले


नौ दो ग्यारह होना: अचानक भाग जाना।

पांचों उंगलियां घी में होना: हर तरह से सुखी होना।

(iii)

वह हर छोटी-छोटी बात पर बाल की खाल निकालने लगता है।(iv)
मुहावरा: गागर में सागर भरना।

वाक्य: इस किताब में लेखक ने अपने विचारों को गागर में सागर भरने जैसी शैली में प्रस्तुत किया है।

(v)

(ख)
उनकी जुबान को समझ इनका दु ख बांटने वाला कोई नहीं है


व्याख्या:
उनकी जुबान को समझ इनका दु ख बांटने वाला कोई नहीं है

(i)

(घ)
बड़े कबूतरों को


व्याख्या:
बड़े कबूतरों को

(ii)

(घ)
कथन (A) सही है लेकिन कारण (R) उसकी गलत व्याख्या करता है।


व्याख्या:
कथन (A) सही है लेकिन कारण (R) उसकी गलत व्याख्या करता है।

(iii)

(क)
लेखक के  परिवार को बहुत परेशान करते थे


व्याख्या:
लेखक के  परिवार को बहुत परेशान करते थे

(iv)

(क)
जंगल


व्याख्या:
जंगल

(v)

कहानी में बड़े भाई ने घमंड को इंसान की एक कमजोरी बताया है।अपनी बात को साबित करने के  लिए उन्होंने रावण और शैतान के  उदाहरण
दिए हैं। रावण अंग्रेज़ों से भी बड़ा राजा था, किंतु घमंड के  कारण उसका अंत हो गया। शैतान को घमंड के  कारण नरक भोगना पड़ा। शाहेरूम को
भीख माँगनी पड़ी और भीख माँगते-माँगते ही वह मर गया। यदि कोई व्यक्ति अपने किसी गुण पर घमंड करेगा, तो उसका हाल भी इन तीनों जैसा
ही होगा |

(i)

तताँरा एक भला और सबकी मदद करने वाला व्यक्ति था। वह हमेशा दूसरों की सहायता के  लिए तैयार रहता था। लेकिन जब लोगों को तताँरा
और वामीरों के  प्रेम का पता चला, तो गाँव के  लोग भी उसके  विरुद्ध हो गए। दोनों अलग-अलग गाँव से थे और उस समय के  रीति-रिवाज़ों के
अनुसार अलग-अलग गाँव के  निवासियों के  बीच विवाह संभव नहीं था। इस कारण उन्होंने वामीरों के  मामले में साथ नहीं दिया।

(ii)

वजीर अली के  दिल में अंग्रेजों के  प्रति नफरत थी क्योंकि वह एक सच्चा देशभक्त था और वो नहीं चाहता था कि अंग्रेज हिंदु स्तान पर शासन करें।
इसी कारण से वो अपने शासन में अपने क्षेत्र में अंग्रेजों का प्रभाव नहीं पड़ने दिया और साथ उनके  अत्याचारों के  प्रति भी आवाज उठाई।

(iii)

सैल्यूलाइड का अर्थ  है-फिल्म को कै मरे की रील में उतारकर चित्र प्रस्तुत करना। ‘तीसरी कसम’ फिल्म को सैल्यूलाइड पर लिखी कविता कहने
के  पीछे  कारण यह था कि यह फिल्म अपने में सघन, सूक्ष्म और और गहरी भावनाओं को संजोए थी।' तीसरी कसम 'आम मसाला फिल्मों से
हटकर है। इसमें गाँव के  जीवन का बड़ा ही सटीक चित्रण हुआ है। यह एक फिल्म की तरह अनुभूति न कराकर एक कविता के  समान अनुभूति
कराती थी। मानो कि सैल्यूलाइड की फिल्म पर कविता उतार दी गयी हो। इस फिल्म को देखने वाले दर्शक को इस फिल्म को देखने पर एक
कविता के  मधुर प्रवाह जैसा अनुभव होता है। इन्हीं सब कारणों की वजह से इस फिल्म को सैल्यूलाइड पर लिखी कविता कहा गया।

(iv)
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बाँध लो अपने सर से कफ़न साथियो

अब तुम्हारे हवाले वतन साथियों

10. निम्नलिखित प्रश्नों में से किन्हीं तीन प्रश्नों के  उत्तर लगभग 25-30 शब्दों में दीजिए:

खंड ग - संचयन (पूरक पाठ्यपुस्तक)
11. निम्नलिखित प्रश्नों में से किन्हीं दो प्रश्नों के  उत्तर लगभग 50-60 शब्दों में दीजिए:

खंड घ - रचनात्मक लेखन
12. निम्नलिखित में से किसी एक विषय पर लगभग 120 शब्दों में अनुच्छेद लिखिये:

(घ)
बलिदानी सैनिकों की परंपरा बनी रहे।


व्याख्या:
बलिदानी सैनिकों की परंपरा बनी रहे।

(i)

(ग)
बलिदानी सैनिकों के  काफिलों को


व्याख्या:
बलिदानी सैनिकों के  काफिलों को

(ii)

(क)
देश पर बलिदान होने की ओर


व्याख्या:
देश पर बलिदान होने की ओर

(iii)

(घ)
जीत की खुशी


व्याख्या:
जीत की खुशी

(iv)

(ख)
देश पर मर मिटने वालों के  लिए 


व्याख्या:
देश पर मर मिटने वालों के  लिए

(v)

कवयित्री मीरा अपने प्रभु की भक्ति में डू बकर उनका सामीप्य और दर्शन पाना चाहती हैं। इसके  लिए वे चाहती हैं कि श्रीकृ ष्ण उन्हें अपनी चाकरी
में रख लें। मीरा बाग लगाना चाहती हैं ताकि श्रीकृ ष्ण वहाँ घूमने आएँ  और उन्हें दर्शन मिल सके । वे श्रीकृ ष्ण का गुणगान ब्रज की गलियों में करती
हुई घूमना-फिरना चाहती हैं। मीरा विशाल भवन में भी बगीचा बनाना चाहती हैं ताकि उस बगीचे में घूमते श्रीकृ ष्ण के  दर्शन कर सके । वे श्रीकृ ष्ण
का सामीप्य पाने के  लिए कु सुम्बी रंग की साड़ी पहनती हैं और अपने प्रभु से प्रार्थना करती हैं कि वे आधी रात में जमुना के  किनारे मिलने की कृ पा
करें क्योंकि इस मिलन के  लिए उनका मन बेचैन हो रहा है।

(i)

इस कविता में कवि सुमित्रानंदन पंत जी ने पर्वतीय इलाके  में वर्षा ऋतु का सजीव चित्रण किया है। पर्वतीय प्रदेश में वर्षा ऋतु होने से वहाँ प्रकृ ति में
पल-पल बदलाव हो रहे हैं। पर्वतों की ऊँ ची चोटियों से सर-सर करते बहते झरने देखकर ऐसा प्रतीत होता है, मानों झरने पर्वत के  गौरव का
गुणगान करते हुए झर-झर बह रहे हैं। इन झरनों की करतल ध्वनि कवि के  नस-नस में उत्साह का संचार करती है। पर्वतों पर बहने वाले झाग भरे
झरने कवि को मोती की लड़ियों के  समान लग रहे हैं जिससे पर्वत की सुंदरता में और निखार आ रहा है।

(ii)

कवि ने व्यर्थ  उस जीवन को बताया है जो मनुष्य दूसरों के  लिए कु छ नहीं करता। स्वार्थी और स्वयं के  हित में ही रहने वाले लोग दूसरों की चिंता
नहीं करते और पशु समान प्रवृतियों को दिखाते हैं। उन्हें सिर्फ  अपना फायदा-नुकसान दिखता है और उन्हें किसी और की चिंता नहीं होती। इस
प्रकार के  व्यक्ति के  जीवन को कवि ने व्यर्थ  बताया है।

(iii)

विरासत में मिली चीजों का बहुत बड़ा महत्व इसलिए होता है, क्योंकि वे हमें अपने पूर्वजों से प्राप्त होती हैं। विरासत में मिली इन चीजों में हम अपने
पूर्वजों की उपस्थिति को महसूस कर सकते हैं। इन चीजों का अपना महत्त्व और इतिहास होता है। उदाहरण के  लिए 1857 की तोप जो कम्पनी
बाग के  प्रवेश द्वार पर स्थित है वह हमें अंगे् रजों द्वारा सौंपी गई थी, जिसकी सँभाल भी की जाती है। इनसे हमें प्राचीन सभ्यता और संस्ड्डति के
वारे में पता चलता है। साथ ही भविष्य के  प्रति सावधान रहने की प्रेरणा मिलती है।

(iv)

महंत का चरित्र उत्तम नहीं था। वह नाम मात्र का ही महंत था। अंदर से वह ढोंगी और धन का लालची था। उसकी नज़र हरिहर काका की ज़मीन
पर थी। उनके  घर की आपसी कलह का वह लाभ उठाना चाहता था। जब हरिहर काका ने ज़मीन ठाकु रबाड़ी के  नाम लिखने से मना कर दिया तो
वह उनका अपहरण करवा लेता है। यह घटना महंत के  चारित्रिक पतन की ओर संके त करती है। ठाकु रबाड़ी जैसी संस्थाओं में इस तरह की
घटना होना धार्मिक उन्माद फै लाना है। महंत जैसे लोभी और ढोंगी आज ठाकु रबाड़ी जैसी संस्थाओं का नेतृत्व कर रहे हैं। इस प्रकार की संस्था
का उद्देश्य समाज में के वल अंधविश्वास और पाखंड फै लाना है।

(i)

पाठ के  अभिभावकों की तरह आजकल के  कु छ अभिभावक अपने बच्चों को खेलकू द में रूचि लेने से रोकते हैं। उन्हें लगता है कि खेलने-कू दने से
समय बर्बाद होता है इसलिए वे अपने बच्चों को के वल और के वल पढ़ाई करने की सलाह देते हैं। सही मायने में यह सही नहीं है। बच्चों के  सर्वांगीण
विकास के  लिए पढ़ाई के  साथ-साथ खेलकू द भी आवश्यक है। जहाँ एक ओर पढ़ाई-लिखाई से बच्चों का मानसिक विकास होता है वहीँ  दूसरी ओर
खेलकू द उनके  शारीरिक विकास के  लिए अत्यावश्यक है। बच्चों का सर्वांगींण विकास ही उन्हें उनके  लक्ष्य तक पहुँ चाने में सक्षम होता है। अतः
पढ़ाई के  साथ-साथ खेलकू द भी उनके  लिए आवश्यक है।

(ii)

हमारा मित्र यदि दूसरे मज़हब का है और वह हमारे घर पर आता है तो हम उसका प्रेमपूर्वक स्वागत करेंगे। उसे आदर से बैठने को कहेंगे  और
उसके  साथ खेलेंगे , उससे प्रेमपूर्वक बातें करेंगे। इफ्फन की दादी टोपी से प्रेमपूर्वक मिलती थीं और उससे स्नेह करती थीं। उन्हें इस बात की
कोई परवाह नहीं थी कि टोपी हिन्दू है। इसी प्रकार हमारे घर के  सदस्य भी हमारे मित्र से स्नेहपूर्ण  बातें करेंगे। मैं अपने मित्र को इस बात का
एहसास भी नहीं होने दूंगा कि वो हमारे मज़हब का नहीं है।

(iii)
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13. सेवा में,

नगर निगम जयपुर

जयपुर।
विषय - नालियों की सफाई व कीटनाशक दवाओं के  छिड़काव के  संदर्भ में।
महोदय,

श्रीमानजी, इस पत्र के  माध्यम से मैं आपका ध्यान हमारे क्षेत्र बरकत नगर की सफाई व्यवस्था की ओर आकर्षित करना चाहता हूँ । हमारे क्षेत्र बरकत नगर में
सभी नाले व नालियाँ गंदगी से भरे पड़े हैं तथा उनका गंदा पानी गलियों में बह रहा है। बारिश का मौसम भी शुरू हो चुका है जिसके  कारण चारों ओर
जलभराव की समस्या उत्पन्न हो गई है। इसमें मक्खियाँ व मच्छर पनप रहे हैं जिससे लोगों का जीवन बेहाल हो गया है। साथ ही मलेरिया, डेंगू फै लने का
खतरा बना है।

आजकल तो वैसे भी स्वच्छ भारत अभियान भी चल रहा है। अतः आपसे अनुरोध है कि स्थिति की गंभीरता को देखते हुए कृ पया नालियों की सफाई व
कीटनाशक दवाओं के  छिड़काव की समुचित व्यवस्था के  लिए उचित कार्यवाही करें।
धन्यवाद।
भवदीय,

मुके श कु मार

बरकत नगर

दिनांक 20/8/20XX

अथवा
श्रीमान प्रधानाचार्य  जी,

ज्ञान सागर पब्लिक स्कू ल,

जल ही जीवन है
पृथ्वी पर रहने वाले हर एक प्राणी के  लिए जल जरूरी और क्योंकि इस पर मनुष्यों की निर्भरता भी बहुत अधिक है, इसलिए जल एक अहम
संसाधन है। जल का उपयोग रोजमर्रा के  कामों से लेकर कृ षि और विभिन्न उद्योगों में किया जाता है। जल के  बिना ज्यादा समय तक धरती पर
जीवन संभव ही नहीं है, इसलिए जल को जीवन बताया गया है।
जल को जीवन का आधार माना गया है, क्योंकि जल के  बिना जीवन संभव नहीं है फिर चाहे वो मनुष्य जीव हो या पेड़-पौधे आदि। जल का
उपयोग खाने में, पीने के  पानी के  अलावा हमारे दैनिक कार्य , कृ षि, विभिन्न उद्योगों के  लिए किया जाता है। इसलिए जल मानव जीवन के  उन
मूल्यवान संसाधनों में से एक है, जो हमें प्रकृ ति ने भेंट दिया है। जल एक ओर हमारे जीवन का हिस्सा है और हमारे शरीर के  लिए आवश्यक है,
वहीं अगर साफ पानी का सेवन न किया जाए तो यह आपको गंभीर रूप से बीमार भी कर सकता है। और आश्चर्य  की बात है कि पृथ्वी पर 71
प्रतिशत पानी मौजूद होने के  बाद भी के वल 1 प्रतिशत ही पानी पीने लायक है। इसलिए जल संरक्षण बहुत जरूरी है।

ऐसे कई देश हैं जहां सूखे की समस्या तेजी से बढ़ती जा रही है और लोगों को पीने का पानी तक मुश्किल से मिल पाता है। ऐसे में कृ षि के  लिए
पानी उपयुक्त नहीं होता और लोग भूख और प्यास जैसी एक बड़ी समस्या से जूझ रहे है। इस समस्या को नियंत्रित करने के  लिए हमें पानी का
उपयोग के वल उतना ही करना चाहिए जितना उपयुक्त हो।
हमें ध्यान रखना होगा कि हम जब नल का उपयोग करे तो थोड़ा ही पानी खोले। कोशिश करें कि घर के  दैनिक कामों के  लिए पानी पुनः उपयोग
कर लें। बारिश के  पानी को जमा कर के  पेड़ पौधों को पानी देने में इस्तेमाल करें। जो पानी गंदा हो या पीने लायक न हो उसका उपयोग घर की
साफ-सफाई में कर सकते हैं। हमे आने वाली पीढ़ी के  लिए इन प्राकृ तिक संसाधनों को बचाना होगा और इसके  लिए जरूरी है कि इन संसाधनों
का उपयोग हम समझदारी से करें। पानी का मूल्य हम सब को जानना चाहिए ताकि हम उसे बचाकर आने वाली पीढ़ी के  लिए उपलब्ध करा
सकते हैं। जल ही जीवन है और हम सब को जीने के  लिए इसकी अति आवश्यकता है। इसलिए इसका संरक्षण करना हम सब को आना चाहिए।

(i)

यह कहावत हमें परोपकार के  महान मूल्य की ओर इशारा करती है। इसका अर्थ  है कि दूसरों की भलाई करना सबसे बड़ा धर्म है। यानी, दूसरों
की सेवा करने से बड़ा कोई धर्म नहीं है।
जब हम दूसरों की मदद करते हैं, तो न के वल उनके  जीवन में खुशी लाते हैं, बल्कि खुद को भी आंतरिक शांति और संतुष्टि प्राप्त होती है।
परोपकार करने से हमें जीवन का सच्चा आनंद मिलता है। यह हमें एक सार्थक जीवन जीने में मदद करता है। जब हम दूसरों की मदद करते हैं, तो
हम समाज के  प्रति अपनी जिम्मेदारी निभाते हैं और एक बेहतर समाज के  निर्माण में योगदान देते हैं।

इसलिए, हमें अपने जीवन में परोपकार को प्राथमिकता देनी चाहिए। चाहे वह किसी की मदद करना हो, किसी जरूरतमंद को दान देना हो या
किसी की भावनाओं का ख्याल रखना हो, हर छोटा-मोटा काम हमारे जीवन को सार्थक बनाता है।

(ii)

मनुष्य सामाजिक प्राणी है। परस्पर सहयोग उसके  जीवन का महत्त्वपूर्ण  अंग है। परस्पर सहयोग के  अभाव में समाज का अस्तित्व ही नहीं रह
जाता। व्यक्ति को पग-पग पर दूसरों के  सहयोग और सहायता की आवश्यकता पड़ती है। व्यास जी ने कहा है-परहित साधन ही पुण्य है और
दूसरों को कष्ट देना ही पाप है। परोपकार के  समान दूसरा धर्म नहीं है। परोपकार का प्रत्यक्ष उदाहरण प्रकृ ति में देखने को मिलता है। मेघ दूसरों के
लिए वर्षा करते हैं, वायु दूसरों के  लिए चलती है तथा सरिता भी दूसरों की प्यास बुझाने के  लिए बहती है। पुष्पअपनी सुगन्ध बिखेरकर, वृक्ष स्वयं
धूप सहकर और पथिकों को छाया प्रदान करके  हमें परोपकार की प्रेरणा देते प्रतीत होते हैं। परोपकार करने वाला मनुष्य पूज्य बन जाता है।
परहित के  कारण गाँधी जी ने गोलियाँ खाईं , सुकरात ने जहर पिया तथा राजा शिवि ने बाज के  आक्रमण से भयभीत कबूतर की रक्षा के  लिए अपने
शरीर का माँस दिया, ऋषि दधीचि ने मानव कल्याण के  लिए स्वेच्छा से अपनी अस्थियाँ दान करके  सम्पूर्ण  मानवता को वृत्रासुर के  अत्याचारों से
मुक्त कराया। बुद्ध, महावीर जैसे महापुरुषों ने तृप्त मानवता को परोपकार का पावन मार्ग  दिखाया। पंचशील का सिद्धान्त भी परोपकार की ही देन
है। अपने लिए तो पशु भी जी लेते हैं। परोपकार इसी कारण मानवीय वृत्ति है। मनुष्य की परिभाषा देते हुए कवि ने कहा है- वही मनुष्य है कि जो
मनुष्य के  लिए जिए।

(iii)
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पालम कॉलोनी, दिल्ली।

27 फरवरी, 2019

विषय: शुल्क-मुक्ति हेतु प्रार्थना-पत्र

महोदय,

सविनय निवेदन है कि मैं इस विद्यालय की नौवीं-अ कक्षा का छात्र हूँ । मेरे पिता जी एक प्राइवेट फै क्ट्री में कं प्यूटर ऑपरेटर हैं, जिनका वेतन कम है। घर में
कु ल छह सदस्य हैं, जिनका निर्वाह पिता जी की कमाई पर निर्भर है। मेरा एक छोटा भाई भी इस स्कू ल की छठी कक्षा का छात्र है। हम दो भाइयों की फीस
देना पिता जी के  लिए काफी मुश्किल हो रहा है। मैंने पिछली कक्षा में प्रथम स्थान प्राप्त किया था। मैं विद्यालय की कबड्डी टीम का सदस्य हूँ ।

आपसे प्रार्थना है कि मेरी फीस माफ करने की कृ पा करें ताकि मैं अपनी पढ़ाई आगे  भी जारी रख सकूँ । आपकी इस कृ पा के  लिए मैं आपका आभारी रहूँ गा।
धन्यवाद सहित।

आपका आज्ञाकारी शिष्य,

बलवंत कु मार,

कक्षा- IX - अ

अनु. - 2

14. 

इलियट अपार्टमेन्ट, पालम

सूचना

30 मार्च , 2019
सोसाइटी के  सभी सदस्आयों को सूचित किया जाता है कि आजकल सोसाइटी में जहाँ - तहां पत्ते, प्लास्टिक, गंदगी नज़र आने लगी है। आपसे निवेदन है
कि घर के  सभी सदस्यों को जागरूक करें ताकि वे ऐसा न करें।
वातावरण की स्वच्छता बनाए रखने हेतु यह कदम उठाया जा रहा है। यदि कोई गंदगी फै लाते हुए देखा गया तो उसे निर्धारित जुर्माना भरना होगा।
अध्यक्ष
इलियट अपार्टमेंट

अथवा

सागर अपार्टमेंट, रोहिणी, दिल्ली

सूचना

जल की बर्बादी रोकने के  संदर्भ में

आप सभी को यह सूचित किया जाता है कि हमारे अपार्टमेंट में जल की कमी हो रही है। बड़े ही दुः ख के  साथ यह सूचित किया जा रहा है कि अपार्टमेंट के
कु छ सदस्यों द्वारा जल का अनुचित व्यय किया जा रहा है। हम सभी जानते हैं कि जल हमारे जीवन के  लिए कितना आवश्यक हैं। जल के  बिना जीवन नहीं
है। अतः आप सभी से यह अनुरोध है कि कृ पया जल के  इस अपव्यय की रोकथाम करने में हमारा सहयोग करें व अन्य लोगों को भी जागरूक करें।

सचिव
रणजीत कु मार

15. 

फ़ोन....... फ़ोन....... फ़ोन

ड्यूल सिम 

फ़ोन सिर्फ़  और

सिर्फ़  रू 7,800/-

फ्रं ट कै मरा
4 जी बी इंटरनल मेमोरी




जीवो फ़ोन

अथवा

सेल ! सेल ! सेल !

सुनहरा मौका


जल्दी आओ जल्दी पाओ, बिल्कु ल सस्ते दाम में कार अपने नाम करो।
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i. पुरानी कार के  दाम पर एकदम नई कार,
ii. तीन वर्ष  पुरानी चमचमाती कार, जिसका रंग हल्का काला है,
iii. कीमत दो लाख रूपये  मात्र,
iv. संपर्क  पता- लल्लन राम, सेक्टर-6, बिजली टोली, रायपुर, (छ.ग.)। मो.- 74xxxxxx403

16. From: pawan@mycbseguide.com

To: abcschool@gmail.com

CC ...

BCC ...
विषय - विद्यालय से दो दिन के  अवकाश हेतु

महोदय,

मैं कक्षा 10 का नियमित छात्र हूँ । जैसा कि आप जानते हैं कि आजकल मौसम तेजी से परिवर्तित हो रहा है और आस-पास काफी लोग बीमार पड़ रहे हैं,
उसी बदलते मौसम के  कारण मुझे भी सर्दी का भयंकर प्रकोप होने से तेज बुखार आ गया है। इसी वजह से मैं कक्षा में उपस्थिति दर्ज  कराने में असमर्थ  हूँ ।
डॉक्टर ने दो दिन की नियमित दवाई के  साथ आराम करने की सलाह भी दी है।

अतः मैं दिनांक 17.04.22 एवं 18.04.22 का अवकाश चाहता हूँ । कृ पया उक्त दो दिनों का अवकाश स्वीकृ त करने का कष्ट करे।
पवन

अथवा
एक बार मैं अपने माता-पिता और बहन के  साथ लद्दाख की पहाड़ियों पर चढ़ाई करने जा रहा था। इसलिए हम सुबह साढ़े चार बजे उठ गए। इतनी ठंड होने
के  बावजूद हम किसी तरह नहाकर जब बाहर निकले तो ठंड से हमारे पैर सुन्न हो गए। हम गाड़ी में बैठकर पहाड़ के  पास जा रहे थे। रास्ते में कु छ पहाड़ियों
पर बर्फ  गिरते देख मेरी बहन डरने लगी। मैंने और मेरे माता-पिता ने उसका हौसला बढ़ाया तो उसमें जोश आ गया।

लद्दाख की पहाड़ियों तक पहुँ चने का रास्ता बहुत सँकरा था इसलिए यातायात बहुत धीमी गति से बढ़ रहा था। बर्फ बारी के  कारण कु छ गाड़ियों के  इंजन
खराब हो गये  तथा कु छ गाड़ी के  टायर बर्फ  में फँ स गये  थे। थोड़ा आगे  बढ़ने पर हमारी गाड़ी में भी खराबी आ गयी। लेकिन हमने हौसला नहीं हारा। जिस
पहाड़ पर हमें चढ़ना था उस पर बर्फ  जमी थी। इतनी दूर आकर चढ़ाई पूरी किए बिना ना लौटने का संकल्प लेकर हमने चढ़ाई शुरू की। ऊपर चढ़ते हुए
हमारे मार्गदर्शक के  पैर में मोच आ गयी, जिसके  कारण वह आगे  हमारे साथ नहीं जा सकता था। अब चढ़ाई धीरे-धीरे और मुश्किल होने लगी। लेकिन हमने
हिम्मत नहीं हारी और अपनी मेहनत से चढ़ाई पूरी की। नीचे उतरने पर ऐसे लगा मानो हमने कोई जंग जीत ली हो।

सीख- इसे देखकर मन में विचार आया कि परिश्रम ही सफलता की सीढ़ी है। परिश्रम से ही सफलता पाई जा सकती है।
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सैनिक स्कूल इम्फाल 

शीतकालीि अवकाश गहृ-कार्य 

ववषर् : हहन्दी 
कक्षा : x 

 

अनुच्छेद लेखन (Paragraph Writing) 

ननम्नललखखत विषयों पर 120–150 शब्दों में अनुच्छेद ललखखए : 

1. जीवि में अिुशासि का महत्व 

2. ववद्र्ार्थी जीवि और समर् प्रबंधि 

3. पर्ायवरण प्रदषूण : कारण और समाधाि 

4. सोशल मीडिर्ा का ववद्र्ार्र्थयर्ों पर प्रभाव 

5. खेलकूद का महत्व 

6. डिजजटल भारत 

7. पुस्तकें  – हमारी सच्ची ममत्र 

B. औपचाररक पत्र लेखन (Formal Letter Writing) 

ननम्नललखखत में से ककसी पााँच विषयों पर औपचाररक पत्र ललखखए : 

1. ववद्र्ालर् में स्वच्छ पेर्जल की व्र्वस्र्था हेतु प्रधािाचार्य को पत्र 

2. िगर निगम को सड़क की खराब जस्र्थनत के संबंध में पत्र 

3. ववद्र्ालर् में पुस्तकालर् सुववधा बढािे के मलए आवेदि पत्र 

4. बस पास बिवािे हेतु पररवहि ववभाग को पत्र 

5. बबजली आपूनत य में अनिर्ममतता के ववषर् में मशकार्त पत्र 

6. खेल सामग्री की मांग हेतु प्रधािाचार्य को पत्र 

7. छात्रववृि हेतु आवेदि पत्र 

C. सूचना लेखन (Notice Writing) 

ननम्नललखखत में से ककसी पााँच विषयों पर सूचना तैयार कीजिए : 

1. ववद्र्ालर् में ववज्ञाि प्रदशयिी का आर्ोजि 

2. वावषयक खेलकूद प्रनतर्ोर्गता की सूचिा 
3. स्वच्छता अमभर्ाि से संबंर्धत सूचिा 



4. सांस्कृनतक कार्यक्रम के ऑडिशि की सूचिा 
5. ववद्र्ालर् भ्रमण (Educational Tour) की सूचिा 
6. वाद-वववाद प्रनतर्ोर्गता की सूचिा 
7. पुस्तक मेला आर्ोजि की सूचिा 

D. ई-मेल लेखन (Email Writing) 

ननम्नललखखत में से ककसी पााँच विषयों पर ई-मेल ललखखए : 

1. प्रधािाचार्य को अवकाश हेतु ई-मेल 

2. िगर निगम को कचरा प्रबंधि के संबंध में ई-मेल 

3. ममत्र को परीक्षा की तैर्ारी के बारे में ई-मेल 

4. ऑिलाइि कक्षा की समस्र्ा के ववषर् में मशक्षक को ई-मले 

5. पुस्तक ऑियर के मलए प्रकाशक को ई-मले 

6. खेल प्रनतर्ोर्गता में भाग लेिे की अिुमनत हेतु ई-मेल 

7. ववद्र्ालर् कार्यक्रम में आमंत्रण हेतु ई-मले 

E. विज्ञापन लेखन (Advertisement Writing) 

ननम्नललखखत में से ककसी पााँच विषयों पर विज्ञापन तैयार कीजिए : 

1. खोर्ा हुआ मोबाइल फोि 

2. ककराए के मलए कमरा 
3. कोर्चगं क्लास में प्रवेश 

4. पुरािी साइककल बबक्री हेतु 
5. कंप्रू्टर प्रमशक्षण संस्र्थाि का ववज्ञापि 

6. र्ोग कक्षा का ववज्ञापि 

7. ट्रू्शि मशक्षक की आवश्र्कता 
 

 

 



SAINIK SCHOOL IMPHAL 

WINTER VACATION 2025-26 

HOMEWORK/ASSIGNMENT 

Class-X 

 

 

 

 

 

 

 

ENGLISH 



ENGLISH ASSIGNMENT 
CLASS X 

 
1. Project Work (Choose ANY ONE) 
 
Project 1: Extended Literature Portfolio 
 
Choose one chapter/poem from First Flight or Footprints Without Feet. Prepare a 
portfolio including 
 

a) Summary (100 words) 
b) Themes 
c) Character notes 
d) Figurative devices (if a poem) 
e) 30 new vocabulary words with meanings 
f) Your personal reflection 

 
Project 2: Grammar Integration File 
Prepare a file containing  

a) 5 real-life examples each of modals, determiners, tenses, subject–verb 
agreement and reported speech (taken from books). 

b) A paragraph of 120 words using them correctly 
c) Explanation of errors you found and corrected 

 
2. Creative Writing 
 

a) Write a letter to the Editor highlighting the problem of increasing pollution in 
your city. 

b) Write a paragraph describing “A festival celebration in your city/town.” 
 
3. Character Sketch (Any two) 
Write a 120–150 word character sketch of ANY ONE: 

a) Anne Frank 
b) Nelson Mandela 
c) The Scientist in Footprints Without Feet 
d) Bholi 
e) Any other character from First Flight or Footprints Without Feet 

 
Include: traits, actions, role in the story, what makes the character memorable. 
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GEOGRAPHY 



Geography Winter vacation assignments 

Class 10 

1. Explain any three characteristics of minerals. 

2. Explain three reasons why we need to conserve mineral resources. 

3. Distinguish between conventional and non- conventional sources of energy. Give 

three points of difference. 


